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Popular Topics

• How to scan

• Autopilot

• Create model manually

• Align scans

• Apply texture

• Orient model

• Fusion and Real-time fusion

• Bridges or Smart Hole Filling

• Export model

• Measure model

• About your scanner

• Ask for help

Artec Studio is an industry-acclaimed software package for advanced 3D scanning and
data processing. It enables you to scan countless objects using Artec scanners.

This manual will show you how to use the application as well as your 3D scanner to quickly
and easily create great-looking 3D models. Use the left panel to get an overview of the
entire manual, or refer to the Quick Start Guide. To get the most out of the documentation,
review the various terms we use throughout. Consult the genindex to ˉnd references
for speciˉc parameters that appear in processing algorithms. Also, take a look at the
Conventions and Acronyms section for a key that describes how we highlight semantic
elements.

The incomplete list of chapters below is intended to clarify the document structure.

• 3D Scanning at a Glance (Quick Start Guide) is a brief overview of scanning and pro-
cessing basics. It also covers Autopilot mode.

• Using the Hardware covers hardware-related matters: scanners, third-party 3D sen-
sors and 3D mice

• Scanning explains the basic principles of object scanning and offers advice on how
to conduct the scanning process to obtain the best results.

• Viewing Scans and Models describes ways in which to control an object’s appearance
in the 3D View window and obtain the best view of the 3D model.

• Projects, Scans and Models contains information on data management, working with
projects, exporting and importing data, undoing recent operations, and saving the
history of project changes.

• Data Processing focuses on data-processing techniques: working with separate
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scans, alignment, fusion, ˉlters, defect-elimination methods and texturing.

• Additional Modes demonstrates how to publish models on the Web; how to use ad-
ditional features, such as employing several scanners to capture an object; and how
to use measuring tools.

In addition to this manual, you can ˉnd practical tips and other information at the Support
Center. If you encounter an issue when using our 3D scanners or applications, please
submit a request.

Documentation for earlier versions of the software is available here.
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CHAPTER 1

3D Scanning at a Glance

Before you start using the guide, we want to show you how easy 3D scanning can be.
Although this well-structured manual covers all the matters related to Artec scanners
and software, you may ˉnd it helpful to have an overview at your ˉngertips. This brief
summary will assist you in getting started right away! But if you prefer to begin with
comprehensive and detailed information, you can skip this chapter.

1.1 Activate

The scanner case includes everything you need to start 3D scanning, except a computer.
At a minimum, your PC must run the 64-bit version of Microsoft Windows 7 or 8 (10 is also
supported). The more powerful the PC, the better. The main memory (RAM) and graphics
card are the most critical components (visit our FAQ page for more information).

Warning: Don’t connect the scanner just yet! Continue reading for more information.

1. Register for an account at my.artec3d

2. Sign in and download Artec Installation Center from the welcome page

3. Install Artec Installation Center. When prompted, enter your email and password.

4. Plug the scanner into a power outlet, then connect it to your PC using the USB cable

5. Wait for Windows to detect the scanner. Click Activate.

6. Click Install in the Software section to get Artec Studio running on your machine

(For more details, see User Account, Scanner Activation and Ofˊine Activation.)
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1.2 Prepare

Most objects are easily scannable. Before scanning transparent, reˊective or black objects,
we suggest applying a powder coating or a special anti-glare spray.

To scan monochrome objects with simple geometric shapes, do the following:

• Add auxiliary objects (e.g., crumpled paper) to the scene

• Paint markers (e.g., “X” shapes) on the surrounding surfaces

Be sure to provide good ambient light. (For more info, see Selecting and Preparing Objects
for Scanning.)

1.3 Scan

1. Launch Artec Studio, then aim the scanner at the object.

2. Press on the scanner to start Preview mode. If your scanner lacks this button, ˉrst
open the Scan panel.

• Geometry + Texture is the default scanning mode and is suitable for most cases

• For older PCs, Geometry mode is a good alternative

• The Real-time fusion mode creates a model in real time, allowing you to skip
postprocessing; click Stop, then select the Real-time fusion checkbox and click
Preview.

3. Make sure the object is visible, then press once again to initiate recording. If
possible, scan all sides of the object in one go, slowly moving the scanner around it
as pictured below.

Note: While scanning, pay closer attention to the object on the screen
than to the actual object.

4. If you hear an alert sound and the screen displays an error against a red background,
smoothly aim the scanner at the area you just captured. Possible reasons for the
“Tracking lost” error include the following:

1.2. Prepare 5
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1. You are scanning simple geometric shapes

2. The part of the object you are scanning is too small

3. Scanner movement is too fast

5. Press to display the scan in the Workspace panel.

1.4 Turn and Scan (Optional)

Note: This part is optional.

Turn the object and capture any remaining unscanned regions (press ). Also, to facilitate
alignment, record at least one previously scanned region.

(For more info, see Buttons and LED Indicators for Eva and Spider, Tweaking Scanning Options,
Scanning Procedure, Tracking Modes, and Scanning With Real-Time Fusion.)

1.5 Use Autopilot

For beginners, the easiest way to obtain a 3D model is by using Autopilot. It’s also a great
time saver for advanced users. If you prefer performing all the steps manually, refer to the
Process Manually section.

Autopilot is a special mode that helps users obtain a complete 3D model without learning
all the ins and outs of postprocessing. It consists of two major parts: semiautomatic
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(editing and alignment) and automatic1.

Tweaking Autopilot Settings

• Hole-ˉlling method (available options are Don’t ˉll, Watertight and By radius) in-
structs the algorithm to ˉll or not ˉll holes in the model.

• Model resolution—the lower the resolution value, the sharper the shape and the
more details you will see. If you’re unsure, leave the value as Auto. Effectively, it’s
the same as Creating Models (Fusion) resolution. Note that the resolution should
be no less than 0.5 for scans captured using EVA and no less than 0.1 for Spider.

• Polygon count determines how many polygons the resulting model will have. The
greater the value, the better the quality and the larger the ˉle size. If you’re
unsure, leave the value as Auto. For more information, consult the Mesh Simpliˉ-
cation section.

• Texture—clear this checkbox if you don’t want to apply texture to the model.

• Texture resolution takes speciˉc values in the range of 512x512 to 8192x8192 or
16384x16384 pixels depending on the available GPU memory.

To produce a model,

1. Click Autopilot in the left panel or hit F9.

2. Become familiar with the steps that you will perform in this guided mode (listed in
the welcome screen).

3. In theWorkspace panel, use the ˊag to mark all scans that you intend to use, then
click Next.

4. Then specify the input parameters for the model-creation step and click Next. Pri-
mary settings may include the following:

Note: We suggest consulting the tool tips, which you can reveal
by clicking the button next to the option name.

1 Automatic steps may include the following:

1. Fine registration

2. Global registration

3. Outlier removal

4. Fusion

5. Small-object ˉlter

6. Mesh simpliˉcation

7. Texturing

8. Texture optimization (Texture inpainting)

1.5. Use Autopilot 7
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a. Scan quality (geometry). Click to determine whether your scan of
the object has the correct geometry by examining the tool-tip images.

b. Scan quality (texture). Click , look at the images and decide whether
your scan has sufˉcient texture.

c. Hard-to-scan surfaces. Select the checkbox if your object has surfaces
that are difˉcult to capture. Consult the image samples by clicking
the button.

d. Decide on the Object size by referring to the image samples.

e. Leave the default values for the remaining options in this window
(sufˉcient for most cases). For advanced scenarios, you can tweak
these settings (more details appear in the sidebar).

5. If necessary, erase any extraneous objects that can hinder postprocessing. Learn
how to use Eraser by consulting the Erasing Portions of Scans (Eraser) section.

6. Once you’re done, click Next. If the object was captured over several scans, Autopilot
will align them and show you the result. You can approve it or align the scans
manually (consult Manual Rigid Alignment Without Specifying Points).

7. Click Next.

8. Autopilot will begin postprocessing1. Once it’s ˉnished, a message will appear in-
forming you that the model is ready. Click OK.

1.6 Process Manually

1.6.1 Crop Surroundings

Once you ˉnish, click File and select Save project. Close the Scan panel; preliminary regis-
tration will start automatically. You can then crop the surroundings.

Purpose: To erase auxiliary surfaces (e.g., a table or ˊoor).

Steps: Open Editor → Eraser → Cutoff-plane selection. Follow the instructions.

(For more info, see Editing Scans.)
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1.6.2 Align

Purpose: To align several scans. Skip this step if only one scan is in the Workspace panel.

Steps:

1. Mark two or more scans using , click Align and select those scans in the Rigid tab
while holding the Ctrl key.

2. Click Auto-alignment.

3. If alignment fails owing a lack of texture or lack of overlapping areas, manually
match the features among the scans and click the Align button.

(For more info, see Scan Alignment.)

1.6.3 Global Registration

Purpose: To simultaneously optimize the frame position across all scans, thus preparing
them for further processing.

Steps: Mark scans using , then click Tools → Global registration → Apply.

(For more info, see Global Registration.)

1.6.4 Eliminate Noise

Purpose: To erase large outliers and some noise.

Steps: Open Tools → Outlier removal → Apply.

(For more info, see Editing Scans and Eliminating 3D-Noise (Outlier Removal).)

1.6. Process Manually 9
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1.6.5 Fusion

Purpose: To create a model (a single surface, as opposed to the multiple surfaces that
constitute the source scan).

Steps: Select Tools → Smooth fusion → Watertight → Apply.

To obtain sharper surfaces, select Sharp fusion. In both cases, resolution can be adjusted:
the smaller the value, the more precise the resulting surface.

(For more info, see Creating Models (Fusion).)

1.6.6 Erase Flaws (Optional)

Purpose: To erase any outliers and poorly scanned regions.

Steps: Click Editor → Defeature brush. Follow the instructions.

(For more info, see Editing Scans.)

1.6.7 Simplify Mesh
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Purpose: To reduce the ˉle size by decreasing the number of polygons without signiˉ-
cantly distorting the actual 3D geometry.

Steps: Click Tools → Mesh simpliˉcation → Apply.

(For more info, see Mesh Simpliˉcation.)

1.6.8 Apply Texture

Purpose: To create a textured model.

Steps:

1. Click Texture.

2. Select fusion and its “parent” scan(s) in the corresponding ˉelds.

3. Select texturing for Export → Apply.

(For more info, see Texturing.)

1.7 Measure, Export, Share

• Export the model: open File → Export mesh. Select the required format, specify the
folder and ˉle name, then click OK.

• Measure the model: open Measures, then select one of the following:

– Linear for distance calculation (points are connected by lines)

– Geodesic for distance calculation (points are connected by curves that pass over
the model surface)

1.7. Measure, Export, Share 11
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– Sections for area and volume calculation

• Share the model on viewshape.com by opening the Publish toolbar

(For more info, see Exporting Models, Scans and Point Clouds, Publishing to the Web and
Measurement Tools.)

1.8 Tips and Tricks

• You can reset all settings to their defaults using F10→ Scan tab→ Reset to defaults

• To return any altered parameters in the Tools panel to their default values, click the
adjacent button. The button indicates a default value.

• Save screenshots by hitting Ctrl+Shift+S

• Apply annotations using Measures → Annotations, enter the tag label and type text,
then click Apply.

12 Chapter 1. 3D Scanning at a Glance
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CHAPTER 2

Glossary

The following terms related to Artec Studio and 3D scanning appear regularly in this
manual.

accuracy (general term) How closely a measurement matches the actual value of the
quantity being measured.

Autopilot An advanced smart mode that guides the user through postprocessing in a few
steps, automatically selecting themost effective settings and producing a 3Dmodel.

bundle Capture of an object through simultaneous use of multiple scanners, whose num-
bers and relative positions are speciˉed in the application.

CAD model Feature-based, editable solid model used in manufacturing. It can be created
in a CAD system or reverse-engineering software package.

ˉne registration A thorough frame alignment using an algorithm for relative positioning
of sequential frame pairs.

frames 3D surfaces captured during a scanning session. Themaximum scanning rate is 15
frames per second (30 frames per second for Microsoft Kinect, PrimeSense Carmine
and Asus Xtion sensors).

fusion Process that creates a polygonal 3D model. It effectively melts and solidiˉes the
captured and processed frames or point-cloud surfaces. Fusion can be run as a
separate algorithm or throughout the scanning (Real-time fusion).

global registration Algorithm that optimizes the relative positions of all frames using a
single coordinate system.

key frames Frames used by the global registration algorithm. The algorithm selects them
automatically to fully cover the surface of the captured object using as few as pos-
sible.

mesh The surface geometry of a 3D model; it comprises a series of linked polygons.
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model The 3D object that results from the fusion operation (in Artec Studio) or another
modeling process in a different software package.

near and far cutting planes Planes that limit the space in which the scanner is capturing
3D frames. The device will ignore everything that is closer than the near cutting
plane or more distant than the far cutting plane.

project A method of managing the scanned material, processed data and user operation
history, either in memory or on disk. Artec Studio project ˉles use the SPROJ exten-
sion.

resolution (general term) The ability of a scanning system to capture detail in an object.

rough registration Preliminary frame alignment performed during capture.

scan A sequence of frames captured in a single continuous movement of the scanner
around an object or scene.

supporting surface A surface on which the object is resting (e.g., a table or the ˊoor).

targets Stickers placed on the object being scanned to ease identiˉcation of the various
regions. There are two types of targets: non-coded and coded. Unless the type is
explicitly speciˉed, the target is considered non-coded. Typically, a non-coded tar-
get is a round sticker that has a black ring with a white circle in the center; a coded
target has a unique code ring that photogrammetry software can automatically rec-
ognize.

tracking Calculation of the scanner’s position in a coordinate system relative to the scene.

You can also ˉnd these terms along with some algorithm parameters in genindex.

14 Chapter 2. Glossary



CHAPTER 3

Using the Hardware

3.1 3D Scanners

Artec Studio can work with one or more Artec 3D scanners. It offers tools to quickly
create 3D models of physical objects. Besides managing the process of capturing objects,
it lets you perform full data postprocessing, optimize mesh tessellations and apply other
operations to obtain a quality 3D model. You can then send the complete model to a CNC
machine or import it to another 3D-modeling application.

Figure 1: Features of Artec 3D scanners: Space Spider (left) and EVA (right).

Most Artec 3D scanners are speciˉcally designed for handheld use, offering light weight
and compact size. Being structured-light 3D scanners, they don’t require you to place
any special targets on the object you’re capturing. Using them is easy—no special knowl-
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edge or skills are necessary. To obtain a complete 3D model, simply scan the object from
different angles and fuse the resulting scans into a single model using Artec Studio.

Depending on the size of the object you’re scanning, use either Artec Ray, Leo and Eva,
Spider or Micro. The primary difference between these models is the depth and ˉeld of
view. They also differ in 3D resolution as well as point accuracy; consult the Artec web
site and respective manuals for details.

Figure 2: Fields of view for Eva and Spider 3D scanners.

You can combine several different scanner types while capturing a scene. In some cases
when capturing complex shapes, this capability increases the scanning rate and enables
you to achieve your desired precision.

3.2 Buttons and LED Indicators for Eva and Spider

3.2.1 LED Indicators

Artec scanners include built-in multicolor indicators. By explaining the meaning of these
indicators, the list below enables you to keep track of the scanning process:

Steady blue—scanner is booting up.

Flashing green—Artec Studio cannot detect a 3D scanner.

Steady green—scanner is connected to the application and ready to use.

Flashing red—scanner is in Preview mode, or tracking in Recording mode
is lost.

Steady red—scanner is in Recording mode and object tracking is proceed-
ing correctly.
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3.2.2 Hardware Buttons

The Artec EVA and Artec Spider 3D scanners have three-position buttons on their bodies:

Figure 3: Scanner buttons: Artec Spider on the left and Artec EVA on the right.

—press this button once to open the Scan panel and start Preview mode; press it once
more to switch to Recording mode. Subsequently, pressing this button will switch
between Preview and Recording.

—press once during a scan to stop the scanning process; press twice to stop scanning
and close the Scan panel.

3.3 Hardware Synchronization for Eva

Artec EVA is equipped with two jacks designed for 6P6C connectors (RJ12). By creating
a bundle, you can link multiple Artec EVA scanners to each other. The master device is
a leading scanner that sends signals to the next slave device. Each subsequent device is
connected to the previous one sequentially as Figure 4 shows. To connect the devices, you
can use a standard phone cable (RJ12 6P6C) or any other cable that uses the conductor
scheme shown in Figure 4. Each scanner should also connect to the PC via USB.

Warning: Only Artec EVA scanners can connect to each other. Do not connect Artec
EVA to a telephone wall port!

3.4 Artec Turntable

Artec Turntable is designed to ease scanning of small and midsize objects by eliminating
the need to rotate them manually. Both the rotary plate and the mat that comes with the
turntable feature a special pattern to ensure robust tracking with Artec scanners. The mat
is made of silicone, which prevents objects from sliding off the rotary plate.

To scan using Turntable, follow the steps:

1. Ensure your computer has a Bluetooth adapter that supports the 4.0 standard.

2. Add a new Bluetooth device.

3.3. Hardware Synchronization for Eva 17
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Figure 4: Synchronization scheme.
Jacks on the Artec EVA scanner shown at left and conductors in a 6P6C connector shown at right.

3. Open Artec Studio.

4. Access the Scan panel.

5. Select the Use turntable checkbox.

6. Place the object on the turntable.

7. Click Preview.

8. Click Record to start capturing. The turntable will start rotating.

9. Click Pause or Stop. The turntable will stop rotating.

3.4.1 Recovering Lost Tracking

If you experience a tracking loss, Artec Studio will pause the turntable. It also turns the
rotary plate back by about 15 degrees. Once the application has recovered tracking, it
resumes rotation.

3.5 3D Mouse

Artec Studio can work with 3Dconnexion manipulators.
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Basic support includes navigation in 3D View and the following commands:

• Home

• Fit to view

• Undo

• Redo

For 3D mouse to function, you need to install drivers from the manufacturer’s web site.
Additionally, you can assign four currently supported commands to the mouse radial menu
or at least two of them to the hardware buttons for Artec Studio.

To assign a command to the 3D mouse button, follow the steps:

1. Open Artec Studio

2. Then open 3Dconnexion Properties utility from the Windows tray

3. Click Buttons

4. Click on the > arrow on the right side of either button ˉeld. A ˊyout window will
open for that 3D mouse button.

5. Open the Artec Studio category

6. Select either of the currently supported command.

Figure 5: Assigning command to 3D mouse button.

3.5. 3D Mouse 19
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If you want to assign several commands, create a new Radial menu (use the eponymous
category in the ˊyout menu). For more information, consult the manual for your 3Dcon-
nexion mouse.

To get used to navigating 3D content, use 3Dconnexion Trainer or 3Dconnexion Demo from
the 3Dxonnextion Home application.

Note: In Artec Studio, you move the camera around the object rather than the object
itself.

3.6 Artec Battery Pack

Available as an accessory, battery pack allows you to scan anywhere without the need to
be near a power outlet. Battery from this pack supports Artec EVA, Artec Spider and Artec
MHT scanners and lasts for up to 6 hours of scanning.

Figure 6: Battery pack with Eva.

Battery pack includes the following items:

• Battery

• Battery pouch
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• Power adapter (110–230 V → 19 V)

1. Fully charge Artec battery using its Input socket.

2. Plug the cable into the battery Output socket.

3. Then connect the cable to your Artec scanner.

Figure 7: Battery ports from left to right: Input, Output.

Important: Never confuse battery ports when connecting scanner.
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Installation

4.1 System Requirements

Your computer must meet the system requirements to use Artec 3D scanners.

In addition, take note of the following:

Real-time fusion mode (Scanning With Real-Time Fusion): ensure that your graphics card
has at least 1 GB of memory or your Intel HD Graphics chipset is 4600 or higher
(consult the FAQ article for more information).

Using Intel RealSense camera requires your computer to run Windows 8 (Windows 10 for
SR300) and to feature at least 4th Generation Intel Core processor and USB3.0

Using Kinect v2 requires your computer to run Windows 8 and to feature 3.1 GHz (or
faster) processor with physical dual-core (2 logical cores per physical) and USB3.0
based on Intel or Renesas chipset.

Using multiple scanners (Multicapturing) requires your workstation to integrate as many
independent USB host controllers as connected scanning devices. Upgrading your
hardware with PCI/PCI Express USB cards may provide the required number of hosts.

4.2 User Account

To install Artec Studio and keep it up to date, register for a free account at my.artec3d.
Registration is also required to activate an Artec 3D scanner. In addition, the site allows
you to track all your Artec devices and products.

Your account at my.artec3d will be valid for all Artec sites and services (including view-
shape.com).
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Figure 8: my.artec3d welcome screen.

To register, follow these steps:

1. Go to my.artec3d and click Sign up

2. Fill in all the ˉelds in the registration form and click Create account

3. Receive a registration email that contains a conˉrmation link.

4. Click the link or copy it to your browser to conˉrm your registration and go straight
to your my.artec3d account.

4.3 Scanner Activation

Before using your new Artec 3D scanner, you must activate it and link it to an account
at my.artec3d. You can do so with the help of Artec Installation Center—a standalone
utility available for download from my.artec3d. If you’re a new user and don’t yet have
Artec Installation Center, please read Running Artec Installation Center below. Otherwise,
proceed to 3D Scanner Activation Using Artec Installation Center.

Warning: Do not connect your scanner to the USB port before installing Artec Instal-
lation Center.

4.3.1 Running Artec Installation Center

To use Artec Installation Center, ˉrst ensure that your computer is connected to Internet.
Any computer with USB2.0 or USB3.0 ports will work. If necessary, you will be able to
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install and activate Artec Studio on a separate computer later. Also make sure that you
already have a my.artec3d account; if not, see User Account.

1. Log into your my.artec3d account and download Artec Installation Center. The link
for the Artec Installation Center executable is available on the site’s main screen.

2. After downloading, open the folder that contains the executable and run it. Fol-
low the instructions on the installation screens. Once Artec Installation Center is
installed, you will see a dialog requesting your email address and password. Use
your my.artec3d account to log in as Figure 9 shows.

Figure 9: Authentication for Artec Installation Center

4.3.1.1 Logging Out and Switching Accounts

You may need to changemy.artec3d account. Artec Installation Center displays the current
user email in the top-right corner (Figure 25).

To log out of Artec Installation Center:

1. Click Log out.

2. Enter another user’s email and password in the window that opens.

3. Click Sign in.

4.3.2 3D Scanner Activation Using Artec Installation Center

To activate a 3D scanner using Artec Installation Center, make sure your computer is con-
nected to the Internet and that you have installed the application.

1. Run Artec Installation Center (go to the Start menu: click Start → All Programs →
Artec Group → Artec Installation Center) to bring up the window shown in Figure 25.

2. Connect your new Artec 3D scanner to the computer and wait until Windows detects
the device and installs the necessary drivers. You may see a notiˉcation similar to
one shown in Figure 10.
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3. Go to Artec Installation Center, click Refresh and wait for the new 3D scanner to
appear in the hardware box. Click Activate (to the right of the serial number) to
enable your 3D scanner. The status of the device should change to Activated, as
Figure 11 shows.

Figure 10: Windows notiˉcation indicating device installation.

Figure 11: 3D scanner activated

4.4 Artec Studio Installation

There are two ways to download and install Artec Studio:

• Through Artec Installation Center (either during the installation process or by click-
ing Install in the application, as Figure 12 shows)

• From my.artec3d—log into the site, go to the My applications page and download the
executable (see Figure 13)

Figure 12: Artec Installation Center is ready to install Artec Studio.

If you download the executable, run it to begin installation; otherwise, click Install in Artec
Installation Center. To continue with the installation, click Next and proceed to the license
agreement (see Figure 14). After reviewing the agreement, accept it by clicking Yes.

Specify the path to the installation folder (we recommend using the default location) as
Figure 15 shows, then select the components you would like to install (see Figure 16):

Program-menu shortcuts create icon in the Start menu
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Figure 13: Portion of My applications page at my.artec3d.

Figure 14: License agreement
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Figure 15: Installation location

Figure 16: Select components to install
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Figure 17: Third-party 3D-sensor driver selection

Figure 18: Artec Installation Center showing Artec Studio activation window
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Figure 19: Finish installation

Desktop shortcut create icon on the desktop

Start-menu shortcut add shortcuts to the Start menu and Quick Launch panel

English manual install user manual in English

Install Artec Scanner Drivers install drivers for Artec 3D scanners

Artec Ray drivers install drivers for Artec Ray 3D scanner

Artec Micro drivers install drivers for Artec Micro 3D scanner

PrimeSense Carmine / Asus Xtion drivers install drivers for PrimeSense/Asus
3D sensors

Intel RealSense Runtime install drivers for Intel RealSense cameras

By default, the application will create all of the above icons and install the user manual
and Artec 3D-scanner drivers. To continue with the installation, click Next.

If you have yet to install Artec Installation Center, a login dialog will appear, as Figure 9
shows. If you are not connected to the Internet, consult Ofˊine Activation regarding ofˊine
activation of Artec Studio.

If you have yet to link to your account the computer on which you are installing Artec
Studio, you will see the activation conˉrmation shown in Figure 18.

When the installation is complete (see Figure 19), the installer will offer to launch Artec
Studio.

4.5 Offline Activation

If the computer on which you are installing Artec Studio lacks an Internet connection for
security or other reasons, you may use the ofˊine activation procedure to activate the
software.
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Note: Copies of Artec Studio activated ofˊine cannot be deactivated, so use this option
only if absolutely necessary.

Note: Before conducting ofˊine activation, make sure the scanner (see Scanner Activation)
and Artec Studio are tied to your my.artec3d account.

For ofˊine activation, you need the following:

• Another computer connected to the Internet

• Artec Studio installation package (preferably, download it from my.artec3d)

• Flash drive or another storage medium to transfer ˉles from the Internet-connected
computer to the computer that will run Artec Studio

Figure 20: Artec Installation Center authentication dialog

Installation and activation procedure:

1. Start Artec Studio installation.

2. During installation the login/password dialog will be displayed as Figure 20 shows.
Click Continue ofˊine

3. In the ofˊine-activation dialog (Figure 21), click Save… and save generated Activa-
tion ID ˉle to a ˊash drive or other storage medium.

4. Log into your my.artec3d account and open My applications page using the Internet-
connected computer.

5. Find Artec Studio and click on it. A new page will appear, as Figure 22 shows.

6. Click the Activate application ofˊine link then the Select ˉle button and specify the
Activation ID ˉle path. Next, click Activate.

7. A new dialog will allow you to download an Ofˊine Activation Data ˉle; save it to
the ˊash drive.
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Figure 21: Ofˊine-activation window

8. Return to the computer on which you are installing Artec Studio. Click Activate and
Continue and specify the Ofˊine Activation Data ˉle.

Note: Once you create the Ofˊine Activation Data File, my.artec3d will decrease the
number of available activations by one.

Once you complete all the steps described above, your copy of Artec Studio will be acti-
vated and all of your Artec 3D scanners will be installed on the non-Internet-connected
computer.

Figure 22: Ofˊine activation at my.artec3d.

Note: If later you purchase another Artec 3D scanner, you must reinstall the application
and repeat the activation procedure described above to copy the new scanner’s data ˉles
to your computer.
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4.6 Deactivation

Note that deactivation is only possible for computers on which you activated Artec Studio
online as Artec Studio Installation describes. Artec Studio installations activated ofˊine
cannot be deactivated.

Note: The number of deactivations may be limited, so deactivate Artec Studio only if you
absolutely must move it from one computer to another.

Figure 23: Deactivation of Artec Studio.

To deactivate a license on your computer, follow these steps:

1. Make sure the computer is connected to the Internet.

2. Go to Control Panel→ Uninstall Applications and click on Artec Studio. The uninstal-
lation process will start.

3. The dialog shown in Figure 23 will appear. Select the I understand. Deactivate Artec
Studio checkbox.

4. Click Next to complete the uninstallation.

4.7 Managing Artec 3D Scanners and Products

Artec Installation Center manages applications and 3D scanners linked to your account.

It’s a multifunctional supplement to Artec Studio that connects with my.artec3d and helps
you install new applications, download updates and manage your 3D scanners. To launch
Artec Studio for the ˉrst time, you must log into my.artec3d. After this one-time authen-
tication, you need not provide your email address or password each time you launch the
application.
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When Artec Studio launches, Artec Installation Center checks for new updates; if an update
is available for any installed product, the software will display a notiˉcation like the one
shown in Figure 24.

Figure 24: An Artec Studio update is available for download.

Once you log in, Artec Installation Center displays information about your products.

Figure 25: Artec Installation Center.

The Software section of Artec Installation Center provides all information about your soft-
ware products:

• A list of all applications available to you

• Activation status of each application (application may or may not be activated)

• Total number of activations and number of activations you’ve used so far

• Activate, Install or Update buttons for any of these actions that are currently available
to you

– Install—appears if the software is not installed on the computer (installation
usually means activation)

– Activate—appears if the software is not currently activated on the computer.
Activation decreases number of licenses by one for each computer.
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– Update—appears if a new version of installed software is available for down-
load

The Hardware section contains a list of the scanners that you own or have otherwise con-
nected to your computer. For the ˉrst case, the Activated status or Activate button will be
displayed, while in the second case, the On loan status or Rent button will be displayed.

A row of buttons appears at the bottom of the Artec Installation Center window:

Refresh —refresh the data displayed by Artec Installation Center

Close —exit Artec Installation Center
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CHAPTER 5

Scanning

5.1 Scanner Buttons and Capture Modes

Your 3D scanner may be in one of the following capture modes (each of which has a
corresponding color and ˊicker rate of the LED indicator on the device if you’re using an
Artec scanner):

Figure 26: Understanding capture modes (colors correspond to scanner LED indicator
colors).

Idle—the LED is steady green . This mode indicates either that the application has de-
tected the scanner or that the user has clicked the Stop button in the Scan panel
or pressed the button on the scanner body (see Figure 3). In this case, the 3D
scanner is not ˊashing.

Preview—the LED is ˊashing red . In this mode, the 3D scanner is capturing images,
but the software is neither performing alignment nor recording captured frames. To
start this process, either click the Preview button in the Scan panel (see Figure 39),
press the button on the scanner body or hit the F7 key on the keyboard. This
mode is useful when doing the following:

1. Checking the 3D scanner’s ˉeld of view
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2. Determining the best position for the object

3. Preparing to recording and developing a scan procedure

4. Adjusting texture brightness

Recording—the LED is steady red Scanning takes place in this mode, with the soft-
ware storing 3D data to disk or RAM. Activate this mode either by clicking the Record
button in the Scan panel, hitting the Space key on the keyboard or pressing the
button (do so once for Preview and a second time for Recording). To pause recording,
either click Pause in the Scan panel, press on the scanner body or hit the Space
key.

5.2 Selecting and Preparing Objects for Scanning

Artec 3D scanners employ the structured-light method of 3D reconstruction. Since they
capture 3D frames using optical technology, some types of objects are difˉcult to scan.
Certain techniques, however, enable successful scanning of such objects. For example, you
can cover a transparent or dark object with a light paint or dust it with talcum powder.
You can also use other easily removable substances or a special anti-glare spray.

Table 1: Hard-to-scan Surfaces
Surface Features Possible Solutions
Black or very dark Dust with anti-glare spray
Shiny or reˊective objects Dust with anti-glare spray, tilt scanner when

capturing
Transparent (glass, certain kinds of
plastic, etc.)

Dust with anti-glare spray

Thin edges Add background geometry (e.g., crumpled pa-
per)

5.3 Technique

Artec 3D scanners capture objects at a rate of 15 frames per second to ensure that adjacent
frame areas overlap as you gradually move the scanner. Artec Studio uses features in
overlapping areas to automatically align captured frames. It performs this task in real
time, providing immediate access to the frames in a single coordinate system. You can
evaluate the captured area after the scanning session to determine which parts of the
object require additional scanning.

To accurately capture an object or scene, follow these steps:

1. Pay closer attention to the object on the screen rather than looking at the actual
object.

2. Ensure that Artec Studio can accurately register frames from the scanner. To this
end, do the following:
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Figure 27: Scanner orientation and reconstructed surfaces.

Figure 28: Distance meter and distance color showing surfaces that fall within the optimal
range for Artec Spider.
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• Don’t move the scanner too fast

• Keep the object as close to the center of the ˉeld of view as possible

• Maintain the scanner orientation in such a way that the ˉeld of view is sufˉ-
ciently ˉlled with surfaces (see Figure 27)

• Try to position the scanner in the way the most surfaces in the ˉeld of view are
colored in green which corresponds to the center of the range meter1 (Figure
28)

3. If you’re capturing an object over several scans, remember to capture a common
area in each one to ensure successful alignment

4. If you’re capturing an object in one scan, do so all the way around the object—
regardless of direction—plus a little more (360+ degrees)

5. Avoid capturing any objects that may change shape during the scanning process.
When the geometry of the scene is changing, the system may fail to ˉnd the correct
position of new frames relative to previously aligned ones. If you have captured
unwanted objects, you must remove them later during the editing stage (see Editing
Scans).

6. Don’t record too many frames: ensure that you have sufˉciently scanned all regions,
but avoid scanning them twice, except when providing overlapping areas for sub-
sequent alignment.

5.4 Scanning Procedure

Ins and Outs

• Artec Studio creates a new scan in the Workspace panel at the beginning of each
session.

• When you start Preview mode, Artec Studio will hide all uploaded scans. This
mode helps you to determine how well the 3D scanner sees the object, and it
helps you to identify areas that may cause trouble during the scanning session.
To begin the scanning process, click the Record button in the Scan panel or press
the button on the device body.

• If your 3D scanner is equipped with a texture camera, Artec Studio will activate
the scanner’s texture ˊash and capture color images that it will later use to texture

1 Technically, the center of the range meter is the center of the depth of view. The 3D scanner has
near and far cutting planes (see Figure 2) that determine the optimum distance between the scanner and
the target object. Artec Studio offers the Range meter feature so you can easily visualize the distance
between the scanner and the object during the recording process. The Range meter comprises a set of
semitransparent diagrams located on the left side of the 3D View window (see Figure 28). Each histogram
displays the distribution of captured surface points by distance from the scanner. The color corresponds to
the set of surfaces from which it was obtained: by default, gray indicates registered key frames, dark green
indicates the last successfully registered frame and red indicates a registration error.
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the 3D model.

1. Prepare the object and make sure it has enough geometry and texture details (see
Selecting and Preparing Objects for Scanning).

2. Provide even lighting without using direct sunlight.

3. If you have connected just one 3D scanner to the computer, Artec Studio will select it
automatically; otherwise, youmust select the appropriate device from the dropdown
list under the Advanced section of the Scan panel.

4. Create a new project before getting started: use the button in the Workspace
panel, select File → New project from the menu, or use the shortcut Ctrl + N.
Once you have saved the project, you will be able to load or unload the scans as
necessary and thereby limit RAM usage (see Projects, Scans and Models for details).

5. Decide howmany sessions you need in order to capture the entire object. By using a
special third-party rotating table, you may be able to avoid interrupting the session
and eliminate the need to turn the object by hand. Depending on your choice, you
may

• Turn the object

• Position yourself to gain access to the other area

• Use a rotating table

6. Click Preview or press on the scanner. Direct the scanner at the object and practice
your movements around the object, taking into account the proper Technique.

Note: If you wish to use the Enable automatic base removal option, ˉrst
direct the scanner at the surface that supports the object.

7. Click Record to start capturing.

8. Gradually move the scanner while monitoring the process in the 3D View window

9. Capture what you can and pause or cease recording by clicking the Pause or Stop
button, respectively. Choose Stop if you must make adjustments to the object’s po-
sitioning (see the next step).

10. Turn the object or otherwise adjust it as necessary, then capture any remaining un-
scanned regions.

11. Once you have successfully captured the object from all sides, click the Stop button
or press on the scanner body.

5.5 Tracking Modes
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Ins and Outs

• Artec Studio still records texture in Geometry tracking mode if the scanner incor-
porates a texture camera

• Continuous scanning in the hybrid tracking mode is easier with the Scan using
auto-alignment option.

The software provides three tracking modes and one option:

Geometry + Texture, or hybrid The optimal (and default) algorithm for 3D scanners
equipped with a texture camera. It uses features from images obtained using the
texture camera as well as geometrical features of the object and thus is more likely
to successfully capture ˊat or textureless objects. The only possible drawback is
greater CPU utilization compared with other algorithms, potentially decreasing the
frame rate for less powerful computers. You can use this mode with Artec MHT,
Artec EVA, Artec Spider and third-party 3D scanners.

Figure 29: Texture tracking renders color object (scanner’s current ˉeld of view outlined
in green).

Geometry The default algorithm for all 3D scanners that lack a texture camera (Artec EVA
Lite). It uses only object geometry to align the scanned frames, making it suitable
for objects that have a rich geometry but not objects with large ˊat, spherical or
cylindrical parts. The Geometry tracking algorithm is the least CPU hungry.

Targets A special algorithm for scanning objects with special targets placed on their sur-
faces.

Real-time fusion (option) Available for both Artec 3D scanners and third-party 3D sensors,
this option fuses the results immediately after scanning.

See also:
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Figure 30: Main window when using Geometry tracking to scan objects.

Tweaking Scanning Options

5.5.1 Base Removal: Erasing a Supporting Surface

Ins and Outs

• Base removal is available for all tracking modes.

• If you click Stop or press , you should again identify the supporting surface.

• If the scene remains unchanged, you can also use the Auto-align new scans with
those marked in Workspace option. In this case, the application won’t prompt you
to identify the base.

• If base detection is successful, the base will always render in Recording mode.

When you capture an object, you can often omit from the scan any surface that supports
the object. The Base removal option serves this purpose. To employ this option, ˉrst indi-
cate the surface onwhich the object is resting and then capture the object. If this approach
is unsuitable for your situation, clear the Enable automatic base removal checkbox.

1. Open the Scan panel.

2. Make sure the Enable automatic base removal checkbox is selected.

3. Click Preview and direct your scanner at the surface that supports object (e.g., a table
or the ˊoor). A gray wireframe plane will appear, indicating the scene’s base.
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4. Once the application detects the base, it will display a message: “Now scan the
object.”

Important: If Artec Studio fails to detect a supporting surface, you can
still start recording.

5. Click Record ( ) and then direct the scanner at the object.

6. Scan the object freely. You can pause and resume the session as necessary.

7. Click Stop; all scans will move to the coordinate system with the Z axis normal to
the base.

8. Close the Scan panel. The Base removal algorithm will remove the previously de-
tected supporting surface. If not, erase it manually.

Figure 31: Scanning with the Enable automatic base removal option.

5.5.2 Resuming Scan After Lost Tracking

Artec Studio records adjacent frames on the basis of common surface features. If the scan-
ner stops recognizing common features, it will stop capturing the scene. This situation
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is called lost tracking; if it happens, just direct the scanner at a recently captured region.
There are, however, nuances, which we address below.

Table 2 lists several causes of lost tracking. The most common is moving the scanner too
fast.

Table 2: Causes of lost tracking.
Reason Possible Solutions
Moving the scanner too fast Move the scanner more slowly or increase the Scanning

speed
Scanner sees too few surfaces Apply an anti-glare spray or direct the scanner at a

larger part of the object; increase Sensitivity of Artec
Spider

Object doesn’t have enough
features for successful track-
ing

Apply masking tape or draw markers on the surround-
ing surfaces, and/or move the scanner more slowly

Figure 32: Alert message: tracking lost.

The Scan using auto-alignment option may ease the process of resuming tracking (this
option is enabled by default in the application settings). Note the following:

• Artec Studio switches almost instantly from displaying Tracking lost mode (see Fig-
ure 32) to Searching for position, which appears on a green background.

• To continue scanning, direct the scanner at a region you’ve already captured.

– Try to maintain the original scanner orientation toward this region
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– You need not necessarily use the most recent one, but it should have sufˉcient
texture features.

• If the application successfully resumes tracking, it will start recording in a newly
created scan. This new scan will already be aligned with the previous one.

The Scan Using Auto-Alignment section describes system behavior when this option is
disabled.

5.5.3 Auto-align new scans with those marked in Workspace

Auto-alignment is a great timesaver and may help simplify further processing. But for
projects that involve scans using Geometry + Texture tracking and for which the actual
scene is unchanged, you can continue scanning immediately:

1. Ensure that the Scan using auto-alignment option is turned on in Settings (see Cap-
ture).

2. Mark previously captured scans using the icon in the Workspace panel.

3. Select Geometry + Texture tracking as well as the Auto-align new scans with those
marked in Workspace checkbox in the Scan panel.

4. Click Preview, direct the scanner at a textured region you’ve already captured tex-
tured region—maintaining the original scanner orientation—and then click Record.

5. If tracking resumes successfully, Artec Studio will align the newly recorded scan
with the selected ones.

5.5.4 Scanning With Real-Time Fusion

Real-time fusion is a special mode in which Artec Studio builds a 3D model in real time
while you’re scanning. It’s the easiest and fastest way to obtain a model, but it cannot
completely replace the normal workˊow for processing raw scans after capturing them.
Thus, we recommend avoiding Real-time fusion in the following cases:

• The scene is large and the amount of GPU memory is limited

• Objects have complicated shapes that cannot be captured in one scan session

• The object has small geometric details

• Extra-high accuracy is required

The Real-time fusion feature is available for each tracking method.

1. Open the Scan panel.

2. Select the required tracking mode.

3. Select the Real-time fusion checkbox2.
2 If you selected the Targets mode and cleared the Disable hybrid tracking for .obc checkbox (see the

Photogrammetry Settings section), Artec Studio will clear the Real-time fusion checkbox because it doesn’t
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Figure 33: Real-time fusion model.

4. Click Preview and then Record. Observe the recommendations in Scanning Procedure.

5. Pause and resume the session as necessary.

6. When you stop scanning, theWorkspace panel will add one or more raw scans named
Eva Scan1, Eva Scan2, Eva Scan3 and so on, as well as one model named
Eva Scan1-Fusion. The number of these raw scans corresponds to how many
times you pause and resume scanning (see Figure 34).

Figure 34: Workspace panel after using Real-time fusion.

You can access the Settingswindow and use the Performance tab to conˉgure the following
Real-time fusion settings (see Real-Time Fusion Settings):

Voxel size 3D resolution of the model (i.e., the size of the triangulation-grid step in mil-
limeters). The smaller the value, the more geometric details you can detect and
capture in 3D.

5.5.5 Target-Assisted Scanning

Generally, you don’t need any special equipment to record using an Artec scanner. If the
object has hard-to-scan regions, however, targets may be useful. In some cases, they can
improve tracking and further registration.

5.5.5.1 Placing Targets

Whatever the method chosen, you should place at least non-coded targets on the object.

support this combination of options.
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Attach non-coded targets (Figure 35) to the object using the following rules:

• Try to place them on ˊat elements

• Avoid uneven surfaces

• Avoid obstructing signiˉcant geometric elements

Figure 35: Non-coded targets placed on an object.

Note: You can specify the target size in the Settings dialog of Artec Studio, as Photogram-
metry Settings describes. If you use non-coded targets from the Scan Reference kit, specify
5 mm for the inner diameter and 10 mm for the outer diameter. You should measure
targets from other suppliers and specify both diameters in the appropriate ˉelds of the
Settings dialog.

Place coded targets if your choice is photogrammetry (Using Photogrammetry Solution (Scan
Reference)).

1. Prepare the objects and surrounding scene. All objects must remain stationary dur-
ing measurement and capture.

2. Place the cross (Figure 37) on the scene, ensuring that it rests ˉrmly, and it is seen
from most points of view. Also double check that all targets on the cross are clearly
visible.

3. Place the coded targets on the object and the surroundings. Note that you should
distribute them such that at least six to eight coded targets are visible in each image.
Random placement is preferable; avoid symmetry and target alignment.

Figure 36: Coded targets.
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5.5.5.2 Using Artec Scanners Only

You don’t necessarily need a photogrammetry kit to beneˉt from targets placed on the
object you’re scanning; Artec 3D scanners can do all the work. This mode employs extra-
hybrid (Geometry + Texture + Targets) tracking and doesn’t require you to upload an OBC
ˉle.

1. Open the Scan panel in Artec Studio. Select Targets under Features to track.

2. Scan the object from all sides

3. Run Global registration

Note: As you scan (without having uploaded an OBC ˉle), the application registers the
target coordinates. You can then save an OBC ˉle and use it in later scanning sessions. We
strongly recommend running Global registration ˉrst, however.

5.5.5.3 Using Photogrammetry Solution (Scan Reference)

By using a combination of special reference targets and photogrammetric measurements,
you can scan large areas in one session, improve the accuracy of captured surfaces and
boost productivity by reducing postprocessing time. The only downside of this method is
the preparation. After scanning, however, you need not align the scanned surfaces, so you
can immediately proceed to Fusion (see the order of postprocessing steps in 3D Scanning
at a Glance).

This synergy of technologies is possible thanks to Artec 3D-scanner and photogramme-
try solutions. Several third-party photogrammetry offerings are available on the market.
Scan Reference photogrammetry is one example. The Scan Reference kit includes hardware
and software (see Figure 37), a digital camera, a reference-scale cross, non-coded sticky
targets (which Artec Studio uses to match the captured 3D data to the photogrammetric
measurements), and reusable magnetic coded targets (required to automatically carry out
measurements in the Scan Reference software).

To perform scanning using targets, follow these steps:

1. Take several photos of the object from different angles. To determine the appro-
priate number of photos, angles and targets for each image, as well as required
settings for a calibrated digital camera, consult the Scan Reference user manual and
FAQ article. General recommendations are as follows:

a) Take photographs at a distance of 0.5–1.5 meters with enabled ˊash

b) Each photograph should contain as much targets as possible and each target should
be captured at least in 10 photos

c) Entire cross should be captured in ˉrst 10–12 photographs

d) Capture the object from all sides

1. Move the cross and the coded targets away from the scene.
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Figure 37: Scan Reference kit
The kit includes (from left to right) coded targets (foreground), a digital camera, a scale cross, a

roll of tape with non-coded targets and a carry case.

2. Connect the camera to a PC, then transfer and process the photos using the Scan
Reference software. Once the calculations are complete, the software will display
measurement results on the screen. These results can appear as a point table or a
3D model.

3. Save the point model in an *.obc ˉle. This format is the software’s default.

4. Open the Scan panel in Artec Studio. Select Targets under Features to track.

5. Click Load targets from ˉle and specify the OBC ˉle path.

6. Scan the object. When you ˉnish, the software will align all scans.

Important: If you don’t want the texture and geometry features to assist target scanning,
select the Disable hybrid tracking for .obc checkbox (Photogrammetry Settings).

5.6 Using Certain Scanner Types

5.6.1 Notes on Scanning With Spider

Because Artec Spider has smaller ˉeld of view and provides higher accuracy in comparison
with Artec EVA, scanning using it can pose difˉculties. Consider the recommendations
given in Technique and also the following:

• Opt for rotating table if possible

• Use a piece of paper with text on it as artiˉcial texture

• Double check that objects don’t change their shape and position

• Try tuning sensitivity in particular cases (see Sensitivity). Avoid extreme values.
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We recommend using the Artec Spider scanner only after it reaches its normal operating
temperature. As soon as you plug Artec Spider in or connect it to a PC, it starts warming
up. If you open the Scan panel, you will see two lines that provide the device’s current
and optimal temperatures. Artec Spider will warm up faster when it’s in Preview mode.
The Scan panel also displays additional information about the time remaining until the
scanner reaches its optimal temperature.

Note: Artec Spider can operate at temperatures beyond its optimal range, but the accu-
racy of captured surfaces may be lower.

5.6.2 Notes on Scanning With Third-Party 3D Sensors

Important: Support for third-party 3D sensors is only available in Artec Studio Ultimate
13 and older.

Third-party 3D sensors are not speciˉcally designed to serve as 3D scanners. Because they
are multipurpose devices made from inexpensive components, they can scan objects, but
the texture and surface quality is far worse than that of professional Artec 3D scanners
(see Figure 38).

When using third-party 3D sensors, bear in mind the following:

Providing good lighting is critical because none of the sensors offers built-in ˊash. Also,
use of these devices precludes the ability to adjust the brightness of the texture
you are scanning, so good lighting is crucial to obtaining a decent model. Avoid
using too much illumination, and avoid using direct light or ˊuorescent lamps. Intel
RealSense R200 is particularly sensitive to direct sunlight.

When using PrimeSense and Asus Xtion sensors, a special technique can help you cap-
ture surfaces with consistent brightness:

1. Click the Preview button

2. Direct the sensor at the object and hold it for 5 secondswhile the sensor adjusts
white balance and exposure

3. Click the Record button

4. Move the scanner slowly to capture the scene

5. While scanning, keep the sensor as close to the object as possible

Most third-party devices work in the Real-time fusion mode, except for Kinect v2. More-
over, this mode is default for Intel RealSense 3D sensors.
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Figure 38: Object captured and processed
(Artec EVA scan on left and PrimeSense on right).

5.6.3 Notes on Scanning With MHT

The ˊash feature in an Artec MHT scanner has a very large but limited number of operation
cycles, so ensure that you disable the scanner when it’s not in use. Avoid leaving the Artec
MHT on for a long time when using the maximum capture rate (15 frames per second).
Artec Studio will automatically turn off the Artec MHT after ˉve minutes of continuous
operation. Normally the active mode/rest mode is 3 minutes of scanning and 7 minutes
of rest; this mode is optimal and signiˉcantly increases the lifetime of the ˊash.

5.7 Tweaking Scanning Options

5.7.1 Disabling Distance Color

The Show distance color option (Figure 28) highlights the reconstructed surfaces in the
ˉeld of view based on the working range of a particular scanner.

Red Surfaces are too close to the object.
Orange, green Corresponds to the middle of range. Green represents the optimal

distance.
Blue Surfaces are too far away from the scanner and about to disappear.
No color Surface is not being recorded.

In some cases you may need to observe how well texture is being recorded. Disabling this
feature would then help. Clear the Show distance color checkbox in the Scan panel to this
end.
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Figure 39: Scan panel in Artec Studio.
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5.7.2 Tuning Texture Brightness

Note: This option is available only for Artec 3D scanners equipped with texture cameras.

You can adjust the Texture brightness setting in Preview mode. Use the slider to increase
or decrease the brightness of frames captured by the color camera (see Figure 40). Note
that the texture brightness affects texture quality as well as tracking steadiness. Observe
the recommendations in the Table 3.

Table 3: Adjusting texture brightness.
Surface Color Recommendation
Dark or black Increase brightness
Light-colored or white Decrease brightness

Figure 40: Color-camera brightness adjustment
The brightness is lower on the left and higher on the right (slider from Scan panel overlaid on

image for clarity).

5.7.2.1 Preventing Overexposure

Artec Studio has error-prooˉng against overexposure. If the Auto-adjust brightness check-
box is selected and the speciˉed value of Texture brightness causes texture to overexpose,
the application will automatically decrease brightness to avoid damaging texture.
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5.7.3 Sensitivity

You can tune the Sensitivity of Artec Spider scanner if the application fails to reconstruct
particular surfaces. Increasing this setting enables the scanner to more easily capture
black, reˊective, translucent and ˉne objects (such as human hair). The higher the sen-
sitivity, the noisier the recorded surfaces will be. Higher values may also reduce the
scanning speed. For Eva and other Artec scanners, this setting is automatically adjusted.

5.7.4 Frequency for Capturing Texture Frames

Specify the frequency for capturing texture frames by using the corresponding spinner in
the Settings dialog (see Texture-Recording Mode and Figure 123).

5.7.5 Deactivating Scanner Flash

If circumstances prohibit you from using the scanner ˊash, follow the directions below.

Figure 41: Inˊuence of ambient light on captured results.
On left: ˊash is turned off; ambient light is poor; results—dark texture. On right: ˊash is turned

off; lighting conditions are improved; results—good texture.

Note that if you disable the ˊash, you should compensate by using bright ambient light.
According to our tests, acceptable texture quality is obtainable with the ˊash disabled if
the surface illuminance is at least 1 000 lux. Compare the models shown in Figure 41,
which were recorded under different lighting conditions.

The following procedure captures the textured model without using the scanner ˊash:

1. Open the Scan panel and click the Advanced link

2. Turn off the texture ˊash by selecting the Disable ˊash bulb checkbox

3. Use good illumination. Avoid ˊuorescent lamps.

4. Click Preview and direct the scanner at the object

5. Adjust Texture brightness and Texture exposure time. In most circumstances, values
should be as low as possible, because increasing the brightness also increases a
texture noise, whereas increasing exposure time can blur the texture. Instead of
adjusting sliders, try to further improve the lighting conditions.

6. Capture the scene
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7. Perform required postprocessing as described in Data Processing to get a textured
model

8. Adjust texture parameters for this model as described in Texture Adjustment. Pay
particular attention to the Hue and Saturation sliders. The Hue slider allows you to
correct unwanted texture color.

5.7.6 Tuning Exposure Time

You can alter texture exposure time in the Preview mode. Adjust this parameter in tandem
with the Texture brightness. Increasing exposure time can blur the texture. Don’t alter the
default value unless it’s necessary.

5.7.7 Disabling Texture Recording

Clear Don’t record texture checkbox if you don’t want to store texture information in your
scans. It is located in the Advanced section of the panel and disengages both texture
camera and texture ˊash in the scanner. Note that this option is unavailable for Artec EVA
Lite. Don’t forget to select this checkbox once you have completed textureless scanning;
otherwise, next time you want to start regular scanning the hybrid tracking mode could
be unavailable.

Important: Just using the Geometry tracking mode it is still not sufˉcient for the applica-
tion to don’t record texture. Make sure you clear the eponymous checkbox.

5.7.8 Decreasing Scanning Speed

Artec EVA captures objects at up to 15 frames per second, whereas Artec Spider at 7.5.
Default values ensure comfortable scanning with smooth movements. However, if you
ˉnd scanning speed inappropriate, you can decrease it. In this case, Artec Studio will
record fewer identical frames and register them faster. To this end, use the Scanning speed
slider in the Scan panel.

Important: Decreasing scanning speed may hinder scanning. Don’t use this slider unless
it is absolutely necessary.

5.7.9 Supplementary Settings

Customize scan names and starting number by entering your own values in the Scan
name and Start with ˉelds and changing the state of the Add scanner type in pre-
ˉx checkbox. The software uses these values to create a scan title in the Workspace
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panel (see Figure 42, left). You can change the default values Eva Scan and 1 to,
for example, Capture and 14.

Set saving scan data to disk Trigger a capturemode that simultaneously records scanning
results to a disk by selecting the Save scans directly to disk checkbox. This option is
enabled when you’re working with an existing saved project (see Saving a Project)
and can be useful when capturing large amounts of data on a computer with insuf-
ˉcient memory.

Specify a delay (in seconds) before recording using the Delay before recording spinner un-
der the Advanced section of the Scan panel. The countdown begins as soon as you
click the Record button. To eliminate the delay, set the value to zero.

Decrease speciˉed operating-zone (Depth of ˉeld) by using the Near (mm) and Far (mm)
sliders under the Advanced section of the Scan panel. Here you can only decrease
range within the speciˉed boundaries.

Specify the operating-zone boundaries (in millimeters) By default, Artec Studio provides
the correct values for the minimum and maximum limits within which the cutoff
planes are to be positioned. These values are different for each 3D scanner model,
and they ensure that you capture good-quality 3D data. If high accuracy is a sec-
ondary concern, you can manually adjust the depth boundaries, allowing you to cap-
ture objects using an Artec L scanner or third-party 3D sensors positioned closer to
or further from the object than is recommended. To do so, select the Override default
depth range checkbox in the Settings dialog in the Scan tab, then specify new bound-
aries for the scanning range (For more details about scan settings, see Capture).

Warning: Custom depth-range settings may reduce accuracy.

Conˉgure hiding Scan panel during scanning To widen the viewport during scanning,
software automatically closes the Scan panel once you start recording using Artec
EVA or Artec Spider scanners. The Hide this panel during scanning checkbox is lo-
cated in the Advanced section and is cleared by default.

5.8 Troubleshooting

Issue Possible Resolution
Geometry + Texture radio but-
tonmissing from Scan panel.

You were probably scanning without texture. Clear the
Don’t record texture checkbox in the Advanced section.

Final model contains notice-
able noise.

You likely scanned the affected areas improperly, or the
scanner was too far from the object. Rescan those areas.

Tracking lost error persists. Make sure Scan using auto-alignment is enabled in the
Settings dialog and use Geometry + Texture tracking.
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First Steps

6.1 Getting Started With Artec Studio

6.1.1 Windows, Panels and Bars

When you launch Artec Studio, you will see the main application window, which allows
you to perform all operations on scans and models.
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The main window is divided into several sections:

1. 3D View

2. Navigation cube

3. 3D toolbar

4. Workspace panel

5. Log window

6. Left panel (ˉgure depicts optionally open panel Tools)

7. Left toolbar

8. Not marked in the ˉgure: menu bar (top) and status bar (bottom).

The 3D View window displays all 3D data. You will use this window regularly. When the
application launches, a coordinate grid with coordinate axes will appear in the center.
Your scans and models will employ this global coordinate system.

To the left of the 3D View window is the left toolbar that contains icons for various applica-
tion modes, including Scan, Autopilot, Editor, Tools, Align, Fix holes, Measures, Multi, Texture
and Publish. These modes are mutually exclusive: the application can work only in one of
them at any given time, except for Autopilot. Some modes will lock the Workspace panel
when you use them.

To the right of the 3D View window is the navigation cube and the 3D toolbar containing
the following commands: Fit to view, Grid, Lighting, Color, Render mode and Backface.

TheWorkspace panel displays and manages all data uploaded to the application. Here you
will ˉnd your scans as well as project-manipulation commands, such as saving, erasing,

moving and renaming. You can reveal the hidden Workspace panel by clicking at the
top right of the 3D View window.

The Log panel sits at the bottom of the application window. The log is the software’s
report on any executed commands, specifying the time and details of each operation. It
also stores all error and troubleshooting messages generated by the algorithms.

The status bar contains information on memory availability and current usage by Artec
Studio. It also has a progress indicator for any currently running task, such as algorithm
execution, model and scan exporting, and so on.

6.1.2 Primary Settings

To access the settings dialog, select Settings… in the File menu. The settings window has
several tabs for various groups of application settings. To switch between the tabs, click
the icon at the top of the dialog. For a detailed description of the tabs, see Settings.

To change the language, select the Miscellaneous tab (Figure 127) and then the required
language from the list and click OK. You will be asked to conˉrm the operation and restart
the application. Once you agree, Artec Studio will automatically restart using the new
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interface language. If you choose not to restart, the changes will be applied the next time
you start the application.

Under the Performance tab you can specify the maximum number of alterations to be
saved, or specify maximum the size (in MB) of the history to be saved. The Data-
compression level slider enables you to adjust the compression level when saving project
data to a disk.

6.2 Object Types

After each scanning iteration, Artec Studio saves a separate scan. The list of all scans for a
given project appears in the Workspace panel (see Figure 42). Afterwards, the algorithms,
primarily Creating Models (Fusion), yield models.

Artec Studio can accommodate the following types of objects in Workspace:

Table 4: Object types in Artec Studio.
Type Content Origin Example

Name
Scan Set of frames From scanners Eva, Spider, Leo and Micro Eva Scan 1
Point-
cloud
scan

Point-cloud From Ray scanner Ray Scan 1

Model Polygonal
mesh

Algorithm output or imported mesh Sharp fu-
sion 1

6.3 Workspace Columns

Data in the Workspace panel is arranged in several columns:

6.3.1 Scan list

Selection ˊag scans marked with in this column will appear in the 3D View window
and will undergo processing by all Artec Studio algorithms and tools.

Color in this column, each scan has a colored square next to it. The square’s ˉll depends
on the number of scan frames loaded into the application. When all frames are
loaded, the square will be completely ˉlled in. When only key frames are loaded,
it will be half ˉlled, and when all the scan data is unloaded, it will be unˉlled (see
Selectively Loading Project Data). You can change the scan color by clicking on the
corresponding square and selecting the desired color from the palette.

ID order number of the scan.

6.2. Object Types 61



Artec Studio, ver. 14

Title when a scan is created, Artec Studio automatically assigns it a name, such as Eva
Scan 1, Eva Scan 2 and so on, according to the values in the Scan name and Start
with ˉelds as well as the state of the Add scanner type in preˉx checkbox in the Scan
panel. To rename a scan, select it by left-clicking on its name. Then either hit F2
or right-click on the scan name to open the dropdown menu. Select the Rename…
option. Both approaches open a dialog that allows you to specify the new name.

Loaded number of scan frames loaded into memory (see Selectively Loading Project Data).

Total total number of frames and size of a particular scan (in MB).

Max error the largest registration-error value among all frames in the scan. More infor-
mation.

Figure 42: Workspace panel: scan list (original view) on left and surface list on right.

6.4 Workspace Toolbar Commands

Toolbar located at the top of the Workspace panel duplicates commands from the menu
bar and helps to quickly create , open or save project, undo operations of the
command history, access Settings .

You can also access project statistics. Call a context menu (RMB) of any object inWorkspace
and select the Project info command.
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6.5 Selecting Scans and Models

To view a scan or model in the 3D View window or to process it, you need to mark it with
the icon in the Workspace panel. To navigate scans and models, use keys ↑ and ↓ or
click an arbitrary area except those in or Color column.

Purpose Method Alternate Method
Highlight scan in Workspace Left-click on the scan

name
—

Toggle visibility and availability
for processing ( flag)

Left-click in the leftmost
column

Hit Space on the
highlighted scan or
select scan name using
Shift+Alt+LMB

Batch selection (deselection) of
scans for display and process-
ing

Click Hit Ctrl+A (Ctrl+D)

Select a single scan for process-
ing and deselect others

Select the scan name
using Ctrl+Alt+LMB

Use Ctrl+LMB in the
empty area of the left-
most column

In addition to the methods in the table above, you can use commands from the dropdown
menu of the button. See also the full list of hot keys in Workspace.

6.5.1 Selecting Frames

Double-clicking the scan name opens the Surface List panel, revealing all frames in that
scan (see Figure 42, right).

Highlighting speciˉc frames will make them (and only them) appear in the 3D View win-
dow. When the Show other selected scans option at the bottom of the panel is checked,
the selected frames from other scans will also appear in the 3D View window.

You can select frames in a number of ways:

• Click LMB on the frame name to select it while clearing other selections.

• Click LMB while holding the Ctrl key to select several frames at once.

• Click LMB while holding the Shift key to select a sequence of frames in the spec-
iˉed range.

• Click the icon in the Surface list panel to select all frames or to clear the selection.

• Use the dropdownmenu for to quickly select all key frames or all textured frames.

• Click Ctrl + A to select all frames.

To start a sequential frame demonstration, use the Play command of the scan context
menu, button in the Surface list or Ctrl + P shortcut. To stop the demonstration,
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select Stop playback from the scan menu, click or hit Ctrl + P again.

6.5.2 Selecting Models

Double-clicking the model that contains no frames will bring a panel with its properties
(see Figure 43).

Figure 43: Model properties.

6.5.3 Selecting Point-Cloud Scans

Point-cloud scans contain only one surface. To access scan summary list, double click its
name in the Workspace. It includes the following data:

• Polygon and vertex count. Since Artec Studio doesn’t display all the points consti-
tuting the scan, you can only see a mesh obtained from a simpliˉed copy of the
actual point cloud.

• Points in point cloud Total number of points.

• Sections in point cloud. When you scan with Ray, you may select particular regions
(sections) to narrow down the actual scene. This parameter stands for the number
of these regions.

Context menu for a point-cloud scan has the Go to scanner viewpoint command that moves
camera to the exact position where Ray captured this scan.
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6.6 Memory Management and History

6.6.1 Selectively Loading Project Data

Whenworking with a large data set, youmay often ˉnd it necessary to free up RAMwithout
deleting any of the project data. To this end, Artec Studio implements a mechanism for
selectively loading scans. You canmove to disk any currently unused scans to free up extra
RAM. If a particular algorithm later requires any of the unloaded scans, the application
will automatically reload them. Frames that are not currently loaded into the memory
won’t show in the 3D View window.

Any scans or frames that are completely unloaded from memory will appear in a gray
italicized font in the Workspace window (see Figure 44).

Figure 44: Selectively unloading scans.

Note: Before you can change a scan’s loading status, you must save the project.

To change the loading status, select the scans in the Workspace window (using the Ctrl
key), click RMB and then select one of the scan-loading options in the pop-up menu (see
Figure 44):

6.6. Memory Management and History 65



Artec Studio, ver. 14

Table 5: Workspace menu commands and corresponding
icons.

MenuCommand Function Resulting Icon Appear-
ance

Unload scans Fully unload scans from memory
Load key frames
only

Only load key frames into memory

Load scans Fully load scans into memory
Load textures Fully load texture images into memory —
Unload textures Fully unload textures from memory —
— Scan loaded partially (some frames not

loaded)

Algorithms may automatically change the loading status of project data in the following
cases:

• You have selected unloaded scans for processing by clicking the button. Artec
Studio will load these scans into memory.

• Execution of the algorithm requires large amounts of memory. Artec Studio will
unload unused scans, frames, textures or a combination thereof.

• Algorithm needs certain frames and it loads only them.

Note: In addition to 3D data, the change history can also consume a large portion of
memory. For information on how to control the history size as well as how to unload or
clear it, consult History of Project Changes.
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Viewing Scans and Models

7.1 3D Navigation

When you have ˉnished scanning, Artec Studio displays the results in the 3D View window.

7.1.1 Moving, Rotating and Scaling

You can control the observer’s perspective in the 3D View window by moving or rotating
the observation point, or by zooming in or out. Use the mouse to control these effects:

Move move the mouse pointer over the 3D View window. Hold down the left (LMB) and
right (RMB) mouse buttons simultaneously, then move the mouse to relocate the
model. You can also use the middle mouse button to perform the same operation.

Rotate move themouse pointer over the 3D View window. While holding down LMB, move
the mouse to rotate the model. To ˊip 3D data around a speciˉc axis in a speciˉc
direction, use the dedicated arc arrows ( ) near the navigation cube (see Figure
47).

Zoom in and out hold RMB andmove themouse. Moving left or up will zoom out, whereas
moving right or down will zoom in. You can also use the mouse wheel to produce
the same effect.

You can also use 3D mouse to navigate 3D content (see 3D Mouse).

7.1.2 Global Coordinate System and Rotation Center

To enable or disable the global coordinate-system axes, select the Show grid option in the
View menu or Grid in the 3D View toolbar, or press G.
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Figure 45: Custom rotation center.
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When you rotate the model, the scene always turns around a certain point—the rotation
center. By default, the rotation center coincides with the origin of the main axis grid. To
change its location, double-click LMB at any point on the 3D model: the rotation center
will move to this point. Setting the rotation center can be useful when you wish to view
a particular object from all sides. Once it is set, rotate the view using LMB.

Artec Studio displays the rotation center as a small purple sphere with the three small
coordinate axes (see Figure 45). If the rotation center coincides with the origin of the
main axis grid, the purple sphere lacks small axes. If the rotation center hasn’t been
altered, it even lacks the sphere.

Application can set the rotation center to the center of mass of the object. Access the
following menu command: Edit → Cursor → Set to mass center. To go back to the default
state, select Set to origin of axis grid.

7.2 Choosing Projections

The View menu allows you to choose between perspective and orthogonal projections
when displaying the model in the 3D View window.

Perspective view is the central projection on a plane produced by direct rays that focus on
one point: the projection center. This method produces a visual effect similar to human
eyesight.

Orthogonal view is when the projection center resides inˉnitely far from the plane of pro-
jection; in this case, the projection rays are perpendicular to the observation plane. This
method preserves parallel lines and is more commonly used for measurement (see Mea-
surement Tools for details).

You can also change projection type in other ways:

• Hit Ctrl + 5 on the main keyboard

• Hit 5 on the extended numeric keypad (numpad)

7.3 Viewpoints

To quickly toggle a camera view between several predeˉned positions, use navigation
cube, View menu or the keyboard combinations listed in Table 6.

In comparison with the other ways, navigation cube provides more ˊexibility in orienting
objects in the window. Apart from using labeled faces (TOP, FRONT, LEFT, etc.), cube
allows one to orient scene to intermediate positions with the help of controls located on
the edges and vertices (see Figure 46).
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Figure 46: Navigation-cube controls (face, edge, vertex).

Table 6: Key combinations for switching viewpoints.
Viewpoint Keyboard Extended Numpad
Front Ctrl + Shift + 1 1
Back Ctrl + 1 Ctrl + 1
Right Ctrl + Shift + 3 3
Left Ctrl + 3 Ctrl + 3
Top Ctrl + Shift + 7 7
Bottom Ctrl + 7 Ctrl + 7

Figure 47: Navigation cube and arc arrows.

The Home command of the View menu or H keystroke restores the view to its original
position.

The Fit to view menu option, button or F keystroke automatically ˉts the object to the
3D View window.

For point-clouds, you can have a look at scan from the Ray perspective. Open the right-
click menu for this scan and select the Go to scanner viewpoint command to this end.

7.4 Displaying 3D Data

The toolbar on the right of the 3D View window features controls for data-display modes.

If minimized, it can be opened by clicking button in the 3D View window (see Figure
47). All the commands for viewing and switching between modes are also available in
the View menu.
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7.4.1 Rendering and Shading Modes

Both the View menu and the 3D View toolbar allow you to choose one of the following 3D
rendering options for scanned frames:

Render solid the most common way to render with a solid ˉll on all faces using your
selected shading method

Render wireframe display polygonal-mesh edges without applying a solid ˉll to the faces

Render points display polygonal-mesh vertices

Render wireframe over solid apply a solid ˉll to the faces and use a different color to dis-
play edges. This method enables you to visually assess the quality of the polygonal
model (see Mesh Simpliˉcation for details).

Render points and solid automatically display scans in point view, but display models in
solid-ˉll view. This mode eliminates the need to switch to another mode in order
to ˉnd the best rendering approach for each surface type. It is enabled by default
for the Artec Spider scanner.

For some examples of the various model-rendering modes, see Figure 48.

Figure 48: Examples of model using different rendering modes.
Point model on left and wire over solid on right.

To choose a shading method for the solid ˉll, use the View menu:

Smooth shading the color value for each point in a triangular face is calculated using color
interpolation at the vertices

Flat shading all the points on a triangular face are assigned the same color

7.4.2 Lighting, Color and Texture

The Lighting option in the View menu or in the toolbar, or L hot key toggles the lighting
in the 3D View window. This option may be useful when you must turn the lighting off to
see only the outline of the model or to assess texture quality.

7.4. Displaying 3D Data 71



Artec Studio, ver. 14

Figure 49: Smooth versus ˊat shading (respectively).

The Color subgroup in the View menu or Color mode section in the toolbar list the methods
for assigning colors to the surfaces in the 3D View window:
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Texture

displays textured data;
otherwise, the software
uses the scan’s default
color

Ctrl+Alt+1

Scan
color

displays the default color
of the scan; the ˉgure de-
picts two scans

Ctrl+Alt+2

Surface
color

displays each frame in a
scan using a different color Ctrl+Alt+3

Max
error

colors the frames from Eva
and Spider in accordance
with their registration qual-
ity from green to red via
yellow and orange; red in-
dicates unacceptable val-
ues and registration errors

Ctrl+Alt+4

X-ray

beneˉcial for noisy data
since it highlights only ar-
eas with high point den-
sity; it features a slider for
adjusting its intensity

Ctrl+Alt+5
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7.4.3 Back-Face Rendering

Artec Studio offers three methods for rendering a frame’s back face:

Show assigns the back face the same color as the model

Cull the back face is not displayed

Black renders the back face in black

You can choose the mode from the View menu or from the toolbar in 3D View window.
See Figure 50 for examples that illustrate the different methods of back-face rendering.
Black is the default mode.

Figure 50: Examples of different methods for back-face rendering.
Show back-face mode on the left, hide (Cull) in the middle and Black on the right.

7.4.4 Representation of Normals and Boundaries

The Show normals option in the View menu enables or disables rendering of normals for
each vertex. By default, the normals point away from the model surface and toward the
3D scanner. You can change this direction using the Invert normals command. You can
also switch between modes for displaying normals by hitting the N key with the 3D View
window active.

When working with edges, the Show boundary feature in the View menu allows you to
enable and disable highlighting of the model’s edges. To toggle this feature, hit the B key
with the 3D View window active.

7.4.5 Rendering and Texturing Untextured Polygons

Textured models may have some untextured areas (for instance, the green area in the
middle of Table 7). The Render polygons without texture option in the View menu allows
you to toggle rendering of such areas.

If the texture of the importedmodel is smaller than themodel itself, Artec Studio can wrap
it to ˉll the untextured areas (see Table 7). The wrapping effect is similar to ˊoor tiling
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or a repeating wallpaper pattern—that is, the texture repeats periodically. To activate this
option, enable the Wrap texture coordinates option in the View menu.

Table 7: Rendering and texturing untextured polygons.
Options Enabled Result

None

Render polygons without texture

Wrap texture coordinates

7.4.6 Displaying Boundaries of Texture Atlas

Textures applied to 3D models are obviously two-dimensional. You may, however, want
to see the boundaries of each texture patch on the actual 3D surface. Artec Studio can
display a texture-atlas ˉle, such as the the middle image in Figure 94, with its boundaries
highlighted (see Figure 51). Identifying the way in which the boundaries lie on the surface
may, for example, help you determine whether you must simplify the model to get better
texture application.

To enable boundary display, access the View menu and select Show texture boundaries or
hit the Shift+B keys with the 3D View window active. To disable this feature, make sure
this menu command is unchecked.

Technically, this command also works for textures produced by triangle methods, but it
provides no usable information.
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Figure 51: 3D model with texture-atlas boundaries.

7.5 Saving Screenshots

You can capture surfaces displayed in the 3D View window and save them in a graphics
ˉle. Unlike the conventional system Print Screen command, this option saves only the
contents of the 3D View window and uses the speciˉed background color (see Background
for screenshots transparent, black or white).

Tip: When saving screenshots in X-ray mode, avoid using transparent background.

To capture a screenshot, follow this procedure:

1. Select the Save screenshot… option in the View menu, or hit Shift+Ctrl+S.

2. In the dialog, specify the destination folder and ˉle name, then click the Save button.
Artec Studio will save the ˉle in PNG format.

Note: If you save a screenshot using an existing ˉle name, Artec Studio will overwrite
that ˉle without warning. Be sure to specify a unique ˉle name to avoid overwriting other
ˉles.
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Projects, Scans and Models

A project encompasses all 3D data obtained by scanning and postprocessing that can be
saved to disk and accessed for later use. In addition, it contains command history and
measurement results. For each project, a corresponding folder contains all project data as
well as a project ˉle describing the structure of that data.

Artec Studio can display project statistics. It includes information on number of scans,
surfaces (frames), polygons, vertices and UV coordinates. To access this data, call a right-
click menu for any Workspace object and select Project info. If you want to collate data on
the selected scans with the total numbers for the project, ˉrst mark the required scans
using with the ˊag.

8.1 Creating a Project

To start a new project, select the File → New project menu option. It is a best practice
to save this project to a speciˉc folder before you start scanning. If you start scanning
with the Save scans directly to disk option enabled or import scans from Ray, a temporary
project is created in the Windows temporary folder or another directory if you speciˉed
one in Settings.

8.2 Saving a Project

You can save your project using the File→ Save project menu option, by clicking at the
top of the Workspace panel or by hitting Ctrl + S.

While you’re working with a saved project, the header ofWorkspace panel displays its name
and the application window its full path. Save project from time to time in the course
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of processing or otherwise using the scanned material.

Note: Artec Studio saves data incrementally, meaning that if you save an existing project,
the application will only save newly changed or added data.

8.3 Opening Project and Scans

To open an existing project, use the File → Open project menu option, click at the top
of the Workspace panel or hit Ctrl + O.

Note: Files from Artec Studio versions 8, 9, 10 and 11 are mutually compatible. Earlier
versions, however, may be unable to open projects saved in a later version using the
SPROJ format.

By default, when you open a project, the application will restore it to the state in which
it was last saved (the three scan-loading states include loaded, unloaded and key frames
only—see Selectively Loading Project Data). To load faster by opening the project without
loading any scans, use the Open project (scans not loaded) dropdown menu option under
the button. Alternatively, use the same option from the File menu or hit Ctrl +
Shift + O.

Note: When Artec Studio opens a project, it will determine the amount of available
memory. If the scan you are trying to load requires more memory than is available in your
system, the application will process it as an “unloaded” scan.

8.3.1 Opening a Project from Leo

You can obtain projects from Leo via direct connection to the scanner or using an SD card
installed in the device.

8.3.1.1 Connecting to Leo

1. Ensure that your Leo scanner and your computer are connected to the same network
and you authenticated using the same credentials

2. Click File → Import → Leo project (connect to scanner)

3. Select the required device from the list and click Connect1

1 If Artec Studio doesn’t list your Leo, try connecting to the device by manually specifying the IP address.
Click Connect by IP to this end.
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4. Then using either LKM or ↑ and ↓ select the project that you want to load (Figure
52)

5. Click Import. Wait for scans and real-time fusion models (RTF) to appear in the
Workspace panel. If the scans contain information on supporting surface and the cor-
responding option is enabled in Settings, application will also launch base removal.

Figure 52: Dialog for selecting Leo projects to import.

8.3.1.2 Using SD Card

If you want to open Leo scans without having to connect to the device, use the following
method:

1. On Leo, ˉrst copy a project to SD card.

2. Then insert the card into the computer with installed Artec Studio.

3. Click File → Import → Leo project

4. Browse for the required project folder

5. Select the folder containing Leo project and click Select folder. Import will start.

8.4 Importing Models and Scans

Importing is another way to load data into Artec Studio in place of capturing or opening
a project. You can import scan ˉles created in earlier versions of the software, individual
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frames, as well as point cloud data in the following formats:

SCAN Artec 3D scan format
PLY Stanford polygon ˉle format
STL Stereolithography ˉle format
VRML VRML ˉle; actual extension is *.wrl
OBJ Wavefront OBJ ˉle format
PTX Disney per-face texture mapping format
C3D Artec Ray original point cloud
BTX Artec Ray point cloud

To import a ˉle, use the File→ Import → Scans, meshes or point cloudsmenu option, Ctrl
+ I or the dropdown menu option for the button. Next, select a ˉle for importing.
You can also drag and drop a ˉle into the main Artec Studio window, or just double click
on it.

Note: The import process runs in the background, so you can continue working with the
scans you’ve already loaded. The progress indicator for the import operation will appear
at the bottom of the main application window. To abort the operation, click Cancel in the
bottom-right corner.

Figure 53: Dialog for selecting surfaces to correct.

Artec Studio will import frame ˉles as individual single-frame scans. After importing each
scan, the application calculates the key frames for any scan that contains more than one
surface. Also, the application will check the surfaces for defects when the appropriate
setting is enabled (see Surface-Consistency Detection During Import). If it ˉnds defects, it
will show a dialog with a list of defective surfaces once the import operation is complete.
You can then choose which ones should be corrected (see Figure 53).

8.5 Exporting Models, Scans and Point Clouds

When you want to store data for future processing, the best approach is to save the project
as an SPROJ ˉle or to export the data to the SCAN format. Any Artec Studio version can
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open the latter format. If you plan to use the data in other applications, however, you
should save scans and individual frames in another format.

You may also need to perform one of the following tasks:

Export one or
more scans

File → Export
→ Scans

Doing so will save all frames to folders with names
that match the corresponding scan names. An ex-
ception is the SCAN format; in this case, Artec Stu-
dio not only stores the frame-by-frame scan struc-
ture, but it does so in a single ˉle.

Export a single
surface

File → Export
→ Meshes

It works for models. If you, however, marked several
scans, models or frames using the button, Artec
Studio will suggest merging them.

Export Ray
scans

File → Export
→ Point clouds

It works for point-cloud scans from Ray.

8.5.1 Exporting Scans

To export scans:

1. Mark any scans you want to export using the button.

2. Select the Export scans… command in the dropdown menu option of in the
Workspace panel.

3. Click the … button to open and specify the destination folder.

4. Select Scan export format using the eponymous dropdown list.

5. If the selected format supports textures, also specify the texture format.

6. Select the Apply transformation checkbox, or leave it cleared (for more information,
consult Understanding How Artec Studio Applies Transformations).

7. Click OK.

ply Stanford polygon ˉle format
stl Stereolithography ˉle format
obj Wavefront OBJ ˉle format
wrl VRML ˉle; actual extension is *.wrl
x Direct X ˉle format
scan Artec 3D scan format
plyVC Stanford polygon ˉle format with vertex colors, actual ex-

tension is *.ply
obc OBC point-cloud ˉle

Note: The export process for models and scans runs in the background, so the appli-
cation will allow you to continue working with the scans. The progress indicator for the
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export operation will appear at the bottom of the main application window. To abort the
operation, click Cancel in the bottom-right corner.

8.5.2 Exporting Meshes (Models)

To export a mesh:

1. Mark one or more models using or select frames in the scan by clicking on them
while holding the Ctrl key.

2. Select the Export meshes… command in the dropdown menu of the button in the
Workspace panel.

Tip: File → Export → Meshes command and Ctrl+Shift+E hot key
also work.

3. Specify the destination folder, enter the ˉle name, and select the appropriate mesh
format from the dropdown list2.

4. Click Save.

5. If the model has texture and the format supports it, specify the Texture export format
in the new dialog (see Storing and Exporting Color Information).

6. Click Export.

PLY Stanford polygon ˉle format (standard and with the support
for vertex color)

STL Stereolithography ˉle format
VRML VRML ˉle (1.0 and 2.0); actual extension is *.wrl
OBJ Wavefront OBJ ˉle format
ASC Point cloud 3D format
AOP American Academy of Orthotists and Prosthetists ˉle format
PTX Walt Disney Ptex: mesh with per-face texture mapping
X Direct X ˉle format (binary and text)
XYZRGB XYZRGB ˉle format
E57 ASTM E57 3D ˉle format

See also:

Model Placement
2 If you type an extension in the ˉle name ˉeld, application will use it rather than the selected mesh ˉle

format.
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8.5.3 Exporting Point Clouds

You can export point-cloud scans obtained from Ray scanner to either of the following
formats (respective units are given in the third column):

PTX Leica Geosystems Cyclone Point Cloud. Important!
Don’t confuse with Disney Ptex.

Meter

XYZ XYZRGB ˉle format Speciˉed in settings
BTX Artec Ray point cloud; various versions (v2, v3, v5,

v6).
Micron

1. Mark one or more point-cloud scans using ˊag in Workspace. Ensure that you
have selected a point-cloud scan by double-clicking its name: the panel must show
point-cloud properties.

2. Select File → Export → Point clouds.

3. Specify the destination folder and required format and click Save.

8.5.3.1 Merging Sections

When exporting to PTX, ensure theMerge sections during export to PTX checkbox is marked
in the Artec Studio settings. This option merges all sections (selections made during scans
with Ray scanner) so that third-party software products can open the exported ˉle.

8.5.4 Understanding How Artec Studio Applies Transformations

Artec Studio offers two options for exporting surfaces:

1. Store surfaces using the scanner coordinates and create XF text ˉles that contain
the coordinates calculated during registration. To use this approach, clear the Apply
transformations checkbox.

2. Store surfaces that are relocated to the positions calculated during registration. In
this case, XF ˉles contain no relevant data. To use this approach, select the Apply
transformations checkbox.

8.5.4.1 Special Aspects of Scan Placement

In most cases when you’re exporting a scan to a common 3D-graphics format, you should
select the Apply transformations checkbox. By doing so, you instruct third-party applica-
tions to display surfaces in the same way that Artec Studio does: that is, with the origin at
the center of mass. If for some reason you need to store a scan in the scanner’s coordinate
system—in other words, with surfaces located at a distance from the origin that is equal
to scanner’s operating range—clear the Apply transformations checkbox.

Technically, Artec Studio saves scans in the scanner’s coordinate system, but it displays
them in a user-friendly manner by placing the origin at the center of mass. The actual
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positions of surfaces calculated during registration are stored in text (XF) ˉles. Therefore,
when you’re importing ˉles using Artec Studio, it makes no difference whether the check-
box was cleared when Artec Studio exported them. It does make a difference, however,
for third-party applications that cannot read XF ˉles simultaneously with 3D geometry.

8.5.5 Storing and Exporting Color Information

You can transfer color information for 3D surfaces in three ways. The most common is
through a texture using a separate bitmap ˉle (see Applying Texture (Procedure)). Another
option is to save color information in each vertex of a mesh. The third is to assign a small
textured fragment to each polygon. The two latter methods produce no texture ˉles.

Colors stored in a vertex are blended throughout the polygon. As a result, you should avoid
oversimplifying the exported mesh; otherwise, colors blended over a large face may fail
to render true texture information.

Table 8: Formats that support color-information transfer.
Texture stored as a bitmap PLY, VRML (*.wrl), OBJ, X, e57
Model file contains separate texture for each face PTX
Formats that support vertex color plyVC, XYZRGB

When exporting texture as a bitmap image, you can select one of the following formats:
PNG, BMP or JPG. PNG format provides the best quality for a given ˉle size thanks to its
lossless image compression. JPG is the most compact format.

8.5.6 Exporting Target Coordinates

If you scan while in the Targets tracking mode using only Artec scanners, you can save an
OBC ˉle containing the target coordinates. Once you ˉnish scanning, run Global registra-
tion, then do the following:

1. Use the button to mark any scans that you captured without having uploaded an
OBC ˉle.

2. Select the Export scans… command from the File menu, or select the corresponding
dropdown menu option of in the Workspace panel.

3. Click the … button to open and specify the destination folder.

4. Select obc from the Scan export format dropdown list.

5. Click OK. The targets.obc ˉle will appear in the folder you speciˉed.

For more information on the OBC ˉle structure, consult the FAQ.
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8.5.7 Exporting to Leios

Artec Studio enables you to export ˉles to Leios by accessing the File menu if the Leios
software is already installed on your computer.

1. Select a model in the Workspace panel

2. Open File → Export to Leios

3. Then, in Leios, select millimeters as the length unit for the imported ˉles.

Figure 54: Model exported to Leios

8.5.8 Exporting to Geomagic Design X

Polygonalmodels created in Artec Studio are insufˉcient formost design needs. Geomagic
Design X (formerly Rapidform XOR) is purpose built to create manufacturing-ready CAD
models directly from meshes.

To export a model,

1. Make sure Geomagic Design X is installed on your computer

2. In the Workspace panel, mark one model using the ˊag

3. Select the Export to Design X command from the File menu

4. Wait for the model in OBJ format to open in the reverse-engineering system.
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Figure 55: Model exported to Geomagic Design X
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8.5.9 Exporting to SolidWorks

Artec Studio allows you to export models to SolidWorks by using third-party plug-ins. It
supports the following plug-ins:

• Geomagic for SolidWorks

• DezignWorks for SolidWorks

To export a model,

1. Make sure SolidWorks and either of the plug-ins are installed on your computer

2. In the Workspace panel, mark one model using the ˊag

3. Select the Export to SolidWorks command from the File menu

4. Wait for the model to open in the CAD system.

8.6 History of Project Changes

Artec Studio stores all data changes and you can later undo most of them. To undo an
operation, click the button in the Workspace panel. To perform the previously undone
operation, click . You can also use Ctrl + Z or Ctrl + Y. Use the dropdown menu
of commands or , respectively, to undo or redo several operations at once.

When you save a project, Artec Studio stores 3D data together with the history of changes.
You can select the maximum length of the history in the settings window under the Per-
formance tab (see Command History). In addition, the Compact memory button allows you
to save the history of changes on a local drive and thus free up RAM. Also, the Clear com-
mand history button clears the change history, likewise freeing up RAM, and makes the
undo operation for the most recent changes unavailable. To clear the history, you can use
the Edit → Clear history menu option in the main window or hit Ctrl + Alt + H.

8.7 Autosaving a Project

A project can be saved by either the user or Artec Studio. The latter case is called autosav-
ing. For temporary (i.e., unsaved) projects, autosaving is unavailable. The application
autosaves a project in the following cases:

• Before running the texturing algorithm (see Texturing)

• When scanning is complete and the Save scans directly to disk option is selected (see
Scanning Procedure)

• When unloading scans with unsaved changes (see Selectively Loading Project Data)

• When the Save project before starting algorithms setting is selected (see Autosave
Options):
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– Before launching algorithms from the Tools panel

– Before and after running the Global registration algorithm (Global Registration)

– Before starting Autopilot (Use Autopilot).
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Data Processing

Once you have captured an object from all desired angles and created a sufˉcient number
of scans, you can then build a 3D model. This chapter offers a detailed description of the
process.

The process of creating the ˉnal model includes the following stages:

See also:

3D Scanning at a Glance.

• Revising Scans and Editing Scans

• Scan Alignment

• Global Registration

• Creating Models (Fusion)

• Editing Models

• Texturing

9.1 Maximum Error and Registration Quality

Max error is the parameter that reˊects frame registration quality. For scans, it shows
the maximum value among all the frames. The larger the value, the less accurate the
alignment. Artec Studio displays noteworthy values only for scans that have passed Fine
registration, Align and Global registration.
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Table 9: Max error values.
Scanner type Max error Recommendations
All 0–0.2 Good results
All >10 Run registration
Spider 0–0.3 Acceptable unless high resolution is required
Spider 0.4–0.5 Acceptable for large objects
Spider >0.6 Unacceptable
Eva 0.4–0.7 Acceptable for small objects
Eva 0.8–1.2 Acceptable for large objects and unacceptable for

small ones
Eva >1.2 Acceptable for large objects
— Warning! Check the frame list
— Failed Indicates unregistered frames

9.2 Revising Scans

As you begin building a 3D model, you may want to start by preprocessing your scans:
separate misaligned areas (if any) into separate scans and cut out unwanted objects from
the scene.

You may encounter the following problems:

Figure 56: Possible scan errors.
Bad geometry on the left, scan misalignment in the middle and hands captured in frames on the

right.

• Misaligned frames (see Figure 56, left)—may occur because of small size, an insuf-
ˉcient number of geometrical features on the object or an insufˉcient number of
polygons in a frame.

• Misaligned parts (see Figure 56, middle)—occurs when the real-time alignment al-
gorithm incorrectly determines the position of the new frame relative to previous
ones.

• Unwanted objects in the frame (see Figure 56, right).
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A visual inspection of the frames can be very helpful in determining problematic areas.
To perform a visual inspection, select the scan and view all the frames that it contains by
holding ↑ or ↓ on the keyboard. This technique can easily detect misaligned frames.

When viewing scans, application generally shows only key frames and textured frames. To
display all the frames, select the Show all frames option in the 3D toolbar.

See also:

Misalignment Detection.

9.2.1 Separating Scans

During the ˉne-alignment process, frames in certain scans may bemisaligned. Sometimes
it’s possible to divide the problematic scan into several scans, where each part is registered
fairly well. In this case, divide the scan. To move some of the frames into a new scan, use
the following procedure:

1. Select in the Surface List panel the frames you want to move (see Selecting Frames).

2. Click RMB and select Move to new scan (Figure 42, right).

You can also ˉx alignment errors in another way: reset the current frame-transformation
values and repeat the registration, making any appropriate changes to the settings. Select
the desired scan in theWorkspace panel, click on it using RMB and select Reset transforma-
tions from the dropdown menu. Doing so will reset the computed positions of individual
frames in the scan. A dialog will then appear, prompting you to conˉrm the operation. To
compute new positions, run the Rough serial registration and then Fine registration algo-
rithms (see Fine Registration).

9.3 Alignment and Registration at a Glance

Registration and alignment tools perform similar tasks, however, they differ. Use the table
below to get an insight into the details.

Table 10: Understanding registration and alignment
modes.

Type Purpose Details
Fine regis-
tration

Adjusting frames’ positions Treat scans in batch separately. Starts
once you leave Scan panel.

Align Assembling scans See also Table 11
Global reg-
istration

Optimizing frames within scans Launch it for a pre-aligned batch of
scans or for a single scan

Rough reg-
istration

Preliminary registration per-
formed during scanning

No need to start it manually
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9.4 Editing Scans

To edit scans, open Editor from the side panel and select the Eraser tool. You can also use
Positioning tool or Transformation tool to orient the scanned data.

Figure 57: Editor panel.

9.4.1 Eliminating 3D-Noise (Outlier Removal)

During the scanning process, so-called outliers may appear in the scene. Outliers are
small surfaces unconnected to the main surfaces. They require removal because they may
spoil the model or produce unwanted fragments. Artec Studio provides two ways to re-
move outliers: erase them before fusion (preventive approach) or after fusion (“furthering”
approach—see Small-Object Filter). We advise using the former approach because it de-
creases the possibility of improper fusion by preventing noisy features from attaching to
the main surface.

This outlier-removal approach is based on a statistical algorithm that calculates for every
surface point the mean distances between that point and a certain number of neighbor-
ing points, as well as the standard deviation of these distances. All points whose mean
distances are greater than an interval deˉned by the global-distances mean and standard
deviation are then classiˉed as outliers and removed from the scene.

For better results, we recommend running global registration before starting the algo-
rithm. If you begin Outlier removal before doing so, a dialog will appear prompting you to
perform global registration.

In most cases, none of the parameters accessible through the button requires adjust-
ment. But if necessary, you can change the values of these parameters:

std_dev_mul_threshold a standard-deviation multiplier. We recommend choosing the
value for this parameter according to the following guidelines:

2 for noisier surfaces

3 for less noisy surfaces
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Figure 58: Outlier removal: before and after.

resolution should be set equal to the resolution of the Fusion process that you expect to
run later.

Click Apply to run Outlier removal.

9.4.2 Erasing Portions of Scans (Eraser)

Nearly always, the scanning process will capture unwanted elements, such as walls, the
operator’s hands, surfaces on which the object is located and other extraneous objects.
This unwanted data can hinder postprocessing. To avoid this problem, we recommend
eliminating these objects before processing. Eraser offers several options to quickly and
easily remove unwanted elements from the scene (see Selection Types).

1. Open the Editor panel using the side toolbar.

2. Open the Eraser tool by clicking or by hitting E.

3. Select one or more scans in the Workspace panel.

4. In the Editor panel, choose the required selection type.

5. Consult the instructions for a speciˉc mode and select regions on the scans that you
want to erase. To clear all selections, click Deselect.

6. Click Erase to eliminate the area highlighted in red or to apply cutting plane (Cutoff-
plane or Base selections).

To undo changes, click in the Workspace panel or menu Edit, or hit Ctrl + Z. Each
click of the Erase button generates a command history entry. To undo several operations,
use the dropdown menu of button and select the lowest entry.
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9.4.2.1 Selection Types

2D Hold down Ctrl and use Scroll wheel to adjust the
tool size. Paint with Ctrl+LMB to create a selection.

3D See above.

Rectangular Use Ctrl+LMB to select a rectangular region.

Lasso Use Ctrl+LMB to freely outline an irregular region.

Cutoff-plane Create selection as in 2D mode. Once you have released
the mouse button, a plane will appear. If necessary, ad-
just the plane level by using Scroll wheelwhile hold-
ing down Ctrl+Shift or orient the plane freely in 3D
space. To this end, hit Alt to display the designated con-
trol. Then still holding the key, drag the required control
ring.

Base Select a ˊat area as in 2D mode. The tool will automati-
cally ˉt the base plane and select everything below it.

If the Select through checkbox is selected, all surfaces throughout the scan are affected.
If not, the brush only works on the visible surface.

Use the following general procedure to erase unwanted elements:

See also:

Hot keys in Editor.

9.4.2.2 More Actions With Selections

Apart from erasure, you can perform the following action with the selected regions:

• Clear selection to create a new one. Click Deselect or reselect the region manually
while holding down Ctrl+Alt.
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Figure 59: Select through in 2D selection: disabled in the middle, enabled on the right.

• Invert selection (clear the highlighted region and select the rest). It might be useful
when working with large scans. Click Inverse or hit I.

• Temporarily hide selection if it obstructs the region you want to erase. Click Hide to
this end. To display hidden polygons, click Show. Then select the region you want
to erase.

9.4.2.3 Erasing Supporting Surface

Artec Studio offers two selection modes that differ from conventional brushes in the way
how you select the area for erasure. First, you indicate the ˊat surface (table, ˊoor or
base) on which the object is resting. Then, application either determines the base plane
and select the area underneath it (Base selection), or creates a cutting plane (Cutoff-plane
selection) that divides the scan into two parts: the ˉrst will remain and the second will be
erased (see Figure 62). You can orient this plane in any way you need.

Tip: Consider using the Enable automatic base removal option when scanning since it
deletes the ˊat surface automatically after you close the Scan panel.

Figure 60: Various controls for orienting cutoff plane: around axes (X, Y and Z) and view
direction.
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Figure 61: Selecting a ˊat region in the Cutoff-plane selection mode.

Figure 62: Cutting plane

Figure 63: Erasing results
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9.5 Fine Registration

Fine registration is an algorithm designed to precisely align captured frames.

In a number of cases you can start the Fine registration algorithm manually using the
Tools panel. To access a list of parameters, click the button in the Fine registration
section. The algorithm affects all scans marked with the icon in the Workspace panel
(see Selecting Scans and Models for more information on scan selection), but it processes
them separately.

registration_algorithm is a type of registration algorithm.

Geometry_and_Texture takes both texture and geometry into account. If the scan lacks
texture information, the algorithm will run on geometry only.

Geometry uses geometry only. Unless your scan entirely lacks texture, we recommend
avoiding this option.

9.6 Scan Alignment

Although Artec Studio features continuous scanning, there may be some cases where the
application lack sufˉcient information about the relative positions of multiple scans. To
assemble all scans into a single whole, you must convert the data to a single coordinate
system—that is, you must perform alignment using the Align tool.

Hint: First refer to Auto-Alignment and take a glance at the Summary of Alignment Modes
section as well.

9.6.1 Selecting Scans for Alignment

In the Workspace panel, use the ˊag to mark all scans that you intend to work with.
Once you click Align in the side panel; the marked scans will appear in the left panel
already selected in the same order as they appear in the Workspace panel. During the
Align operation, Artec Studio divides the selected scans into two sets: aligned (registered)
scans and unaligned scans. The ˉrst set initially contains only one scan (the ˉrst one in
the list), which is highlighted in blue. Its name appears in bold and uses the same color
icon ( ). Auto-Alignment, however, may produce several groups of aligned scans.

The user’s task is to align all scans to those that are already registered and to “assemble
a model”. In general, the procedure includes the following steps:

1. Click the required tab in the Align panel.

2. Select one scan from the unregistered group in the Align panel. The name of un-
registered scan appears in a regular typeface. When selected, the unregistered scan
is marked by the green icon . You can select several scans using either of the
following methods:
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• Press and hold down the Ctrl key, and then click each scan that you want to
select

• Click the ˉrst item, press and hold down the Shift key, and then click the last
item.

3. If necessary, specify point pairs (for two scans) or sets of points (for more than two
scans)

4. Click the desired alignment-command button (Auto-Alignment is the most recom-
mended one). The command affects all scans selected in the Align panel plus the
ˉrst one ( ).

Since each mode varies in its effects, see the details in the corresponding subsections
for more information. Note that you can use either one mode or a series of modes (see
comparison table in Summary of Alignment Modes): drag alignment, rigid alignment with
and without point speciˉcation, automatic rigid alignment, and alignment with surface
deformations.

9.6.1.1 Changing Scan Status

If you have already aligned several scans, you should move them to the registered group.
Select them in the Align panel using LMB. Next, click RMB on the name of any scan and
select theMark as registered option from the dropdownmenu, or just double-click its name
in the list. At this point, Artec Studio will treat registered scans as one, so you cannot move
them independently.

If you accidentally mark a scan as aligned, remove it from the registered group by selecting
the Mark as unregistered item from the dropdown menu, or just double-click it.

9.6.2 Displaying Scans in 3D View

Scans selected in the Align panel appear in the 3D View window. Keys 1, 2 and 3 switch
among scans in the 3D View window:

1 shows aligned scans and groups

2 shows scans that are currently under alignment

3 shows all scans

Navigation in align mode is similar to navigation in the 3D View window:

Rotate hold LMB and move mouse

Zoom in/out Scroll the Mouse wheel, or hold RMB and move mouse

Move freely hold LMB and RMB simultaneously, or hold the middle button, and move
mouse
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9.6.3 Summary of Alignment Modes

The table below provides basic information on the various alignment modes (see Scan
Alignment).

• Scan type lists which scans you can use in a particular mode.

• Scans per operation is the number of scans required to use a particular mode.

• Markers in set prescribes how many markers (points) you can map in one point set.
Some modes require point (marker) sets, but some don’t.

• “—” means that markers are unnecessary.

• “0 or 2” means point speciˉcation is optional and, if you do specify them, only marker
pairs are allowed.

• “At least 1” means you can specify an unlimited number of markers in one set.

Table 11: Parameters for alignment modes.
Mode Scan Types Scans per

Operation
Mark-
ers in
Set

Notes

Rigid
(mark-
ers)

Any 2 2 Considers only coordinates,
not geometry

Rigid
(meshes)

Any 2 0 or 2 Considers geometric features

Rigid
(tex-
ture)

Multiframe with
poor geometry

2 0 or 2 High resource consumption

Rigid
(auto)

Any Any number — Works if surface is well tex-
tured

“Drag” Any 2 — Interactive
Non-
rigid

Models Any number 0 or 2 Deforms surfaces and tex-
tures; pre-alignment required

Com-
plex

Any 1 (at least 2
for models)

At least
1

Precise and ˊexible

9.6.4 Drag Alignment

Drag alignment is always available, regardless of which tab is active in the Align panel.
This mode allows you to align scans by manually dragging them in the 3D View window.

Owing to the low accuracy of this approach, however, you can optionally use it for pre-
liminary alignment before running more-accurate modes.

1. Select the scan you want to align, keeping in mind the recommendation in Selecting
Scans for Alignment. Artec Studio allows you to select multiple scans, but note that
it will align them with the registered scans as a single unit.
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Figure 64: Dragging a scan

Figure 65: “Drag” alignment result
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2. Holding down the Shift key and one mouse button, move and rotate the scan
you’re aligning (a green one ) close to the registered scan (a blue one ). Here is
a list of allowed movements and corresponding buttons:

• Shift+LMB to rotate

• Shift+LMB+RMB to move

• Shift+RMB or Shift+Scroll to move only unregistered scan along the
view direction

3. To conˉrm the alignment, release the mouse button(s) and the Shift key, then click
Apply. Note carefully that any scans you are registering won’t automatically move
to the registered set (see Figure 65). You can do so manually as the Changing Scan
Status describes.

4. If you have several scans to align, repeat these steps for each one individually.

9.6.5 Auto-Alignment

Rigid alignment is a universal mode suitable for aligning most scans. Auto-alignment is
the easiest approach, however. The advantages of this latter mode include the ability to
align several scans at once and avoid the need to specify points; the only disadvantage is
minimum requirements for the size of the overlapping areas in the scans you’re aligning.

To perform auto-alignment, follow these steps:

1. Make sure the Rigid tab is selected in the Align panel (see Figure 66). The tool will
automatically select all scans. Clear unnecessary selections by using the Ctrl key
(see Scan Alignment).

2. Click Auto-alignment. Ideally, Artec Studio aligns all the scans and marks them using
the icon. It may, however, mark scans as registered even though the 3D surfaces
failed to join properly.

Important: Auto-alignment may be unsuccessful if the scans have small overlapping
area.

Auto-alignment may produce the following results:

• Aligned scans, marked with the icon (basic group of registered scans)

• Unregistered scans, marked with the icon

• One group ( ) or several groups ( , ) of registered scans. Scans forming this group
failed to align with the basic registered group ( ), although they succeeded in align-
ing with each other.

We recommend resolving issues with unregistered scans or registered groups by align-
ing them manually as Manual Rigid Alignment Using Point Speciˉcation describes. Other
methods may also help.
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9.6.5.1 Managing Groups and Scans

You can perform the following actions on the scans from the list in the Align panel (right-
click on the item to open the context menu):

Mark as registered Only available for single unregistered scans ( → )

Mark as unregistered Use this command to discard the alignment state of a particular scan
(unavailable for scans)

Select group Highlights the respective group ( , , and so on)

Mark group as registered Converts all scans from the group into the basic registered group
( → )

9.6.6 Manual Rigid Alignment Without Specifying Points

You can perform rigid alignment either with or without specifying points. If the scans
are close to each other in distance (e.g., after “drag” alignment), or if they have a large
overlapping area or rich texture, you can skip the task of point speciˉcation when aligning
them.

Perform the following steps:

1. Make sure the Rigid tab is selected (see Figure 66).

2. Select the scan you want to align, as the beginning of Scan Alignment describes.

3. Click Align. The result should be as Figure 68 depicts. If you are dissatisˉed with
this result, click and follow the recommendations inManual Rigid Alignment Using
Point Speciˉcation.

4. Select another scan from the list of unregistered scans and repeat the above proce-
dure.

5. Click Apply to conˉrm your alignment results or Cancel to reject them.

9.6.6.1 Texture Alignment

If the object was scanned with texture, the texture-alignment feature may ease the align-
ment process. It uses texture-image characteristics of scanned objects and greatly de-
creases the possibility of incorrect alignment. This feature also helps to align objects
with few or no geometrical features, such as round or ˊat objects with no corners. If an
object has rich, nonrepetitive geometry, however, we recommend disabling texture align-
ment to reduce the algorithm’s running time. Also keep in mind that texture alignment
will be useless if the object texture is monochrome.

To enable texture alignment, select the Enable texture alignment checkbox at the bottom
of the Align panel just before you perform Step 3 of the procedure above.
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Note: Texture alignment is a resource-intensive algorithm that slows down the alignment
process. We recommend using it only in cases where the object’s geometrical features are
insufˉcient.

9.6.7 Specifying Points and Editing Their Positions

Before considering how to align scans using points, it is helpful to highlight point-pair
speciˉcation. The alignment algorithm uses pairs of point, or point sets in “Complex
alignment” mode (Complex Alignment), to detect scan areas that should be brought close
together.

To do point alignment, create several point pairs. To create one pair, mark one point
on the aligned scan and then mark another one on the unaligned scan. Ensure that in
each case the points for a given pair match a corresponding point on the surface of a
real object; note, however, that high matching accuracy is unnecessary, since Artec Studio
only uses the pairs to gain a rough approximation before performing precise registration.
In the Complex mode, you can create a set of points (instead of just a pair), i.e. you can
simultaneously specify more than two points in one or several unregistered scans and
only one in the registered scan. All these points are connected by polylines and form a
set.

When specifying points in the Rigid and Nonrigid modes, the application automatically
creates pairs. Having speciˉed one pair, you can immediately create the next one. In
Complex mode you must conˉrm set creation by hitting Space or by clicking New set
from the left panel, because the set may comprise multiple points (see Figure 67 and
Figure 73).

You can toggle between the point pairs (sets) by hitting Space and Backspace, or by
clicking RMB in the 3D View window and selecting the relevant options from the menu.
You can also relocate points in the pair (set). Hover the mouse cursor over the point until
the pair (set) is highlighted in white, then drag the point to the proper position using
LMB, or select the pair (set) and specify a new position using LMB. To conˉrm your actions
and deselect the pair (set), hit Space. You can also remove either a pair (set) or one of
its individual points: click on the point using RMB and choose the appropriate command
from the menu. Alternatively, you can use Del to remove the selected pair (set).

9.6.8 Manual Rigid Alignment Using Point Specification

We advise using this mode when scans are located at a signiˉcant distance from each
other.

To use this approach, follow these steps:

1. Make sure the Rigid tab is selected (see Figure 66).

2. Select the scan you want to align, as the beginning of Scan Alignment describes.
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Figure 66: Align panel: Rigid tab.

Figure 67: Creation of point pair.
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Figure 68: Alignment result.

3. Specify several point pairs (Figure 67), keeping in mind the recommendations from
Specifying Points and Editing Their Positions.

4. Click Align markers. This mode takes into account only the coordinates of speciˉed
points and tries to reduce the distance between the markers for each pair.

5. Carry out Steps 3–5 of the procedure in Manual Rigid Alignment Without Specifying
Points.

9.6.9 Nonrigid Alignment

Whereas rigid alignment can only perform such transformations as translation and rota-
tion, the nonrigid algorithm can deform 3D data. This algorithm is intended to process
so-called nonrigid objects: objects whose shapes have changed during the scan (e.g.,
models of animals or humans—see Figure 70, left). Keep in mind that the surface Artec
Studio produces as a result of the deformation may differ from the surface of the actual
object.

Note: Nonrigid alignment works on models only. Thus, before you run it, prepare models
by fusing the source scans. It is also necessary to ˉrst align models in rigid mode (see
Manual Rigid Alignment Without Specifying Points, Auto-Alignment or Manual Rigid Align-
ment Using Point Speciˉcation).

To run the nonrigid alignment, follow these steps:

1. Make sure the Nonrigid tab is selected (see Figure 69).

2. Select the models you want to align, as the beginning of Scan Alignment describes.

3. If themodels differ signiˉcantly from each other, we suggest that you specify several
point pairs, keeping in mind the recommendations in Specifying Points and Editing
Their Positions.
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Figure 69: Align panel: Nonrigid tab.

Figure 70: Two models after rigid (left) and nonrigid alignment (right).
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4. Where necessary, adjust the deformation degree using the ˊexibility slider. The
greater the ˊexibility value (i.e., the more “ˊexible” the deformation), the longer
the computation will take.

Warning: Avoid extreme Flexibility values. Applying very large values
may result in major surface distortions and may slow down the algo-
rithm. Extremely low values, on the other hand, barely deform surface
and often fail to produce the expected nonrigid-alignment results.

5. Click Align…. The algorithm will align models by deforming one of the model (see
Figure 70, right). If you are dissatisˉed with the alignment results, click and
specify additional point pairs, or reposition the current pairs.

6. Select another model from the unregistered set and repeat the steps above.

7. Click Apply to conˉrm your alignment results or Cancel to reject them.

Figure 71: Flexibility slider in action: original model (left), nonrigidly aligned model with
low Flexibility value (middle) and with high value (right).

Note: This version of Artec Studio does not support texture mapping on nonrigidly
aligned models.

9.6.10 Complex Alignment

Complex alignment allows you to align not only scan to scan, but surface to surface within
a given scan (see the mode comparison in Summary of Alignment Modes). Relative to other
modes, this one supports multipoint-set deˉnition—that is, you can link more than two
points. It’s useful for aligning scans obtained during circular movements of the 3D scanner
in cases where ˉne or global registration fails to align them. To run the Complex alignment,
perform the following steps:

1. Make sure the Complex tab is selected (see Figure 72).

2. Select the scans you want to align, as the beginning of Scan Alignment describes.
This mode allows you to work even with just one registered ( ) scan.
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Figure 72: Align panel: Complex tab.

Figure 73: Before alignment: two point-set added.
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Figure 74: Alignment result.

3. Specify one or more point sets on the scan surface (see Figure 73), keeping in mind
the recommendations in Specifying Points and Editing Their Positions.

4. Click Align… to run the alignment with your speciˉed constraints (Figure 74 shows
example results). If you are dissatisˉed with the alignment results, click and
specify additional point sets, or reposition the current sets. To redo an operation

that you have undone, click .

5. Click Apply to conˉrm your alignment results or Cancel to reject them.

9.7 Global Registration

Once you have aligned all your scans, proceed to the next stage: global registration. The
global-registration algorithm converts all one-frame surfaces to a single coordinate sys-
tem using information on the mutual position of each surface pair. To do so, it selects a
set of special geometry points on each frame, followed by a search for pair matches be-
tween points on different frames. To perform correctly, the algorithm requires an initial
approximation, which a user ensures in the course of the Align operation.

Note: Global registration is a resource-intensive operation. Processing of large data sets
may take a long time and require a large amount of RAM.

To launch the algorithm,

1. Select all aligned scans in the Workspace panel.
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2. Open the Tools panel.

3. Locate the Global registration section.

4. Check the Preset ˉeld. It must display the actual scanner that was used to obtain
the selected scans.

5. Click Apply.

9.7.1 Global-Registration Parameters

registration_algorithm Geometry_and_Texture
or Geometry

The type of algorithm that will perform scan
registration. If an object has rich texture and
poor geometry, consider using the Geome-
try_and_Texture option. For objects with rich
geometry, you can choose Geometry mode to
increase the registration speed.

key_frame_ratio 0–0.6

Determines how many surfaces are treated
as key frames. Decreasing this parameter
when processing a feature-rich object may
speed up registration. Increase it if only the
previous attempts to register scans failed.
Technically, values higher than 0.7, includ-
ing 1, are possible, but they may signiˉcantly
slow down the algorithm.

feature_search_radius

3–5 mm (Spider); 5
mm (Eva/Leo) and
50 mm in Geome-
try_and_Texture mode

Controls how sparse the features are lo-
cated. Objects with many repetitive features
may require decreasing this setting, whereas
large values will ensure algorithm robust-
ness on the big objects. Increase this param-
eter sparingly since large values may cause
erroneous registration and hinder calcula-
tion. Adjust it if Fine Registration completes
with inappropriate values ofmaximum errors.

9.7.2 Global Registration for Point-Cloud Scans

Global registration with the Artec Ray preset only runs on several point-cloud scans. Artec
Studio offers three modes:

• Targets considers only targets (spheres and checkerboard targets)

• Geometry_Ray. The prerequisite step for this mode is alignment. The scans must be
have sufˉcient initial approximations and may not have targets.

• Targets_Geometry. Global registration ˉrst runs on the basis of targets, then on ge-
ometric features.
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• Geometry_alignment is suitable for point-cloud scans captured without targets. It
doesn’t require an alignment, but you need to run Geometry_Ray afterwards.

– effective_distance_from_scanner is a radius around the scanner viewpoint from
where the algorithm will take points. Alter it when you need to ignore the
background 3D noise.

– voxelSide is a volume measure to cull the extra points from the algorithm in-
put. The more the value, the more the points will be culled and the faster the
algorithm. Increase it sparingly since it affect the algorithm accuracy.

– minDistBetweenDescriptors is a factor to adjust the point culling. Decreasing it
will result in increasing the algorithm robustness and duration.

9.7.3 Possible Global-Registration Errors

• After the global-registration algorithm ˉnishes, the frames are in disarray (see Fig-
ure 75, left) or the frame positions are unchanged. This error occurs because the
application is conˉgured for a different scanner type than the one that captured the
data. Change the device type in the application settings (see Algorithm Settings).

• The algorithm has completed successfully, but a gap exists between two or more
scans (see Figure 75, right). Select just these scans in the Workspace panel and run
the global-registration algorithm. If the scans have drawn closer to each other but
have failed to align after the algorithm ˉnishes, increase the number of iterations
and rerun the algorithm. Repeat this process until you achieve full alignment, then
run global registration once again for all data. If you are unable to align several
problematic scans, try aligning just two of them, then gradually increase the number
of scans until all of them are aligned.

Figure 75: Global-registration errors: wrong settings on left and gap between scans on
right.
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9.8 Ray Scan Triangulation

Application offers twoways to convert point-cloud surfaces to the commonly usedmodels:

• Fusion operation

• Special triangulation algorithm

The latter approach is preferable to fusion in terms of speed. It generates a polygonal
mesh from the original point cloud by simplifying its structure.

To launch this algorithm, follow the steps:

1. Mark a scan from Artec Ray using ˊag in the Workspace panel.

2. Access Tools from the left toolbar.

3. If necessary, specify the decimationStep and set either of the threshold ˉlters.

4. Click Apply.
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method Simple, Adaptive

Adaptive takes into account the distance
from the scanner, whereas Simple re-
moves points with the ˉxed step (deci-
mationStep)

decimationStep 1–10

The larger the value, themore the points
will be culled. 1 leaves the point cloud
unchanged. 2 culls half of the points, 4
keeps some 25% of the total amount of
points, 10 about 10%.

useWholeCloudTriangulation On/Off Enable it to stitch sections of the point-
cloud scans

colorMode SourceColor, Sec-
tionColor, None

It can color an output model on the basis
of vertex colors (SourceColor) or sections
constituting the point-cloud scan. The
latter yields multicolor model.

edgeLength
Adaptive method tries to maintain this
edge length for triangles within the en-
tire model.

maxEdgeLength Above 0.1 mm1
Algorithm will remove triangles whose
edge lengths are greater than the spec-
iˉed value.

minTriangleAngle 1–601

Triangles with angles smaller than spec-
iˉed limit (in degrees) won’t be created
in the resulting mesh. Extremely large
values that are out of the recommended
range may yield no mesh.

maxIncidenceAngle 0.1–901

If the angle between the normal to tri-
angle and the scanner view direction is
larger than the speciˉed one, this trian-
gle is subject to removal.

maxTriangleAngularSize 0.1–901

The algorithm will remove triangles
whose edge lengths form angles (toward
the scanner viewpoint) greater than the
speciˉed limit (in degrees).

9.9 Creating Models (Fusion)

Fusion is a process that creates a polygonal 3D model. It effectively melts and solidiˉes
the captured and processed frames. Fusion is the most interesting part of the processing
task because a polygonal 3D model is what most people expect to see when performing
a 3D scan. To this end, you can use one of the following algorithms, each of which has a
self-explanatory name (see also the summary in Table 12):

• Fast fusion produces quick results.

• Smooth fusion is good for scanning the human body because of its ability to com-
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pensate for slight movements by the person you’re scanning.

• Sharp fusion perfectly reconstructs ˉne features and is suited to both industrial ob-
jects and human bodies. It is the onlymode that allows you to use all the capabilities
of a Artec Spider scanner.

Figure 76: Models of a human subject obtained using various algorithms: Fast fusion (left),
Smooth fusion (middle) and Sharp fusion (right).

Figure 77: Models of a shoe sole obtained using various algorithms: Fast fusion (left),
Smooth fusion (middle) and Sharp fusion (right).
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Table 12: Comparison of fusion modes.
Fast Fusion Smooth Fusion Sharp Fusion

Usage
Fast results for large
data sets; also for
measurements

Large, noisy data sets
with patchymissing re-
gions; scans of moving
objects

Scans from Artec Spi-
der; scans having re-
gions with ˉne details
and sharp edges

EVA resolution no less than 0.5
Spider resolution no less than 0.15
L resolution no less than 1.5
Fill_holes Not applicable Available

Features Resulting surfaces are
relatively noisy.

Smoother results. Can
compensate for slight
movements, but not
recommended for ac-
curate measurements.
Relatively slow.

Higher level of detail.
Faster than Smooth fu-
sion, but may intensify
existing noise.

To obtain a model:

• Make sure the scans you intend to fuse have passed Global registration.

• Select the scans in the Workspace panel using .

• Enter the Tools panel.

• Select the necessary mode; optionally, specify parameter values.

• Click Apply.

• View the model in the 3D View window and in the Workspace panel once the algo-
rithm ˉnishes. The model name will match the algorithm name.

The fusion algorithms use the following parameters:

resolution —the step of the grid (in millimeters) that the algorithm uses to reconstruct a
polygonal model. In other words, this parameter deˉnes themean distance between
two points in a model. The lower the resolution value, the sharper the shape. When
specifying values, keep in mind the default values, lower limits in Table 12 and Max
error.

Fill_holes —instructs the algorithm to ˉll holes in the mesh being reconstructed; option
unavailable for Fast fusion. The methods for ˉlling the holes are as follows:

By_radius —ˉlls all holes with radius less than or equal to the speciˉed
value in the max_hole_radius text box (in millimeters)

Watertight —automatically ˉlls all holes in the mesh

Manually —prompts you to ˉll holes manually in the Fix holes panel,
which opens automatically

remove_targets —allows you to erase small embossments from surfaces on which targets
are placed (see Target-Assisted Scanning). Parameter can assume either the On or Off
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value; unavailable for Fast fusion.

9.9.1 Fusion-Algorithm Errors

Occasionally, defects appear in the 3D model after fusion; some are correctable by creat-
ing additional scans, whereas others are correctable by using the model-processing tools
described in the next section.

Figure 78: Surface noise caused by insufˉcient data (left) and improvedmodel after adding
one more scan (right).

Errors that can be corrected by capturing additional scans include low-amplitude noise on
the surface (see Figure 78, left). Normally, this error indicates that the affected area has a
small number of frames. The number of frames needed to eliminate the noise depends on
the reˊective properties of the object’s surface. To correct the error, you need one more
scan to cover the noisy area (see Figure 78, right).

Sometimes the cause of noise is an insufˉcient number of scanning angles. Areas captured
at a larger angle have more noise than areas captured at a direct angle (i.e., 90 degrees).
You can correct this error by scanning the area again using a better angle.

When the scanning conditions or the object features are such that you are unable to cap-
ture additional data, you can correct errors using the Fix holes (see Hole Filling) or Smooth-
ing (Smoothing (Tools)) tools. If such errors are frequent, reduce the speed at which you
move the scanner around the object, or increase the capture rate (see Decreasing Scanning
Speed).

9.10 Editing Models

The resulting fusion model may contain surface defects due to scanning or registration
errors. Artec Studio provides a number of tools to correct such errors:

Repair —corrects the model’s triangulation errors
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Small-object ˉlter —removes small objects located near the model surface

Fix holes —semiautomatically ˉlls holes and smooths the model edges

Hole ˉlling —ˉlls holes in the model automatically

Smoothing —ˉlters low-amplitude noise over the whole model

Smoothing brush —enables manual smoothing of the surface areas with the most noise

Mesh simpliˉcation —reduces the number of polygons in a model while minimizing lost
accuracy

Isotropic remesh —creates isotropic mesh while keeping the processed mesh as close to
the original as possible

Each algorithm processes all scans selected in theWorkspace panel and replaces the orig-
inal data with the results. If the algorithm is unsuccessful, you can restore the original
data by clicking (Undo) in the Workspace panel.

9.10.1 Small-Object Filter

If you forgot to erase outliers before fusion (see Eliminating 3D-Noise (Outlier Removal)),
Artec Studio may solidify and preserve them in the scene as small, distant fragments.

You can effectively remove these remaining outliers by using a ˉltering algorithm.

To remove these artifacts, select in the Workspace panel only the model you are currently
editing, then open the Tools panel. Click Apply next to Small-object ˉlter to run the algo-
rithm (see Figure 79). A window containing algorithm settings will appear when you click
. You can adjust the following parameters:

mode —the Leave_biggest_objects option from the dropdownmenu instructs the algorithm
to erase all objects except the onewith themost polygons; Filter_by_threshold erases
from the scene all objects whose number of polygons is less than the amount spec-
iˉed in the threshold parameter.

threshold —the maximum number of polygons for Filter_by_threshold.

9.10.2 Defeature Brush (Editor)

Erasing certain geometrical imperfections often demands further processing of the result-
ing holes in the model. The Defeature brush combines functions of the Eraser and Hole
ˉlling tools and may boost your productivity. To use it, follow these steps:

Warning: If you edit a textured model, note the following. Since the texture will
incorrectly ˉt the altered surface, the Defeature brush will remove it from the model.
So you will need to repeat texturing after you ˉnish editing.

1. Select one model in the Workspace panel.
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Figure 79: Filtering of small objects: before (left) and after (right).

Figure 80: Defeature brush: imperfection on the scanned surface (left), results of applying
the tool (right).
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2. Open the Editor panel using the side toolbar and click either Defeature brush or hit
D.

3. In the Editor panel, choose the required selection type.

4. Consult the instructions for each mode and select regions on the model that you
want to modify. To clear all selections, click Deselect.

5. Click Apply. The software will delete the feature, close up the hole and smooth the
surface.

To undo changes, click in the Workspace panel or menu Edit, or hit Ctrl + Z. Each
click of the Apply button generates a command history entry. To undo several operations,
use the dropdown menu of button and select the lowest entry.

9.10.2.1 Selection Types

2D Hold down Ctrl and use Scroll wheel to adjust the
tool size. Paint with Ctrl+LMB to create a selection.

3D See above.

Rectangular Use Ctrl+LMB to select a rectangular region.

Lasso Use Ctrl+LMB to freely outline an irregular region.

Cutoff-plane Create selection as in 2D mode. Once you have released
the mouse button, a plane will appear. If necessary, ad-
just the plane level by using Scroll wheelwhile hold-
ing down Ctrl+Shift or orient the plane freely in 3D
space. To this end, hit Alt to display the designated con-
trol. Then still holding the key, drag the required control
ring.

If you need to deselect any region, hold Ctrl + Alt and reselect this region. To clear
all selections, click Deselect.

If the Select through checkbox is selected, all surfaces throughout the model are affected.
If not, the brush only works on the visible surface.
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See also:

Hot keys in Editor.

Figure 81: Applying Cutoff-plane selection in Defeature brush.

9.10.3 Smoothing

9.10.3.1 Smoothing (Tools)

The smoothing algorithm evens out noisy areas in the 3D model. Artec Studio provides
two such tools: automatic smoothing of the entire model and manual smoothing of spe-
ciˉc areas identiˉed using a brush (see Smoothing Brush (Editor)).

To run the automatic smoothing algorithm, open the Tools panel and select Smoothing.
You need only set one parameter:

steps —the number of algorithm iterations to be performed

9.10.3.2 Smoothing Brush (Editor)

The Smoothing brush is a tool that you can employ selectively in speciˉc areas without
touching areas that require no alteration (for more information about automatic smooth-
ing, consult Smoothing (Tools)).

To use the Smoothing brush,

1. Select just one model.

2. Open the Editor panel, and click the icon or hit S.

3. Hit Ctrl, an orange region will appear around the cursor in the 3D View window.

4. Change brush size if necessary:

• Use either the Ctrl + [ and Ctrl + ] shortcuts or

• Use Scroll wheel.

• Enter a size (in millimeters) in the Brush size ˉeld.
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• Alternatively, you can adjust the slider bar in the Smoothing brush panel.

5. Set the smoothing strength if necessary:

• Enter the desired value in the Smoothing strength ˉeld or

• Adjust the slider bar.

6. Hold LMB and paint the surface region in order to smooth it. The tool will smooth
the affected areas (see Figure 82, right).

To undo changes, click in the Workspace panel or hit Ctrl + Z as many times as
needed to return to the original state of the model since each brush stroke generates a
command history entry.

Figure 82: Before smoothing (left) and smoothing out a poorly captured area (right).

9.10.3.3 Smoothing Edges

The Edges tab allows you to smooth ragged edges of the model.

To smooth an edge or any part of it, follow the steps:

1. Open Fix holes→ Edges. It will show the list of edges detected on the surface. These
defects are sorted by their full length.

• Mark the checkbox next to the edge in the list to select a whole edge2.

• In 3D View window, hold down LMB and drag the square control to specify a
part of the edge.

• Use the Select all button to select all edges.

2. Artec Studio will highlight these edges in red and draw yellow curves alongside
them depicting smoothed boundaries.

3. Use the Strength slider to control the edge-smoothing intensity as necessary.

4. Click Smooth edges.

5. Click Apply to conˉrm the results. If the results aren’t satisfactory, use the button
to cancel recent changes.

2 If the Move camera to selection option is checked, the model will automatically rotate to display the
selected hole.
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Figure 83: Boundary selection for edge smoothing

Figure 84: Edge-smoothing algorithm results.
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9.10.4 Hole Filling

Sometimes the shape of an object or the scanning conditions prevent you from properly
capturing of all parts of the scene. As a result, the fused 3D model will have holes. In
such instances, you can use either of the hole-ˉlling tools to interpolate the surface.

• Bridges or Smart Hole Filling

• Automatic Hole Filling

• Fixing Holes

9.10.4.1 Bridges or Smart Hole Filling

The Bridges tab is intended to connect a pair of the edge fragments by constructing a
surface that follows the curvature of the neighboring surfaces.

To create a bridge, follow the procedure:

1. Open Fix holes → Bridges. All holes will outline in red.

2. Specify two fragments3 between which a bridge will go (Figure 86). To this end,
perform the steps below twice (for each fragment).

1. Press Ctrl+LMB to start drawing a fragment.

2. Hold Ctrl+LMB and drag the cursor to specify the fragment.

3. Release Ctrl+LMB to conˉrm your fragment.

3. Once you’ve conˉrmed the second fragment, a bridge preview will appear. Change
its position as necessary.

4. Adjust bridge curvature on both sides and Bridge smoothness as necessary.

5. Click Build bridge to conˉrm your bridge.

The table below lists the possible actions matched with the options and commands for
this tool.

Prepare edges by removing raggedness Select the Smooth edges ˉrst checkbox
Preserve the original geometry (Figure
86)

Clear the Smooth edges ˉrst checkbox

Smooth bridge surface Use the Bridge smoothness slider
Edit bridge-preview position Drag the square controls while holding

Ctrl
Adjust bridge tension Use interactive sliders Curvature (start, end)
Delete bridge preview Hit Delete key

3 Normally a bridge goes between two fragments of one hole. In complex cases, you may use fragments
on different holes or edges.
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Figure 85: From left to right: original surfaces, bridge preview, actual bridge.

Figure 86: Specifying fragments. Correct fragments can resolve original geometry.
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Smoothing or Keeping Edges

Smoothing edges might not always be beneˉcial to you. If the bridge failed to recreate
the original geometry, try one or several actions from the following list:

• Clear the Smooth edges ˉrst checkbox.

• Use small or medium values of the Bridge smoothness slider (Figure 87).

• Select fragments correctly.

Figure 87: Small smoothness values on left and maximum on right.

9.10.4.2 Automatic Hole Filling

To quickly and automatically ˉll holes, use the Hole ˉlling algorithm in the Tools panel.
The algorithm only processes holes with perimeters below the threshold speciˉed in
max_hole_len (maximum length of the hole perimeter in millimeters).

Use button to access this parameter.

Figure 88: Hole-ˉlling algorithm: original model on left, processed on right.
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9.10.4.3 Fixing Holes

Unlike Bridges, the Holes tab provides ˊat hole ˉlling.

1. Open Fix holes from the side panel.

2. Select the Holes tab. It will show the list of holes detected on the surface. These
defects are sorted by their perimeter length.

3. Select a hole either in 3D View window or mark the checkbox next to it in the list.
Artec Studio will highlight these holes in red (see Figure 89).

Note: If the Move camera to selection option is checked, the model will
automatically rotate to display the selected hole.

Hint: Use the Select all and Deselect all buttons in the panel to select or
clear all selections, respectively.

4. Click Fill holes to repair your model.

5. Click Apply to conˉrm the results. If the results aren’t satisfactory, use the button
to cancel recent changes.

Figure 89: Two holes marked for correction.

If you try to exit the Fix holes mode without accepting changes, the software will ask you
for conˉrmation.
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Figure 90: Result from running the Fill holes algorithm.

9.10.5 Mesh Simplification

The mesh produced after fusion may be less than optimal for some applications because
it will contain a large number of polygons. This complexity will increase the amount of
memory the model occupies, hindering further processing. To optimize the model size
while retaining accuracy, use the Mesh simpliˉcation algorithm.

Figure 91: Mesh simpliˉcation: original mesh on the left, optimized mesh on the right.

Select the model and open the Tools panel. You can choose from two algorithms.
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9.10.5.1 Conventional Algorithm

Open the dropdown algorithm settings by clicking the button next to Mesh simpliˉca-
tion. Select the appropriate processing method (determined by the stop_condition):

Accuracy —optimize model to a predetermined accuracy: the error parameter deˉnes the
optimized model’s maximum allowable deviation (in millimeters) from the original
model. When the algorithm reaches this value, the optimization stops.

Remesh —perform simple mesh optimization, removing triangles whose edge lengths are
less than the remesh_edge_thr value (in millimeters).

Triangle_quantity —simplify the model by targeting the number of triangles speciˉed in
the tri_num parameter. The algorithm minimizes the resulting model’s deviation
from the original model, but the ˉnal deviation value will remain unknown until
processing concludes. Use this method when you know how many triangles the
resulting model should have.

Tip: To determine the number of triangles, double-click the appropriate
model from the list in the Workspace panel (see Figure 43).

UV_Triangle_quantity —similar to the Triangle_quantity algorithm, but intended for
meshes with textures mapped by the Atlasmethod (see Applying Texture (Procedure)).
This approach not only simpliˉes the polygon grid, reducing the number of triangles,
but it preserves texture.

UV_Vertex_quantity —simplify a textured model by targeting the number of vertices spec-
iˉed in the vrt_num parameter.

Tip: Since the UV methods tend to slightly reduce texture resolution, we recommend
using either of them only when no raw scans are available. It is generally better to simplify
models using one of the regular method and then reapply texture.

The three ˉrst algorithms in the list above have additional parameters:

keep_boundary —maintain the model boundary. Mesh simpliˉcation on the scan edges
may affect their geometry. Thus, if the shape of the boundaries is more important
than the optimized mesh, select the On value. Otherwise, select Off, and the algo-
rithm will simplify the boundary mesh.

max_neighb_normals_angle —the angle between the normals of two neighboring faces.
You can specify an angle (default value is 120°) to prevent Artec Studio from creating
degenerate triangles. If the angle measure in some region exceeds the speciˉed
value, the algorithm will leave the mesh unchanged in that region. Note that the
default value is appropriate in most circumstances.

After adjusting the algorithm settings, click Apply to start processing.

Note: Mesh simpliˉcation may take a long time when the parameters of the original
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Figure 92: Boundary-appearance options: keep_boundary enabled (left) and disabled
(right).

and optimized models are signiˉcantly different (for example, if the deviation value is
high in Accuracy mode or if the required number of polygons in Triangle_quantity mode
is much smaller than the number in the original model). For very large 3D models the
operation requires extensive memory resources and may fail owing to insufˉcient RAM.
Free thememory by closing unused applications and by optimizingmemory usage in Artec
Studio, keeping in mind the recommendations inMemory, Command History and Selectively
Loading Project Data.

9.10.5.2 Fast Mesh Simplification

The Fast mesh simpliˉcation algorithm works faster than the conventional one. To run it,
perform these steps:

1. Open the dropdown algorithm settings by clicking the button next to Fast mesh
simpliˉcation.

2. Specify in the tri_num text box the desired number of triangles for the resulting
model. You can determine how many are in the actual model by double-clicking it
in the Workspace window.

3. Set the force_constraints option:

• If this option is set to Off, the value speciˉed in the tri_num text box remains
constant.

• If this option is set to On and the algorithm is unable to produce a surface
with the speciˉed number of triangles (tri_num), Artec Studio will automatically
update this value. In other words, improving the quality of the resulting surface
is the primary objective.

4. Click Apply to run the algorithm.

9.11 Texturing

Artec scanners are equipped with a color camera, allowing you to capture 3D surfaces
with texture and expanding the range of objects available for scanning. Texturing is a
process that projects textures from the individual frames onto the fused mesh.
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9.11.1 Preparing Model

To take advantage of texture, do the following:

1. Make sure the Don’t record texture checkbox is cleared.

2. Adjust the capture frequency for texture frames (see Texture-Recording Mode) if nec-
essary.

3. Avoid turning off the ˊash bulb.

4. Adjust the texture brightness in Preview mode by using the eponymous slider in the
Scan panel.

5. Scan the object using a tracking algorithm of your choice. Captured frames are
marked with the letter “T” in the Workspace panel (surface-view mode) (see Figure
42, right).

6. Process the data and create a model, consulting the list in the beginning of Data
Processing or Use Autopilot.

7. Run a mesh-simpliˉcation algorithm for the resulting model (see Mesh Simpliˉca-
tion) to accelerate the texturing process.

8. Use the Texture panel to apply the texture to the model.

9.11.2 Applying Texture (Procedure)

The 3D model obtained after fusion contains no texture information. To apply textures
onto a model, do the following:

1. Open the Texture panel

2. Choose amodel from the ˉrst list (see Figure 93); Artec Studio will apply the textures
to this model

3. Select from the second list the scans from which you created the model (these scans
have the required textures)

4. Next, choose a method for applying textures to the model. Artec Studio offers two
methods:

• Preview (triangle map)

• Export (texture atlas)

5. Select the required Output texture size4 and other options as necessary (Supplemen-
tary Settings)

6. Click Apply to start the texturing process5

4 Texturing with the 16K resolution (16384x16384) is only available if your graphics card features at
least 3 GB of GPU memory.

5 To optimize resource utilization, Artec Studio unloads all surfaces from memory, except those needed
for texturing, before running the applying procedure. For a more detailed description of selective project-
data loading, see Selectively Loading Project Data.
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7. Finally, when the texture is ready, adjust it as necessary.

To reduce or increase the resolution (Output texture size) of the already applied texture,
you can re-apply it several times faster by enabling the Export (reuse UV map) option.

Figure 93: Choosing a texture-application method and adjusting its parameters.

Warning: We recommend that you avoid applying texture to models that have under-
gone major changes in geometry or orientation. The algorithm will apply the texture
incorrectly if you have done any of the following:

• Position or transform the model relative to its source scans

• Nonrigid Alignment

• Erase major parts of the model

Perform these operations only after texturing.
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9.11.3 Modes

Table 13: Comparison of the texture-applying methods.

Mode Texture Distor-
tion Speed Number of

Textures
Texture-Resolution Man-
agement

For pre-
view

Does not preserve
aspect ratio of tri-
angles

Fast One or more Adjust triangle size and
texture-image resolution

For export Preserves aspect
ratio of triangles Slow Only one Adjust texture-image resolu-

tion

9.11.3.1 Texturing for Preview (Triangle Map)

The Preview method transfers all textured triangles to a square texture image (or a series
of images). You can adjust the Triangle size (in pixels)6 using the eponymous slider (see
Figure 94, right). To select the resulting texture size, use the dropdown list (maximum
texture size depends on the capabilities of your graphics card). After changing the trian-
gle/texture size, the estimated number of textures will appear in the Estimated area at the
bottom of the panel; the actual number may differ slightly, however.

9.11.3.2 Texturing for Export (Texture Atlas)

The Export method cuts the surface into pieces, then unfolds and nests these pieces ˊat
and ˉts them into the speciˉed image size (see Figure 94 (middle) and Figure 51 in Dis-
playing Boundaries of Texture Atlas). This method takes longer to run than Preview, but the
resulting texture is much more convenient for manual editing.

Figure 94: Texture mapping methods: mesh with texture applied (left), texture-atlas sam-
ple (middle) and triangle-map sample (right). The latter covers only a portion of the mesh
surface (the rest two images not shown).

6 Triangle size is determined by the number of pixels per side.
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9.11.4 Supplementary Settings

To modify a texture using an inpainting technique, use one of these two options:

9.11.4.1 Inpaint Missing Texture

This option allows you to apply a texture to regions with no texture information by spread-
ing it from the neighboring regions.

9.11.4.2 Remove Targets

Remove targets is similar to inpainting. It paints out targets by applying surrounding tex-
ture information (targets are used to facilitate scanning—see Target-Assisted Scanning).
This option makes sense if you enabled remove_targets before producing this fusion model
(see Creating Models (Fusion)).

9.11.4.3 Enable Texture Normalization

Enable texture normalization aims to compensate for uneven lighting caused by movement
of a scanner’s ˊash unit during capture. We don’t recommend clearing this checkbox.

9.11.4.4 Reduce Glare

Reduce glare is intended to eliminate glare spots on texture. This option is only available
for Texturing for Export (Texture Atlas) and requires many texture frames captured from
different perspectives.

1. Check whether the source scans include sufˉcient number of frames (especially
those marked with “T”). If necessary, increase texture-frame rate and rescan.

2. Select the Reduce glare checkbox.

3. Adjust the Reduction level slider as necessary. Avoid extreme values.

Hint: Glare reduction is a time consuming algorithm. If you plan to obtain a high-
resolution texture, we advise you to ˉrst tweak the settings on low values (for example,
512 x 512) and then reapply texture with the required Output texture size.

9.11.5 Texture Adjustment

After the texturing is complete, you can adjust the texture on the model (see Figure 96).

You can adjust the following texture parameters by way of the corresponding sliders (see
Figure 95 for details):
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Figure 95: Hue, saturation and brightness representation.

• Brightness

• Saturation

• Hue

• Contrast

• Gamma correction

Figure 96: Texture adjustments.

The initial position of the Hue slider corresponds to the current texture color. Dragging
it left or right corresponds to rotation counterclockwise or clockwise, respectively, on the
color wheel.

After making the necessary changes, click Apply to transfer the resulting textured model
to the Workspace panel.

To reopen the texture-adjustment dialog, follow the steps:
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1. Select a textured model in Workspace.

2. Use RMB to call the context menu.

3. Select the Adjust texture command from the list.

9.12 Texture-Healing Brush: Manual Inpainting

You can manually inpaint missing textures by using the Texture-healing brush. This tool
is based on the same algorithm as the Inpaint missing texture option covered in Applying
Texture (Procedure). The inpainting algorithm uses texture information from neighboring
regions to ˉll in areas with missing or incorrect texture. Left image in Figure 97 shows a
small texture imperfection: a felt-tip pen mark on the ˉgurine. Results of inpainting this
region appear in Figure 97 (right).

Figure 97: Texture-healing brush: before application (left) and after (right).

To launch the tool and inpaint a texture, do the following:

Hint: We advise you to ˉrst back up your model by selecting the Duplicate scans command
from its context menu since the undo function is unavailable in this tool.

1. Mark the model textured for Export with the ˊag.

Important: This version of Artec Studio does not support texture restora-
tion on the models ‘textured for Preview’ (triangle map) and in regions of
any models that have been corrected using the Defeature brush.

2. Open the Editor panel by clicking its icon in the side toolbar.

3. Select the Texture-healing brush.

4. Hold down Ctrl while using Scroll wheel or [ and ] keys to adjust the tool
size. It should not exceed the size of the region that needs texture correction.

5. Paint over the region of interest using LMB while holding down Ctrl so that the
tool (a circle or a spot) only rolls over the problem area. Try to avoid touching
neighboring areas. Use the Deselect button to clear all the selections.

6. Repeat the previous step as necessary.
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7. Click Apply to accept the changes or close the panel to reject them.

Note: If you paint an area in which the number of polygons exceeds the value speciˉed in
the settings dialog (see Warnings), a message will appear prompting you to either ignore
the value, which means that processing may take longer, or cancel the operation.

9.13 Preparing Models To Export

9.13.1 Moving, Rotating and Scaling (Transformation Tool)

The Transformation tool allows you to move, rotate, scale and mirror objects relative to the
global coordinate-system axes.

To access this tool, open the Editor panel and select Transformation tool or hit T. The panel
will open, displaying four tabs that correspond to different modes for altering the object
position in the global coordinate system. The name of the active mode appears at the
bottom of the 3D View window.

To revert your changes inside the tool, use the Reset button. Artec Studio applies changes
when you leave the tool. Use the (Undo) button in the Workspace panel or hit Ctrl+Z
to reset changes after you close the tool.

Hint: To quickly move objects to the origin and align them with the camera viewport,
use the Auto-position button.

9.13.1.1 Translate

To enter translation mode, click the Translate tab or hit T. Three input ˉelds will appear
in the Editor panel showing the current origin coordinates (in millimeters) of the local
coordinate system. The initial position of the local coordinate system will be in the center
of the global one. To translate an object, do either of the following:

• Enter the new coordinate values for the local system using the input ˉelds in the
Editor panel. To adjust the position only along a speciˉc axis, ˉrst hit the corre-
sponding X, Y or Z key.

• Translate the object in the 3D View window by dragging the corresponding control
(see Figure 98):

– Square in the center to move it freely

– Arrow to move it along a speciˉc axis

– Lines between arrows to move it along the two axes simultaneously
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Note: Orienting the object may be easier if you ˉrst specify a new position for the origin
of the local coordinate system: double-click on the desired surface point in the 3D View
window.

Figure 98: Translation control

9.13.1.2 Rotate

To enter rotation mode, click the Rotate tab or hit R. Three input ˉelds containing the
Euler-angle values will appear in the Editor panel. Initially, all values are set to zero. To
rotate the object, do either of the following:

• Enter the new angle values (in degrees) using the input ˉelds in the Editor panel.

• Drag one of the three circles (see Figure 99) to rotate the object. Hitting the key
that corresponds the required axis (X, Y or Z) will hide the controls for the other
axes.

Note: Orienting the object may be easier if you ˉrst specify a new position for the center
of the local coordinate system: double-click on the desired surface point in the 3D View
window.

Figure 99: Rotation control
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9.13.1.3 Scale

To enter scaling mode, click the Scale tab or hit S. A single input ˉeld with the current
scale value (1.000) will appear in the Editor panel. You have two options for scaling the
object:

• Enter the new scale value in the ˉeld.

• Drag the origin of the control (Figure 100) or either of its round ends in the 3D View
window.

Figure 100: Scaling control

9.13.2 Placing Objects on Coordinate Plane (Positioning Tool)

You may need to place the model on one of the coordinate planes (e.g., for aesthetic
reasons or when preparing the model for measurements, for capturing a screenshot, for
exporting and so on). Instead of adjusting the model position using the Rotate and Trans-
late modes of the Transformation tool, you can use the special Positioning tool. To do so,
follow these steps below.

Tip: The Enable automatic base removal option may come in useful to position scans au-
tomatically after the scanning completes (see Base Removal: Erasing a Supporting Surface.)

1. Open the Editor panel from the side toolbar and click either Positioning tool button
or hit P.

2. Ensure that the coordinate axis grid is shown. Otherwise hit G or select the Grid
command from 3D toolbar.

3. Choose the coordinate plane in which you want to place the model by activating
one of the following options: XOY, YOZ or ZOX. Note that you may skip this step and
return to it after Step 3.

4. Use LMB to specify at least three points on the surface; the plane will automatically
pass through their center of mass (see Figure 101). The following conditions will
then apply:

138 Chapter 9. Data Processing



Artec Studio, ver. 14

Figure 101: Positioning the model in the global coordinate system.
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1. For each additional point you specify, Artec Studio rebuilds the plane. Click
Clear points at any time to redeˉne the points.

Note: Three points determine a plane. When you’re dealing with
nonplanar surfaces, however, three points may be insufˉcient. In that
case, the more points you specify, the more precisely a plane will ˉt
the surface.

2. In addition to the plane passing through the center of mass of the points you
select, the coordinate origin will shift to that location as well.

3. The position of the coordinate origin is adjustable, as described below.

5. Invert the direction of the coordinate axis, if desired, by clicking the Invert Z button
for the XOY plane, Invert X for YOZ, or Invert Y for ZOX.

6. If appropriate, adjust the model’s position relative to the coordinate origin:

1. Shift + LMB—rotate the model around the axis that is currently normal to
the plane

2. Shift + RMB—move the model along the plane in a ˉxed direction

3. Shift + LMB + RMB—move freely along the plane

7. Hit Apply to ˉx the model on a speciˉed plane or close the panel to cancel position-
ing.

To discard changes of object position, click in the Workspace panel or hit Ctrl+Z.

9.14 Advanced Techniques

9.14.1 Automatic Processing

See also:

Use Autopilot

Automatic processing is a special mode for the Tools panel that saves time and simpliˉes
postprocessing. It allows you to run all postprocessing algorithms from the Tools panel
(Rough, Fine and Global registration; Fast, Smooth and Sharp fusion; Small-object ˉlter or
Outlier removal; Hole ˉlling; Mesh simpliˉcation; Remesh; and Smoothing) with a click of
just one button.

To switch from manual to automatic mode, open the Tools panel and choose the Auto
option from the dropdown list in the left corner. Click the button near Go! to view all
options available in automatic mode. Note that only Global registration, Fast fusion and
Small-object ˉlter are enabled by default. To perform other actions automatically, choose
the On option in the dropdown list next to the required function, or choose Off to exclude
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Figure 102: The extended Auto postprocessing menu.

a function from automatic processing. Click Go! or hit Ctrl + G to begin automatic
processing.

Each algorithm setting and parameter is based on the values for manual mode. To change
these values, switch to Manual mode, make the necessary alterations and then run auto-
matic processing—Artec Studio will apply all changes.

Keep in mind that the algorithms run in the order in which they are listed, starting with
Rough serial registration and ending with Remesh. Thus, if you want to run the Small-object
ˉlter before Fast fusion or Global registration, for instance, you must do so manually.

Unlike manual processing, automatic processing runs without the need for constant user
attention, so it is more convenient when processing large objects: you can conˉgure the
settings, start the process and leave it unattended. It can also process objects of any size,
reducing the number of mouse clicks to get the result.

9.14.2 Mirroring

Artec Studio allows to mirror the 3D data. The application uses the local rotation center
as a mirroring center (see Global Coordinate System and Rotation Center). If it isn’t speciˉed,
Artec Studio employs the global coordinate center.

To mirror the model, follow the steps:

1. Open Editor

2. Access Transformation tool

3. Select the Mirror tab

4. If necessary, double click the model to specify a rotation center

5. Select an axis to mirror the object along. Press the respective button—for example,
Along axis Y.
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Figure 103: Mirroring in action.

To revert your changes, use the Reset button. For details, consult Moving, Rotating and
Scaling (Transformation Tool).

9.14.3 Isotropic Remesh

Note: Don’t confuse it with the remesh parameter in Mesh simpliˉcation.

Isotropic remesh is an operation that modiˉes 3Dmodel in the way that newmesh triangles
have uniform size. Software packages where the models from Artec Studio are intended
to be used may impose these requirements.

The algorithm produces an isotropic mesh, but doesn’t necessarily decrease the polygon
count. However, the output ˉle is often smaller than the original one through the uniform
triangles.

To produce a uniform mesh,

1. Mark the model using the ˊag

2. Open the Tools panel

3. Locate the Isotropic remesh section

4. Click and specify resolution as necessary

5. Click Apply.
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Figure 104: Isotropic remesh operation in action: original model on left, processed one
on right.

9.14.4 Normal Inversion

Normal direction determines the visibility of a surface in 3D graphics. Learn how to show
normals of the objects in Artec Studio 3D View, see Representation of Normals and Bound-
aries.

Normal inversion allows one to turn the model inside out. This operation may be useful
when you need to manufacture some mating parts, like molds; or obtain a model based
on its cast (e.g., turn the footprint cast into a shoe last, see Figure 105).

Figure 105: Normal inversion application: obtaining a foot model (right) from its cast
(left).

To invert normals on a particular model,

1. Mark the model using the ˊag

2. Open the Tools panel
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3. Locate the Normal inversion section

4. Click Apply.

9.14.5 Correcting Triangulation Errors

Some algorithmsmay introduce triangulation errors into the resultingmodel. These errors
include the following:

Unattached vertices —points that are not vertices of any of the triangles

Vertices with identical coordinates —vertices that have the same coordinates

Faces containing invalid vertices —triangles that point to nonexistent vertices

Singular faces —triangles for which at least two of the three vertices coincide.

Faces with equal signature —faces with fully coinciding sets of vertices

Edges incident to three or more faces —edges that are adjacent to three or more faces

Faces with wrong orientation —faces whose normals point in a direction opposite to those
of the adjoining faces

To correct these errors, mark a model in the Workspace panel by using the ˊag and hit
Ctrl + R or select the Window → Repair menu command. If the algorithm detects no
triangulation errors, Artec Studio will notify you that it has found no defects. Otherwise,
the Repair panel will open, displaying the above-mentioned list of defects to be corrected.
Next to the names of the defects, a column will appear stating the number of defects of
a certain type found in the model. You can select all defects by pressing View all. Doing
so will display in the model all the defective vertices and triangles using colored points.
You can disable display of any particular defect type by removing the icon next to the
corresponding name, or disable them all by clicking View none. To correct the defects,
click Repair all. Clicking the Apply button accepts the changes.
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Additional Modes

This chapter describes other Artec Studio modes, such as

• Publishing to the Web

• Multicapturing

• Measurement Tools

10.1 Publishing to the Web

Having models on a web may simplify the process of collaboration among users. Artec
Studio allows you to publish your 3D models on the Web through viewshape.com. View-
shape is a service that uses WebGL to render 3D models in a web browser. You can see
published models at viewshape.com or embedded at other websites, blogs or social net-
works. Models can be shared privately so that only those who know the unique URL can
see, comment on and use them.

Most browsers currently support WebGL. If this feature is disabled or unsupported in a par-
ticular browser, viewshape.com displays the 3D geometry as a pre-rendered set of images
that you can rotate using a mouse. Such images are called spin images.

To publish a model, use the Publish panel. It will open only if you have exactly one fusion
selected in the Workspace window; otherwise, Artec Studio will display an error message.
To log into viewshape.com, use yourmy.artec3d account. If the process fails, you can access
the login window from the link at the top of the panel (see Figure 106).

After you successfully login, you will see the window shown in Figure 107. Follow the
steps below to continue uploading:
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Figure 106: Viewshape.com login window.

Figure 107: Publish panel.
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1. Adjust model’s position in the 3D View window to see how it will appear on the Web.

2. Preview rotation when necessary.

3. Select visibility options (Public or Private).

4. Choose whether to employ WebGL: use Show to display a full-featured 3D model
and rotate it freely, or use Don’t show (spin image only) to display images of the
model captured from different angles. You can rotate these images only around the
vertical axis.

5. Select a license type for your model.

6. Specify the collection in your gallery to which you want to publish the model, or
create a new one.

In addition to the above steps, you must also set theModel name and, optionally, theModel
description. Once you have completed this entire process, click Publish; your model will
appear on the site.

10.1.1 Model Requirements

WebGL is a progressive API, but it is not very powerful. If your model contains several mil-
lion polygons and several very high-resolution textures, you will have difˉculty rendering
it in a browser. Therefore, to produce a model that looks good, you must ˉrst optimize it.
We recommend the following model parameters:

• Fewer than 1000000 (300000 for Trial version) polygons

• Texture size of 4096×4096 (1024×1024 for Trial version) pixels

• Texture mapped using Atlas method (mandatory)

• Model positioned appropriately to rotate around Y axis

Using LMB in the 3D View, you can rotate the model around its center of mass. Because
translation is impossible here, you should rotate the model to the position in which you
want it to appear on the web.

If the model parameters fail to satisfy the requirements and recommendations listed
above, a yellow notiˉcation will appear at the bottom of the window, along with a button
that instructs Artec Studio to ˉx the issue.

10.1.2 Fixing Issues

If your model suffers from one or more issues (as Figure 107 shows), click the Fix issues
button. The software will open the new panel shown in Figure 108.

Artec Studio can currently identify two issues: very dense meshes and incorrect texture
mapping. If the mesh is too dense, you must ˉrst simplify the model. The simpliˉcation
tool is available in the Issues found dialog. If the texture is mapped using the Preview
method (triangle map), you can remap it by clicking Fix texture, as Figure 108 shows. The
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Figure 108: Fixing model issues.

Texture panel will then open, allowing you to ˉx it using the Export method (texture atlas)
and the recommended resolution.

Once you have resolved all the issues, click Back to Publish to return to the Publish panel
and resume the publication process.

10.2 Multicapturing

Artec Studio enables synchronized scanning with multiple scanners. This mode is helpful
when capturing a large object from several angles using more than one scanner simulta-
neously. Multicapturing with several scanners implies that the system knows their posi-
tion in advance. This condition simpliˉes and accelerates data processing considerably.
For this reason you must calibrate the relative positions of the scanners before capturing.
The resulting calibration data, which includes scanner IDs and their spatial orientations,
is referred to as a bundle.

Important: Using multiple Artec scanners requires your workstation to integrate as many
independent USB host controllers as connected scanning devices.

Use the following procedure to prepare the devices and the environment to simultane-
ously capture 3D reality:

1. Calibrate the relative position of each device (i.e., create a bundle)

2. Use the Multi panel to capture scans

To create a bundle, perform the following steps:

1. Capture the test object using all bundled scanners (see object requirements in Bun-
dle Creation)
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2. Manually align the resulting scans using the Align tool to compute the relative po-
sition of all scanners

3. Create the bundle using the Create bundle panel

Note: Once you have created the bundle, you can no longer move the scanners relative
to one another. If even one device has changed position, you must recreate the bundle!

10.2.1 Bundle Creation

Perform the following steps before creating a scanner bundle:

1. Select device positions. The scanners’ combined ˉeld of view should cover the re-
quired area.

2. Fix the scanners in the chosen positions. If you plan to use hardware synchroniza-
tion (see Hardware Synchronization for Eva), attach the scanners to the tripods by
securing them with thumbscrews while allowing the wires to hang freely.

3. Select and set up the calibration object. Any object with a geometry-rich surface
is a candidate. Avoid selecting objects with simple geometries for calibration (e.g.,
planes, spheres or cylinders). You may use several objects as a composition when
creating a bundle. We recommend object installation at the distance corresponding
to the middle of the operating range for the corresponding device type.

You can perform the scan using the Capture or Multi panel. The latter option is more
convenient, as it allows you to capture the video data stream simultaneously from several
scanners. For details regarding this mode, see Performing Multicapture.

If you install the scanners at small angles relative to each other (i.e., you can see the same
object area simultaneously through different scanners), you need not rotate the object. In
this case, you can take calibration scans either sequentially or concurrently.

Note: In case of sequential scanning, make sure the object is ˉxed safely and remains
motionless during the scan.

If you set up the scanners at a large angle and their ˉelds of view have no overlap, use
the Multi panel to start the capture sequence and then turn (move) the object to enable
all scanners to capture the same parts.

Note: It is important that all scanners capture a large portion of the object or scene (but
not necessarily the same portion) in each frame, because the position of all subsequent
frames—as well as the scanners themselves—will be determined by their predecessors.
Also, the relative positions of the scans will determine the intercalibration of the devices.

If the cameras are far from each other and the object was moving, then you should register
the scans using the Fine registration and Global registration algorithms. This requirement,
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Figure 109: Bundle-creation window.
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however, isn’t applicable for 3D sensors: running Global registration may spoil the scans
owing to low quality of the geometry obtained from the sensors.

4. Next, proceed to the Align panel and align the captured scans as Scan Alignment
describes. At that point, everything will be ready for bundle creation.

5. From the menu, select File → Create bundle. A warning message will appear if you
forget to align the scans. Otherwise, the bundle-creation panel will appear (see
Figure 109). The 3D View window will show the selected scans, the position and
viewing direction of the scanners (by means of an appropriately colored pyramid),
the device ID, and the scanner coordinates. It will display a list of connected devices
and corresponding information.

6. Add a device to the bundle or remove one by inverting the image in the leftmost
column of the list. The order of devices in a bundle refers to the scan order in the
Workspace panel.

7. A bundle name will appear in the ˉeld at the top of the bundle-creation panel. By
default it contains the serial number of the bundled scanner. Before creating the
bundle, you can easily change this name by typing in the corresponding ˉeld. Click
Apply at the bottom of the panel to create and install the bundle.

10.2.2 Performing Multicapture

Multi mode allows you to capture 3D-data streams simultaneously from several devices.
Selecting this mode activates the corresponding panel (see Figure 110) and lets you
choose the device conˉguration: either use one of the existing bundles or specify the
scanner list manually.

Note: In multicapture mode the system possesses information about the relative scanner
positions. Therefore, scans captured by bundled scanners differ frommanual scans in that
the matching frames from different scanners are already in the same coordinate system.

1. Select the Use bundle checkbox. A dropdown list of all installed bundles will appear
in the panel. Active bundles are highlighted in black, inactive bundles in gray. Artec
Studio considers the bundle active if all bundled devices are installed and connected
to the PC.

2. Select Synchronization type from the Options tab in the Multicapture panel.

• In Software mode, scanners are synchronized via USB, Windows and Artec Stu-
dio, and the slave-scanner actuation time always varies (~10 milliseconds) ow-
ing to the numerous links in the chain.

• InHardwaremode, scanners are synchronized via cables (seeHardware Synchro-
nization for Eva for details). Hardware synchronization provides high precision
and repeatability for slave-scanner actuation time (about 1 millisecond with a
precision of less than 10 microseconds, thanks to microelectronic processes).
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Figure 110: Multicapture panel: Options tab on left, Device tab on right.
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Note: We recommend hardware synchronization in most circumstances; when cap-
turing moving objects, it is mandatory.

3. Click Preview to start capture.

10.2.2.1 Tweaking Multicapture Options

You can store multicapture data either as separate scans (use the Separate scans radio but-
ton) or as a single scan in which every frame represents an aligned union of corresponding
frames from all bundled devices (use the Merge frames radio button).

If you need to capture frames with a certain delay between the scanners, enter the delay
value in the Delay between frames ˉeld. Unlike the Scan mode, the Multicapture mode
captures each frame independently without attempting to align each subsequent frame
with the previous one, so it makes sense.

Sometimes, limiting the cameras’ ˉeld of view is necessary (e.g., to cut off extraneous dis-
tant objects). Two sliders in the Depth of ˉeld area set the near and far scanning bound-
aries. The application sets work-area boundaries for each device independently in the
device tabs (see Figure 110, right). By default, the minimum and maximum boundary val-
ues for the corresponding device type are set to the recommended range; we encourage
you to avoid changing them. However, if you’re using Artec L scanners or 3D sensors, it
may become necessary. To change these values manually, mark the Override default depth
range checkbox in the Scan tab of the Settings dialog and enter the appropriate values in
the ˉelds below.

Note: For most scanner types, redeˉning the recommended depth range may reduce
accuracy.

Fast capture mode instructs Artec Studio to store raw scanned data in memory and pro-
cesses frames after completing the capture sequence. It allows to save processor time on
building and rendering surfaces. And if the number of processor cores is less then doubled
number of scanners in the bundle, it can also increase scanning speed.

To enable it,

1. Check the Fast capture mode box.

2. Enter the desired capture duration in seconds. The application will automatically
recalculate and display the required amount of memory.

Artec Studio saves multicapture parameters when you exit the application and reapplies
them the next time you start it.
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10.3 Measurement Tools

Artec Studio offers a number of measurement and commenting tools, including

• Linear measure

• Geodesic measure

• Sections (cross-sections)

• Surface-distance maps

• Annotations

The corresponding buttons reside in the upper part of theMeasures panel (see Figure 111).

1. Choose a measurement tool, the application displays a list of scans you can work
with

2. Select the checkbox of each desired scan. The scans will appear in the 3D View
window.

3. Click Next. The selected measurement-tool window will open.

The coverage below takes a closer look at the different measurement tools and their
features.

Figure 111: Measures panel.

Hint: If your Measurement panel lists the previously created items, you can open one of
them by double-clicking that item or clicking the Edit button.
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10.3.1 Linear Distance

The linear-measurement tool (see Figure 112) allows you to measure distances between
selected points and to measure the total length for a string of multiple points. Click the

button and select the scan to switch to the Linear window. You can enter a name for
the new measurement by typing it in the Name ˉeld in the upper part of the window. The
application creates new measurements with default names Linear 1, Linear 2 and
so on.

To measure distances between points,

• Use LMB to sequentially select the points on the model in the 3D View window. The
application will add these points to the current point list, which will also display
linear dimensions and point coordinates.

• When you roll the cursor over any one of these points in the 3D View window, the
point will be highlighted in red; you can then drag it to another location using LMB.
When you release the mouse button, the point will ˉx to its new location.

Warning: You can’t set a point outside the object’s surface; in this
situation, if you release the mouse button, the point will return to its
original position.

The total number of points and total length of the measurements appear in the Measures
panel.

Table 14: Basic operations in the linear and geodesic
measurement modes.

Purpose Control Name
Hide scans in the 3D View Hide source data checkbox
Display order numbers of points Show numbers checkbox
Display dimension results in the 3D View Show labels checkbox
Specify the label and line color Color button
Start a new measurement chain on the same objects
(clear 3D View of all points and empty point list)

Make another button

Export measurements in a CSV or XML ˉle Export button
Export measurements to SolidWorks Export to SolidWorks but-

ton1

Return to the original Measures tab Measurements link in the
upper part of the panel

After you click Apply, the application will return to the original Measures panel and will
display a list of all saved measurements along with editing and deletion options.
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Figure 112: Linear measurement.

10.3.2 Geodesic Distance

Geodesic distance is deˉned as the length of the shortest path over a surface between

several given points. Click the button in the Measures panel and select a point-cloud
scan or model to start using the tool.

Working with geodesic measurements is similar to working with linear measurements
(see Figure 113). Calculation of the shortest path is a time-consuming process that is
accompanied by a progress-bar window. Also keep in mind that the shortest path between
different surfaces or disconnected parts of the same surface is not deˉned. Therefore,
the program will display an error if you select points on parts of a surface that are not
connected to each other.

Note: The geodesic algorithm is complex, and computations for a large number of ver-
tices may take a long time. Therefore, if you choose the ˉrst point on a surface contain-
ing more than 150000 points total, the software will warn you that it may be a lengthy
operation. You can either use the mesh-optimization algorithm beforehand (see Mesh
Simpliˉcation) or delete the parts of the surface that you don’t need.

The left panel in this mode is similar to the one for linear-measurement mode (see Linear
Distance).
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Figure 113: Geodesic-distance measurement.

10.3.3 Using Sections to Measure Area and Volume

Section is the plane that splits model or scan into two parts. Once created, it can provide
you with data on volumes and areas of these parts as well as area and perimeter of the
contour, i.e. the line formed as an intersection of the plane with surface.

To create a section of the object, follow the steps:

1. Click the button in the Measurements panel and select one or more models or
scans. Models are preferable, since they contain only one surface.

2. Click Next and change the section name in the Name ˉeld as necessary.

3. Select constrain type in the bottom of the panel: Parallel to either plane or Not
constrained

4. Use LMB to mark points on the object’s surface:

1. Mark only one point to specify a plane in parallel with one of the coordinate
planes (XOY, YOZ, XOZ).

2. Mark three points to specify the plane that passes through them exactly.

3. Mark more than three points to specify the plane that passing through their
center of mass.
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Figure 114: Orienting new section in Translate mode.
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5. Redeˉne your point selections, if necessary, before you use Create section; to do so,
click the Clear points button.

6. Orient plane position as necessary. Choose a tool: Translate, Rotate or Scale. You can
either specify numerical values (in the global coordinate system) in the text ˉelds or
drag the controls (see Figure 98, Figure 99 and Figure 100) in the 3D View window.
For instance, enlarge Scale to make the plane cross the whole surface.

7. Click Create section.

8. Create a series of sections, if desired. To do so,

1. Click the Change position button.

2. Specify the quantity of planes you want to create by entering the value in
Number of planes and deˉne the spacing in the Section spacing, mm ˉeld.

3. Then select from the Direction list one of three directions (Positive, Negative or
Both) in which to create the new planes2.

9. Save your changes by clicking Apply, or click Measurements in the upper part of the
panel. To save the changes and begin creating the next plane, click Make another
section.

Once you have created the section, the Section panel will display its geometrical informa-
tion. This information includes perimeter and area for contours as well as area and volume
for parts of meshes. Besides displaying geometrical values, Artec Studio will show a list
of meshes and contours that allows you to highlight them in the 3D View window.

10.3.3.1 Switching Selections

A section splits model into two parts (selections). Artec Studio displays volume and area of
the one highlighted in red. To display volume or area of another part, click Invert direction.

To determine volume or area of the entire model, put down both values and sum up them.
You can also move your plane in order to situate it below the model (see the step about
orienting plane in the procedure above). This operation will highlight the entire model in
red and display the corresponding calculations.

10.3.3.2 Comparing Values

The Section panel allows you to compare contours and mesh parts. To this end, select
either two contours or two mesh parts from the list using the Ctrl key. Artec Studio
will calculate the differences between the areas and perimeters of the contours and the
difference between volumes and areas for mesh parts. These values will be available in
the lower part of the Section panel (see Figure 115).

2 If you want to separate a set of sections into individual ones, click Convert to multiple sections. The soft-
ware will notify you that the operation was successful, and the new objects will appear in the Measurements
list.
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Figure 115: Using sections.
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10.3.3.3 Exporting Sections

You can export sections in the following formats: CSV, XML or DXF.

• To export each section individually, enter the Section panel and click Export

• To export several objects at a time, access the original Measures panel, select the
checkbox next to desired sections and then click Export.

10.3.3.4 Displaying Only Sections

To display only planes and contours, select the Hide source data checkbox.

10.3.4 Surface-Distance Maps

You may often ˉnd it necessary to compare two models and assess the deviation of their
forms. For instance, quality control may require comparison of the original model with
the scanned one. You can handle these tasks by using Surface-distance map.

Note: Artec Studio can only compare models or scans containing a single surface.

Figure 116: Specifying parameters for surface-distance map calculation.

Use this tool as follows:

1. Click the button from the Measures panel.
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2. Select two models for comparison and click Next.

3. If necessary, specify the name of the distance map in the Name ˉeld of the Measures
panel (see Figure 116). By default the application creates new distance maps under
the names Map 1, Map 2 and so on.

Note: The direction along the normals of the ˉrst scan is considered
positive; the opposite direction is considered negative. The button
swaps scans.

4. Specify the Search distance (mm) value, a maximum range in millimeters for calcu-
lating distances between surfaces. You can adjust the actual range subject to this
maximum after the calculation ˉnishes.

5. Click Calculate. Once the process is complete, the distance map will appear in the
3D View window and the calculation results in the Measures panel (see Figure 117).

Figure 117: Surface-distance map calculated for two models.

You can analyze the calculation results and the distance map:

• On the basis of the Search distance value you entered, Artec Studio calculates the
following:

– RMS (root mean square)—the square root of the arithmetic mean of the squared
distances

– Mean absolute deviation

– Mean of signed distances
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• A distance map is a colored rendering on the particular surface regions. You can
read the corresponding distance values and their distribution from the graduated
scale and histogram that appear adjacent to the model. The map color changes
from blue, which corresponds to a negative distance, to red, which corresponds
to a positive distance.

– Green means the distance between surfaces in this region is close to zero.

– Gray highlights any surfaces with distances that exceed the speciˉed Search
distance.

– Orange and bright blue correspond respectively to distances that are
slightly above and below the limiting values of the scale.

• The graduated scale ranges from the positive value to the negative value of the
Error scale. You can adjust this range using the Error scale (mm) slider or text box.
Its maximum value cannot exceed the Search distance.

• If you move the mouse cursor to a particular point on the map, the exact distance
will appear nearby and in the Distance at cursor ˉeld in the left panel.

To save the current distance map and quit this mode, click Apply. To save the current map
and create another one, click Make another map.

Note: Surface-distance maps are supported by annotations. You can use any saved dis-
tance map in Annotation mode (see Annotations).

10.3.5 Annotations

Annotations tools allow you to mark noteworthy surfaces and surface-distance maps. The
annotation can include one or more labels, which look like rectangular tags with connect-
ing lines pointing to the corresponding surface elements (see Figure 118).

To create an annotation,

1. Click the button in the Measures panel, then select one or more scans and click
Next.

Note: If you want to annotate a previously obtained surface-distance
map, select it from the Distance map list.

2. Specify the Annotation name in the upper part of the panel, or simply proceed with
your annotation using the default name.

3. Click LMB on the surface’s target point in the 3D View window; the label will appear
with a blinking text cursor in the Annotation text ˉeld of the Measures panel.
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Note: Artec Studio doesn’t enable you to redeˉne a label’s target point.
If you inaccurately specify a point on the surface, add a new one (repeat
Step 3) and delete the old one (consult the instructions below).

4. Type any desired text for your annotation; this text will appear in both the corre-
sponding ˉeld in the panel and the label in the 3D View window.

5. Repeat Steps 3 and 4 to create a new label. In addition to tagging the surface,
each new label will appear in the annotation list of the Measures panel (see Figure
118). You can show or hide labels in the list or change their colors by clicking
RMB and selecting the appropriate option from the menu. Alternatively, toggle the
selection ˊag or click the square button to show/hide labels or change their
colors, respectively.

Figure 118: Annotation of a model layered with a surface-distance map.

You can adjust the label position (meaning the rectangular tag, not the target point!) by
holding LMB in the 3D View window while moving the mouse cursor. To delete unneces-
sary labels, use any of the following approaches:

• Select the label in the 3D View window; its border color will become red (see se-
lected label in Figure 118). Hit the Del key.

• Select the label from the list, then either hit Del, or click RMB and choose Delete
from the menu.

To export annotations (more precisely, label coordinates and titles) to a CSV or XML ˉle,
click Export in either the Annotations or original Measures panel. By default, the ˉle name
will be the same as the annotation name. Accept it or type in another name of your
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choice. To complete the annotation, click Apply in the bottom of the Measures panel or
click Measurements in the upper part.
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CHAPTER 11

Settings

This chapter describes Artec Studio settings that you can change through the Settings
dialog. To display this dialog, select Settings… from the File menu or hit the F10 key.

The user-adjustable settings are divided into categories under separate tabs. These cat-
egories include the following:

• General

• Performance

• Scan

• UI

• Miscellaneous

11.1 General

The General tab contains basic Artec Studio settings and includes the following options
(see Figure 119):

• Project-storage folder

• Autosave options

• Import/export options

• Default import units and Default export units

• View control settings
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Figure 119: General settings page.

168 Chapter 11. Settings



Artec Studio, ver. 14

11.1.1 Project-Storage Path

Project-storage path is a default path which Artec Studio will use in the project saving dia-
log (Saving a Project). The default location is Windows user’s Documents folder. You can
alter this path by editing the ˉeld content or clicking Browse… and afterwards specifying
the required folder.

11.1.2 Temporary Folder

A newly created and yet unsaved project is stored at the location speciˉed in the Temporary
folder ˉeld. The default path is the Windows temporary folder. To change this folder, use
the Browse… button or enter a new path in the ˉeld.

Artec Studio automatically clears project folder. You can access Windows temporary folder
and remove the unwanted projects as necessary.

1. Open the Explorer window.

2. Type %temp% in the address bar and hit Enter.

3. Locate folders that have GUID names in braces { }.

11.1.3 Autosave Options

When the Save project before starting algorithms option is enabled, the application will
always save your project before running any processing routines. The Restore loading state
of scans after algorithms ˉnish checkbox allows you to control loading of selected scans
once the algorithm is complete. Artec Studio always loads selected scans into memory
before launching an algorithm; if a scan is not loaded at this point, the application will
automatically save it to the hard drive after the algorithm ˉnishes, freeing up memory.
For more information about autosaving projects, see Autosaving a Project.

11.1.4 Registering Artec Studio as Default Viewer

Artec Studio supports various ˉle formats. Tomake it the default application for supported
formats, click Change… and select the formats you want the application to open by default
(see Figure 120):

*.sproj —project ˉles for Artec Studio

*.scan —single-scan export/import format

*.ply —format for saving polygonal models obtained using 3D scanners

*.stl —3D-model export format for fast-prototyping equipment

*.wrl —virtual-reality ˉles in VRML 1.0 and VRML 2.0 format

*.obj —texturized 3D models; Wavefront OBJ format
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Figure 120: Making Artec Studio the default application for various ˉle types.

For more information on importing and exporting ˉles, see Exporting Models, Scans and
Point Clouds and Importing Models and Scans.

11.1.5 Opening Files

Artec Studio can serve as the default viewer for SPROJ, SCAN, PLY, STL, OBJ and VRML
(*.wrm) formats. To open each subsequent ˉle in a new application window, select Open
new model in a new window. If the Open new model in the same window option is selected,
Artec Studio will use existing windows to display subsequent ˉles.

11.1.6 Surface-Consistency Detection During Import

The Surface-consistency detection during import option instructs Artec Studio to examine
imported ˉles for defects. Select one of the following parameters:

Do not detect —disable automatic surface-consistency detection

Detect & ask —enable automatic surface-consistency detection; Artec Studio will prompt
you to start defect correction

Always detect & ˉx —enable automatic surface-consistency detection and correction

11.1.7 Model Placement

When exporting, the application can automatically center scans and models on the origin
of the axis grid. To enable this option, select theMove model to origin of the axis grid during
export checkbox. If the checkbox is cleared, the application will save the model’s current
placement on the axis grid when exporting surfaces.

11.1.8 Base Removal for Leo Scans

The Enable automatic base removal option in the Scan panel only works for scans from Eva
and Spider and other handheld scanners connected to computer. To enable automatic
base removal for scans from Leo, select the Launch base removal for Leo scans checkbox.
The algorithm will start after the application imports that project.
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11.1.9 Point-Cloud Export

The Export point clouds to PTX with merged sections ensures a successful import of the
exported ˉles in third-party software products. See Merging Sections.

11.1.10 Units

In Artec Studio, all software operations use millimeters as the default measurement unit.
If you need to import or export a model in other units, change the settings under Units.
The software applies these settings only when importing or exporting a model or a point-
cloud scan.

Selecting the Show unit-selection dialog on import option enables you to choose on im-
port which measurement unit was used to create the scan (see Figure 121). Artec Studio
supports units of millimeters, centimeters, inches and meters. If in most cases you import
data in a particular measurement unit, but you might occasionally import models created
using another unit, you should enable the Only if object is less than __ mm option and enter
the threshold value. In this case, the unit-selection dialog will only appear if the model
dimensions are below the threshold value.

TheDefault import units andDefault export units dropdown lists determine the default mea-
surement units for importing and exporting models. When exporting point-cloud scans
(Artec point cloud and Leica Geosystems Cyclone Point Cloud), application will ignore the
speciˉed units. See Exporting Point Clouds for details.

Figure 121: Unit-selection window.

11.1.11 View-Control Settings

Artec Studio allows you to use Scroll wheel to zoom in on the model in the 3D View
window. You can take advantage of this capability in two ways:

Clear the Mouse-wheel zoom to cursor checkbox to enable zooming to the center of the
screen. In this case, you must keep the target area in the screen center and readjust
its position from time to time.

Select the Mouse-wheel zoom to cursor checkbox to enable interactive zooming to the
mouse-cursor position. In this mode, you need only keep the cursor on the target
area while spinning Scroll wheel forward and backward.
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11.2 Performance

The following parameters are user adjustable by way of the Performance tab (see Figure
122): multithreading, memory usage, command-history storage, compression levels for
stored data, texture-recording mode and Real-time fusion settings.

Figure 122: Performance-tab options.

11.2.1 Multithreading

On computers that feature multicore processors, Artec Studio uses all cores by default.
If you would like to limit the number of cores the application employs, clear the Use all
available processor cores checkbox and enter the number of concurrent threads manually.
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11.2.2 Memory

Under Memory, the Settings dialog shows RAM availability. If the current amount is insuf-
ˉcient, you can try to increase it by clicking the Compact memory button. Artec Studio will
clear the command history and attempt to optimize memory allocation. Clicking Compact
memory won’t permanently delete the history, but simply unload it from memory. The
Undo command will reload it. For more information about saving projects, see History of
Project Changes.

Note: You cannot unload the command history from memory if you haven’t saved the
project. Save the project and try again.

Artec Studio automatically optimizes memory allocation after each algorithm ˉnishes.
This function is handled by the Compact memory after algorithm completes checkbox. In
contrast to the button, it doesn’t unload command history.

11.2.3 Command History

Under the Command history section you can limit the amount of history Artec Studio will
save. By default, the maximum values are set as a certain number of commands and size
on disk (in MB). If necessary, you can clear the Max history length checkbox. Doing so
means the program will save all history for each project from the beginning. You can
clear the project history by clicking the Clear command history button; the application will
prompt you to conˉrm this action.

Note: Once you clear the history, you cannot return to an earlier project version.

11.2.4 Data-Compression Level

The Data-compression level slider allows you to change the amount of ˉle compression
when saving data. Higher compression saves disk space, but loading and saving these
scans takes longer.

Important: Maximum compression settings are optimized to ensure that the shape of
your models and frames will be preserved. Insigniˉcant deformation may, however, occur.
Change the slider position as necessary.
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Table 15: File compression in Artec Studio.
Slider Posi-
tion

Type Compatibility Output File
Size

Left No compression All versions Large
Middle Medium compression (loss-

less)
All versions Medium

Right Maximum compression
(lossy)

Artec Studio 12 and
later

Small

11.2.5 Texture-Recording Mode

By default (Automatic texture recording enabled), Artec Studio doesn’t capture texture for
every frame. You can, however, manually specify the frequency for capturing texture
frames by using the Record texture every __th frame spinner.

Figure 123: Spinner for adjusting capture frequency of texture frames.

11.2.6 Real-Time Fusion Settings

Real-time fusion offers two optional settings (see Scanning With Real-Time Fusion):

Voxel size (mm) The fusion resolution. It affects the algorithm’s performance and quality.
The lower the value, the sharper the shape of the model. Note that specifying low
values may produce noisy surfaces.

Buffer size Amount of GPU memory employed to reconstruct a Real-time fusion object in
the scene. The default value depends on the computer’s available GPU memory.
Note that Artec Studio may fail to correctly determine the upper limit if your com-
puter has an Intel HD Graphics card. The more memory you have, the larger the
scene you can scan in Real-time fusion mode. The slider doesn’t deˉne the total
ˉnite memory size, however; the algorithm employs system memory (RAM) when
GPU memory is consumed.

Note: Avoid altering the Buffer size unless you have started noticing artefacts while
scanning.

Table 16: Default values of Voxel size.
Artec EVA Artec Spider Third-Party 3D Sensors

Voxel size (mm) 1 0.3 3
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11.3 Scan

The Scan tab allows you to edit the parameters that the application uses both while scan-
ning and while postprocessing the results (see Figure 124).

Figure 124: Scan-settings tab.

11.3.1 Algorithm Settings

Artec Studio automatically selects and displays settings for each scanner type in the Cur-
rent scanner type dropdown of the Settings dialog and in the Preset dropdown of the Tools
panel. If it fails to correctly identify your scanner type or you process scans from differ-
ent scanners, select the appropriate scanner type manually. To reset all settings to their
default values, click Reset to defaults.

Current user preset allows you to save the current parameter values in the Tools panel. By
selecting a saved preset, you can change all settings at once. Note that this option applies
only to the selected device type.

11.3.2 Photogrammetry Settings

Photogrammetry settings allow you to deˉne the target size. Inner target diameter (mm)
corresponds to the diameter of the white circle in the middle of the target; Outer target
diameter (mm) corresponds to the outer diameter of the target’s black ring. The most pop-
ular targets have diameters of 6mm and 12mm; the values 5mm and 10mm correspond
to the Scan Reference target. See Target-Assisted Scanning for details.
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The Disable hybrid tracking for .obc checkbox ensures that tracking is purely based on
targets. Select the checkbox if you don’t want the texture and geometry features to assist
target scanning (Using Photogrammetry Solution (Scan Reference)).

11.3.3 Capture

The Capture section covers settings related to the trigger button for the Artec MHT scanner,
as well as the scanning-depth range and individual frames acquired during the scan.

The ˉrst option is the Trigger mode for device button checkbox, which changes the button
behavior on the Artec MH and Artec MHT scanners. For details regarding these buttons,
see Scanner Buttons and Capture Modes.

The scanner has a deˉned depth range. If it’s too close to the object, it may fail to cap-
ture all or part of the object. On the other hand, if the scanner is too far away, various
types of 3D “noise” will appear in the scene, complicating the postprocessing effort and
affecting the ˉnal results. Therefore, you should position the scanner as close as possible
to the object without crossing the cutoff plane. Default settings for each 3D scanner con-
tain minimum and maximum limits within which you can position the cutoff planes. The
scanner model determines these values. If you are using an Artec L scanner or 3D-sensor
and high accuracy is of lesser importance, however, you can adjust the depth boundaries
manually, allowing you to scan closer to or further from the object than the recommended
distances indicate. To this end, mark the Override default depth range checkbox and enter
new range values.

Warning: Redeˉning the depth range may reduce accuracy.

11.3.3.1 Scan Using Auto-Alignment

The Scan using auto-alignment option is enabled by default and is covered in the Resuming
Scan After Lost Tracking and Auto-align new scans with those marked in Workspace sections.
The application’s behavior varies depending on this option’s value, as Table 17 shows.
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Table 17: Application behavior with option enabled and
disabled.

Scan Using Auto-
Alignment On Off

Tracking Mode Geometry + Texture Geometry or Geometry +
Texture

Audio Notification? Yes (see Audio Notiˉcation) Yes

Message in 3D View Searching for position: Point 3D Scan-
ner at the object to continue

Tracking lost: Repeat scan
using slower motions or
additional features

Instructions

Direct the scanner at any already cap-
tured region with sufˉcient texture,
maintaining the original scanner orien-
tation relative to the object

Direct the scanner at the
last captured region

Data Recording Handled in a newly created scan Handled in the same scan

11.3.4 Misalignment Detection

In some cases, Artec Studio may incorrectly determine relative frame positions, result-
ing in misalignment. When this error occurs, you must restart the scanning session and
remove the misaligned scans. Alternatively, you can attempt to ˉx the misalignment by
breaking the scan into several segments. Further information about addressing this prob-
lem by dividing scans is available in Separating Scans. To prevent possible misalignment
and improve your scanning experience, Artec Studio features a Misalignment detection for
EVA scanner setting that functions during the scanning process. However, if you have dif-
ˉculty maintaining the tracking when scanning particular objects, you can disable this
setting.

Options are as follows:

On (Hybrid tracking only) —default value, option works for Geometry + Texture tracking
mode

On —option works for all tracking modes, including Geometry

Off —option is turned off for all trackers.

11.3.4.1 Default Capture Settings

Artec Studio allows you to change the characteristics of single-frame surfaces as the scan-
ner captures them. To change the default parameters, clear the Use default capture settings
checkbox and change the settings manually in the displayed window. The options below
are user adjustable:

Important: We recommend using default settings. Poorly chosen settings may reduce
data quality.
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Triangles step —point density for a frame mesh

Minimum object size —smallest object scanned, by number of polygons

Length ˉlter threshold —triangle-ˉltration threshold by edge length (maximum possible
size in mm)

Interpolate —use interpolation for parts of surface that are missing data

Max interpolated length —maximum size of areas to be interpolated (in mm)

Max angle —triangle-ˉltration threshold by maximum angle (in degrees) between the tri-
angle’s normal and the camera’s sight vector

Geometry registration threshold —the higher the threshold, the stricter the quality require-
ments for the geometry being scanned. Therefore, determining the proper geometry
in the scene is more difˉcult in such cases. Subsequently, Artec Studio runs geom-
etry registration less frequently, making way for texture registration. Works with
Geometry + Texture tracking only, values are between 0 and 1.

11.4 UI

The UI page allows you to edit user-interface settings (see Figure 125) and covers the
following categories:

• Audio notiˉcation

• Workspace colors

• Warnings

• Surfaces that Artec Studio displays during a scan

11.4.1 Audio Notification

Sometimes, automatic alignment in real time is impossible during the scanning process,
and the program is unable to align the previous frame with the current one (see Resuming
Scan After Lost Tracking). When this situation occurs, Artec Studio issues an audio warning
that stops once you reposition the scanner and the software again ˉnds its location in 3D.
To enable or disable this feature, use the Enable audio warnings in scan mode checkbox. A
standard “beep-sound” is the application’s default sound. You can choose any WAV ˉle as
the warning sound. To this end, click the … and specify a ˉle path.

See also:

Warnings in Tools and Editor.

11.4.2 Workspace Colors

Artec Studio automatically chooses display colors for newly created scans. You can select
any of the standard palettes:

178 Chapter 11. Settings



Artec Studio, ver. 14

Figure 125: Interface-settings tab.

11.4. UI 179



Artec Studio, ver. 14

• Full palette

• Light colors

• Web-safe colors

• Random colors

• Monochrome

11.4.3 Warnings

TheWarnings options allow you to toggle certain notiˉcations. They include the following:

11.4.3.1 Startup Checks

Show OpenGL compatibility issues on startup. Artec Studio requires OpenGL version 2.0 and
some OpenGL extensions to function properly; your PC may or may not currently support
these capabilities. Selecting this option activates a display window on startup containing
information regarding possible missing extensions.

11.4.3.2 Warnings in Tools and Editor

If you are familiar with these algorithm peculiarities, you may disable these notiˉcations.

Texture-healing brush: warn if over __ polygons selected. This checkbox instructs the ap-
plication to display a warning if you exceed the maximum number of polygons to be in-
painted at one time. This limit reduces the potential for the computer to hang up. Specify
a suitable value for your system, or clear this checkbox if you require no warnings of this
kind.

Warn about texture removal by Defeature brush. Be ready thatDefeature brushwon’t preserve
texture in the corrected areas, so the application notiˉes you of this.

Warn about smooth fusion on Spider scans. Artec Studio will recommend switching from
Smooth fusion to Sharp fusion for scans from Spider, since the latter yields more detailed
models.

Warn about scans in transformation tool. We advise that you refrain from repositioning
source scans as it may result in the incorrect texture application. Themessagemay remind
you about it.

Inform about texture frames for Reduce glare. Since this option in the Texture panel requires
many texture frames, Artec Studio will advise you to adjust frame-recording settings.

Play a sound on completion of algorithm lasting more than 30 seconds. This setting allows
you to get distracted while the application is busy running algorithms and performing
commands. Once the application ˉnishes any of these processes, it chimes.

180 Chapter 11. Settings



Artec Studio, ver. 14

11.4.4 Displaying in 3D View Window

You can change the way you see surfaces and points during the scanning process, adjust
their colors as well as the background color, and specify the mode for frame playback. To
these ends, use the settings below:

11.4.4.1 Display

Last scanned surfaces. Number of visible surfaces most recently captured that will appear
in 3D View during scan

Visible surfaces. Total number of visible surfaces displayed during scan (equal to the num-
ber of most recently scanned surfaces plus the number of key frames to display)

Disable smart simple rendering mode. Smart simple rendering mode ensures that 3D con-
tent is rendered without simpliˉcation if computer resources allow it. Once the system
experiences lags, it automatically turns on simpliˉcation.

Polygon limit for conventional simple rendering mode. Maximum number of polygons in
the viewport beyond which Artec Studio will switch to simple rendering mode during 3D
navigation

Point-cloud polygon limit. If the polygon count of a point-cloud surface exceeds the spec-
iˉed value, Artec Studio will render a simpliˉed copy of this surface having no more than
speciˉed polygons.

Spherical target diameters. List of diameters of the target spheres used during scanning
with Ray. Use semicolon ; as a delimiter between values in millimeters in the ˉeld.

Point size. Number of pixels for rendering each point when using the Points or the Points
and solid rendering mode

Animate movements It shows movement of the 3D data when Artec Studio repositions or
reorients it. Disable this option on slow computers.

11.4.4.2 Colors

Last —color of last scanned surfaces

Registered —color of correctly aligned surfaces

Preview —color of surfaces in preview mode

Dropped —color of unaligned (and thus dropped) surfaces

Key frames —color of key frames (surfaces)

11.4.4.3 Playback

See also:

Selecting Scans and Models
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Repeat —continuously loop the frame sequence in the surface-view mode of the
Workspace panel

FPS —speed (in frames per second) at which frames appear during playback

11.4.4.4 Background

Color —background color; the application may automatically alter this color in certain
modes, such as X-ray

Dropped color —background color when misalignment occurs while scanning

Texture —display patterned (chessboard pattern) or plain background

Gradient —gradient or monochrome background color

Background for screenshots —application will use this background color when saving
screenshots, the actual background color will remain unaltered

Figure 126: Example of altered background.
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11.4.4.5 Welcome Screen

Don’t show —disable the welcome screen

11.4.4.6 Autopilot

Don’t show greeting screen —disable the Autopilot screen showing the steps to pass in this
mode

11.5 Miscellaneous

11.5.1 Usage Information

You can help us improve the quality and performance of Artec Studio by allowing us to
collect and send usage information to Artec Group. This information will not be used to
identify you, and it excludes your project data, 3D surfaces, textures and any other data
that you obtain and process using Artec Studio. By default, the Collect and send anonymous
usage data to Artec checkbox is selected. We recommend leaving this checkbox marked so
we can better improve the application.

When installing Artec Studio, you can decide whether you want it to collect and send
usage data. The same checkbox described above also appears in the ˉnal installation
dialog (see Figure 19).

Figure 127: Miscellaneous-settings tab.

11.5.2 Language

The Artec Studio interface supports several languages:
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• Auto—automatic language selection on the basis of system settings

• Chinese (Simpliˉed)

• Chinese (Traditional)

• Czech

• English (U.S.)

• French

• German

• Italian

• Japanese

• Korean

• Polish

• Russian

• Spanish

To switch between languages, choose the one you want and click OK. The program will
then prompt you to restart. If you agree, the application will restart automatically using
the newly selected interface language. If you choose not to restart, the changes will take
effect the next time you start the application.

Note: To change the language, Artec Studio must restart.
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Scanner Calibration and Correction

The Diagnostic Tool is a special utility that enables you to calibrate Artec 3D scanners
and correct an existing calibration. In general, calibration is the process of checking and
adjusting a scanner’s measurements by comparing themwith the standard (etalon) values.
Every Artec scanner is delivered pre-calibrated.

In some cases, owing to careless handling or transportation (jolts, accidental drops or
some other reason), the scanner may fail to capture surfaces properly. The scanned sur-
faces may only be partially reconstructed or may contain holes (for example, the results
of bad reconstruction are noticeable on the blue surface in Figure 132). You can resolve
these issues by correcting or calibrating the scanner.

Depending on the scanner model, the Diagnostic Tool can operate in one of the three
working modes:

• Correction for Artec MHT, Artec MH, Artec L and Artec EVA scanners

• Correction for Artec Spider scanner

• Calibration of Artec Spider scanner

Note: Calibration is available only for Artec Spider scanners.

12.1 Suggestions for Use

Correction differs from calibration in that it preserves the current calibration: it only
changes the correction ratio so as to enable good reconstruction.
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Important: Application of the correction does not guarantee that captured geometric
shapes and linear measurements will be accurate. Use this procedure as a temporary
measure until calibration is performed.

Table 18: Correction versus calibration.
Mode Characteristics Speed For Spider? For EVA, L, MHT?
Correction Inexact Fast Yes Yes
Calibration Exact1 Prep required Yes No

12.2 Launching Diagnostic Tool

To launch the Diagnostic Tool, ˉrst ensure that the scanner you intend to diagnose appears
in Artec Installation Center as either On loan or Activated. You can launch the tool either
through the Start menu by clicking Start → All Programs → Artec Group → Artec Studio →
Diagnostic Tool or in Artec Studio by selecting the Run Diagnostic Tool command from the
File menu.

If you have several scanners connected, select the appropriate one from the dropdown
list.

Figure 128: Diagnostic Tool window.

The utility window contains three sections: the 3D View panel, the right panel and the
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toolbar (see Figure 128).

12.3 Scanner Correction

Important: Apply correction sparingly as a temporary measure until calibration is per-
formed.

12.3.1 Correcting Field of View for EVA, MHT, MH and L Scanners

The Artec EVA, Artec MHT, Artec MH and Artec L scanners only allow you to correct their
current calibration data on ˉeld of view.

Figure 129: Artec EVA correction results.

1. Launch the Diagnostic Tool as Launching Diagnostic Tool describes.

2. Select the scanner you want to diagnose.

3. Click Start diagnostic or press the button. The scanner will start the preview, a
range meter will appear in the 3D View window and another panel will appear on
the right showing a 2D camera preview.

4. Direct the scanner at the right angle to a ˊat, light (but not shiny) monochrome
surface (e.g., a wall or ˊoor) from a distance of 650–700 mm for an Artec MHT,

12.3. Scanner Correction 187



Artec Studio, ver. 14

Artec MH or Artec EVA scanner or a distance of 850–900 mm for an Artec L scanner.
The tool will render the surface in blue in the 3D View window.

Note: If the rendered surface is not ˊat and contains holes, the correction is worth
performing.

5. Click Start correction or press the button on the scanner. In addition to the blue
surface, a yellow surface will appear in the 3D View window. Blue corresponds to
the surface captured using the original calibration data; yellow corresponds to the
surface captured using corrected calibration data.

6. Two indicators in the right panel can help you assess the surface quality (green
stands for good results, yellow for satisfactory and red for unsatisfactory). If the
corrected (yellow) surface has no holes and is sufˉciently ˊat, and if the correction
results meet your expectations, click Commit or press the button on the scanner.
Otherwise, click Rollback or press on the scanner.

12.3.2 Correcting Calibration Data for Spider

Correction for Artec Spider differs slightly from correction for Artec MHT and Artec EVA
scanners.

Figure 130: Artec Spider correction process.
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1. Launch the Diagnostic Tool as Launching Diagnostic Tool describes.

2. Select Artec Spider from the dropdown list.

3. Click Start diagnostic or press the button; the scanner will start the preview, a
range meter will appear in the 3D View window and another panel will appear on
the right showing a 2D camera preview.

4. Direct the scanner at the right angle to a ˊat light monochrome surface (e.g., a wall)
from a distance of 190–270 mm. The tool will render the surface in blue in the 3D
View window.

Note: If the surface, when captured from a distance within the sug-
gested range, fails to render as ˊat or contains holes, correction is worth
performing.

5. Place the scanner on a desk or attach it to a tripod, keeping a distance of about 190
mm from the ˊat surface (see the range meter in the 3D View window).

6. Click Start correction or press the button on the scanner. A red mark will appear
on the range meter.

7. Move the scanner smoothly toward the ˊat surface such that the histogram peak
coincides with the red mark on the range meter (see Figure 131).

8. Look for a new red mark to appear higher on the range meter. Smoothly move the
scanner away from the ˊat surface to approach the red mark.

9. Repeat Step 8 three more times. Once you ˉnish, the calculation will start. A yellow
plane that corresponds to the surface you captured using the corrected calibration
settings will then appear in the 3D View window (see Figure 132).

10. If the yellow surface has no holes and is sufˉciently ˊat, and if the correction results
meet your expectations, click Commit or press the button on the scanner. Oth-
erwise, repeat Steps 7–9, click Rollback or press on the scanner. Two indicators
on the right panel can help you assess the surface quality (green stands for good
results, yellow for satisfactory and red for unsatisfactory).

12.4 Spider Calibration

To carry out the calibration, you will need the following additional equipment: a calibra-
tion rig, a scanner stand and a pattern. Assembly instructions for the scanner stand and
calibration rig appear in Assembling the Scanner Stand and Assembling the Calibration Rig,
respectively.

1. Unfold the pattern and place it on a desk or any hard, planar surface.

2. Align the scanner stand with the rectangle marked on the pattern, paying close
attention to the orientation of the slots in the stand cover (see Figure 133).
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Figure 131: Artec Spider scanner’s position and corresponding distance on the range me-
ter.

Approaching the read mark (at the top), reaching the required distance (at the bottom).

Figure 132: Artec Spider correction results.
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Figure 133: Scanner stand resting on a pattern.

Figure 134: Placing Artec Spider on the stand
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Figure 135: Calibration rig, pattern and scanner stand with Artec Spider.

3. Place the scanner on the scanner stand, making sure that you insert the three scan-
ner stems in the three slots of the stand cover (see Figure 134).

4. Set the calibration rig on the pattern, turning its marker side toward the scanner as
Figure 135 shows.

5. Launch the Diagnostic Tool as Launching Diagnostic Tool describes.

Note: You should conduct the calibration only after the scanner has
warmed to the optimal temperature.

6. Click Start calibration. A dialog box will open (see Figure 136); enter the serial num-
ber of your calibration rig (it appears on the board). If the scanner temperature is
outside the optimal range—for example, you just connected the device to a power
outlet—the tool will notify you of this condition (see Figure 137). We advise against
clicking Skip and instead recommend waiting for the Artec Spider to reach its opti-
mal temperature.

7. Place the rig in its initial position such that the front edge of its base coincides with
the color line numbered 1 on the pattern. As you do so, also keep an eye on the 3D
View window for a red plane (current position) and a green plane (target position)—
see Figure 138. Once the red plane coincides with the green one, stop moving the
rig and wait for the scanner to capture the plane.

8. Wait for the tool to instruct you to move the rig to the next position on the pattern;
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the number for that position will appear on the screen. Move the rig and again wait
for the scanner to capture the plane.

9. Repeat the preceding step for the remaining positions sequentially. Depending on
the version of your calibration kit, the pattern will have 11 to 15 positions.

10. Once you have captured the last position and the calculations have concluded, a
message will appear prompting you to either overwrite the existing calibration or
keep the current one. Before you decide, direct the scanner at a ˊat, nonglossy
surface (e.g., a piece of paper) from a distance of about 200 mm. Assess the quality
of the reconstructed surface and check for any holes.

11. Click Yes, apply the calibration if no holes appear on the surface and you are satisˉed
with the reconstruction results. To reject the new calibration, click No, keep the old
one (see Figure 139).

Figure 136: Entering serial number of calibration board.

Figure 137: Warming up the scanner.

12.5 Notes Regarding Scanner-Calibration Files

Calibration and correction results reside in ˉles that you can access as follows. Their
location is

C:\Users\%name%\AppData\Roaming\Artec\Artec Installation Center
\Devices\SP.00.00000000.

Here, %name% is the current user folder and SP.00.00000000 is the folder correspond-
ing to the scanner serial number. Note the following information regarding calibration
and correction.

• Once you apply correction results, the software will create an ACD ˉle.
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Figure 138: Moving calibration rig to position number 1.

Figure 139: Assessing calibration results.
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• Once you apply calibration results, the software will create ACD and CORR ˉles.

• All newly created ˉles have names of the form YYYYMMDD_HHMMSS, with the char-
acters corresponding to the date and time of the ˉle’s creation.

• Original ADD and CORR ˉle names are based on the scanner serial number and have
the form SP.00.00000000.

Note: You can restore the initial calibration by removing the ACD and CORR ˉles whose
names have the form 20131121_101010.

Note: If you use the scanner on several computers, you need not recalibrate it on every
one. Simply copying the ACD and CORR ˉles to the above-mentioned folder on each
computer may be sufˉcient.

12.6 Assembling the Scanner Stand

The scanner stand comes unassembled with Artec Spider and consists of ˉve parts (see
Figure 140): two side walls, one front and one back wall (these parts are identical, how-
ever), and a cover. Before beginning assembly, lay them all out as Figure 140 shows. Then
follow these steps:

Figure 140: Parts of the scanner stand.

1. Raise the two side walls to the upright position, as Figure 141 shows. Noting care-
fully the orientation of the T-shaped slot, install the front wall to the side walls
using the two pairs of hooks. Press the front wall and slide it down against the stop.
Make sure the three walls are properly aligned with each other.

2. Install the back wall in the same way (see Figure 142).
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3. Paying attention to orientation of the slots, install the cover using the upper hooks
of the side walls (see Figure 143).

4. Press your thumbs against the T-shaped holes on the cover and shift it toward the
back wall until you hear a click (see Figure 144).

Figure 141: Assembling the front wall.

Figure 142: Assembling the back wall.

The scanner stand is now ready to use.

Note: To disassemble the stand, release the detents in the cover’s T-shaped slots (see
Figure 140) using a thin object like a ballpoint pen. Repeat the assembly steps in reverse
order (from Figure 144 to Figure 141), moving the parts in the opposite directions.
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Figure 143: Mounting the cover.

Figure 144: Latching the cover.
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12.7 Assembling the Calibration Rig

The calibration rig comes only with Artec Spider and consists of the base and the board.
To assemble the rig, follow these instructions:

1. Press the hinge of the base against your foreˉngers.

2. Unfold the bent leaves of the base, pressing on their edges with your thumbs.

3. Insert the board into the slot, as Figure 145 shows.

Figure 145: Assembling the rig.
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Hot Keys

13.1 Scanning

Open Scan panel F7
Anywhere exc. modal dia-
log

Toggle between Preview and Record
modes Space Scan panel

Open Multicapture panel F8
Anywhere exc. modal dia-
log
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13.2 Workspace

Select one scan and deselect the
rest Ctrl+Alt+LMB Workspace panel

Select one scan and deselect the
rest Ctrl+LMB

Workspace panel, ˉrst col-
umn

Select/deselect scan Shift+Alt+LMB Workspace panel
Select all scans/models or frames Ctrl+A Workspace panel
Deselect all scans/models or frames Ctrl+D Workspace panel
Select/deselect the highlighted
scan Space Workspace panel

Invert selection of scans/models Ctrl+Alt+A Workspace panel

Select only key frames Ctrl+K
Workspace panel → Sur-
face list

Select only textured frames Ctrl+J
Workspace panel → Sur-
face list

Rename scan/model F2 Workspace panel
Start/stop playback scan frames Ctrl+P Workspace panel

Delete selected frames/scans Del
Workspace panel (including
surface list)

13.3 Save, Export and Import

Create new project Ctrl+N
Anywhere exc. modal dia-
log

Save project Ctrl+S
Anywhere exc. modal dia-
log

Open existing project Ctrl+O
Anywhere exc. modal dia-
log

Open existing project with scans
unloaded (to save memory) Ctrl+Shift+O

Anywhere exc. modal dia-
log

Import 3D ˉles Ctrl+I
Anywhere exc. modal dia-
log

Export meshes Ctrl+Shift+E
Anywhere exc. modal dia-
log

Clear command history Ctrl+Alt+H
Anywhere exc. modal dia-
log

Save screenshot of 3D View window Ctrl+Shift+S Anywhere
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13.4 Viewing 3D Content

Fit to view F 3D View win-
dow

Place coordinate origin to the viewpoint center
(Home)

H 3D View win-
dow

Display/hide coordinate axis grid G 3D View win-
dow

Set rotation center to the object’s center of mass Ctrl+Shift+C 3D View win-
dow

Set rotation center to the origin of axis grid Ctrl+Shift+M 3D View win-
dow

Change rendering mode to Texture Ctrl+Alt+1 3D View win-
dow

Change rendering mode to Scan color Ctrl+Alt+2 3D View win-
dow

Change rendering mode to Surface color Ctrl+Alt+3 3D View win-
dow

Change rendering mode to Max error Ctrl+Alt+4 3D View win-
dow

Turn on/off lighting L 3D View win-
dow

Display/hide normals N 3D View win-
dow

Display/hide boundaries B 3D View win-
dow

Display/hide texture boundaries Shift+B 3D View win-
dow

Toggle between perspective and orthogonal
views

5 (numpad) or
Ctrl+5

3D View win-
dow

13.4.1 Switching Viewpoint

To front 1 (numpad) or Ctrl+Shift+1 3D View window
To back Ctrl+1 3D View window
To left 3 (numpad) or Ctrl+Shift+3 3D View window
To right Ctrl+3 3D View window
To top 7 (numpad) or Ctrl+Shift+7 3D View window
To bottom Ctrl+7 3D View window
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13.5 Editor

Activate 2D selection mode Shift+Alt+1 Editor → Eraser
Activate 3D selection mode Shift+Alt+2 Editor → Eraser
Activate Rectangular selec-
tion mode

Shift+Alt+3 Editor

Activate Lasso selection
mode

Shift+Alt+4 Editor

Activate Cutoff-plane selec-
tion mode

Shift+Alt+5 Editor

Activate Base selection mode Shift+Alt+6 Editor → Eraser
Display control for adjusting
cutoff plane

Alt Eraser/Defeature brush →
Cutoff-plane selection

Move cutoff plane Ctrl+Shift+Scroll Eraser/Defeature brush →
Cutoff-plane selection

Change tool size Ctrl+[ and Ctrl+] or
Scroll Wheel

Editor panel → any tool

Select the entire surface be-
low the cutoff plane

Ctrl+Q Eraser/Defeature brush →
Cutoff-plane selection

Clear selection of 3D regions Ctrl+Alt+LMB Editor
Invert selection I Editor panel → any tool →

3D View
Delete selected region Delete Editor → Eraser

13.5.1 Transformation Tool

Enable Translate transformation T Editor → Transformation
Enable Rotate transformation R Editor → Transformation
Enable Scale transformation S Editor → Transformation
Translate (rotate/scale) the model along
(around/in direction of) X axis

X Editor → Transformation → any
mode → 3D View

Translate (rotate/scale) the model along
(around/in direction of) Y axis

Y Editor → Transformation → any
mode → 3D View

Translate (rotate/scale) the model along
(around/in direction of) Z axis

Z Editor → Transformation → any
mode → 3D View
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13.6 Aligning Scans

Display aligned scans/models 1 Align panel
Display unaligned scans/models 2 Align panel
Display all scans selected for align-
ment

3 Align panel

Manually align scans Shift Align panel
Switch between point sets/pairs Space and

Backspace
Align panel → points

Conˉrm creation of point set Space Align panel → Com-
plex

13.6. Aligning Scans 203



Artec Studio, ver. 14

13.7 Starting Tools, Modes and Dialogs

Open Autopilot F9
Anywhere exc. modal dia-
log

Start automatic processing (don’t
confuse with Autopilot) Ctrl+G

Anywhere exc. modal dia-
log

Open Tools panel Ctrl+T
Anywhere exc. modal dia-
log

Open Align panel Ctrl+L
Anywhere exc. modal dia-
log

Open Fix holes panel Ctrl+B
Anywhere exc. modal dia-
log

Open Repair panel Ctrl+R
Anywhere exc. modal dia-
log

Open Measures panel Ctrl+M
Anywhere exc. modal dia-
log

Open Texture panel Ctrl+U
Anywhere exc. modal dia-
log

Open Editor panel Ctrl+E
Anywhere exc. modal dia-
log

Start Eraser tool E Editor panel
Start Defeature brush D Editor panel
Start Positioning tool P Editor panel
Start Transformation tool T Editor panel
Start Smoothing brush S Editor panel
Open web manual F1 Anywhere
Open local User Guide ˉle Ctrl+F1 Anywhere

Call Settings dialog F10
Anywhere exc. modal dia-
log

Show/hide Workspace panel F11
Anywhere exc. modal dia-
log

Show/hide Log window Ctrl+Alt+L
Anywhere exc. modal dia-
log
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Conventions and Acronyms

Portions of this user guide are highlighted to draw your attention. For example,

Note: Important information appears in specially formated paragraphs.

The following examples illustrate our conventions:

• Panel and element names that appear in the application window use italics: e.g.,
Workspace, File and Texture

• Buttons, checkboxes and elements of dropdown lists in panels and application
menus are italicized and underscored: Invert, Apply and so on

• Shortcuts, individual keys and hardware buttons use gray highlighting: e.g., Ctrl
+ A

• Characters that appear in a ˉeld, ˉle extension, or directory or ˉle path employ the
following style: Scan 1, SPROJ, C:\Program Files, and so on.

Note the following abbreviations and icons:

• LMB—left mouse button

• RMB—right mouse button

• —Play/Pause button on the scanner body
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Accuracy, 128
accuracygeneral term, 13
Adaptive, 112
Autopilot, 13

buffer size, 174
bundle, 13
By_radius, 115

CAD model, 13
colorMode, 112

decimationStep, 112

edgeLength, 112
effective_distance_from_scanner, 110
error, 128

feature_search_radius, 110
Fill_holes, 115
Filter_by_threshold, 117
ˉne registration, 13
force_constraints, 129
frames, 13
fusion, 13

Geometry
for Fine registration, 97
for Global registration, 110

Geometry_alignment, 110
Geometry_and_Texture

for Fine registration, 97
for Global registration, 110

Geometry_Ray, 110
global registration, 13

keep_boundary, 128
key frames, 13
key_frame_ratio, 110

Leave_biggest_objects, 117

Manually, 115
max_hole_len, 125
max_hole_radius, 115
max_neighb_normals_angle, 128
maxEdgeLength, 112
maxIncidenceAngle, 112
maxTriangleAngularSize, 112
mesh, 13
method, 112
minDistBetweenDescriptors, 110
minimumAngle, 112
minTriangleAngle, 112
mode, 117
model, 14

near and far cutting planes, 14
None, 112

project, 14

registration_algorithm
for Fine registration, 97
for Global registration, 110

Remesh, 128
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remesh_edge_thr, 128
remove_targets, 115
resolution

for Fusion, 115
for Outlier removal, 92

resolutiongeneral term, 14
rough registration, 14

scan, 14
SectionColor, 112
Simple, 112
SourceColor, 112
std_dev_mul_threshold, 92
steps, 120
stop_condition value, 128
supporting surface, 14

Targets, 110

targets, 14
Targets_Geometry, 110
threshold, 117
tracking, 14
tri_num

for Fast mesh simpliˉcation, 129
for Mesh simpliˉcation, 128

Triangle_quantity, 128

useWholeCloudTriangulation, 112
UV_Triangle_quantity, 128
UV_Vertex_quantity, 128

voxel size, 174
voxelSide, 110
vrt_num, 128

Watertight, 115
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